
Moving Items Between Layers
The Move To Layer command is used to move items to another 
layer in the layout.

When you create a new layer, or want to get rid of an existing layer, you will more than 
likely want to move some items in existing layers to the new one, or move items in the old 
layer to some other layer so that you can remove the layer.    In order to do this, you use 
the Move to layer command found under the Action menu.    

 RR-Track displays the Layer Chooser dialog so that you can choose the destination layer, 
and then moves the items.    As soon as they are moved, they inherit the properties of the 
new layer.    In other words if you move items from a visible layer to a hidden or grayed 
layer, they are redrawn as hidden or grayed.
Procedure:
1. Select the items you want to move to another layer.
2. Pull down the Action menu and choose Move to layer...    The Layer Chooser dialog 

appears.
3. Select the destination layer from those in the list and press OK.    Or, double-click on the 

destination layer combine choosing a layer and clicking OK.    If you decide not to move 
the items, choose Cancel.    RR-Track immediately moves the items to the destination 
layer.

see also:
working with layers



Moving Items Incrementally
The Move command under the Action menu lets you move the 
selected track and objects in small increments without using the 
mouse.    

This lets you adjust the fine positioning of items, or can serve as a substitute method of 
precisely placing items for those who are not comfortable using the mouse.

 When you select the Move command, you will see a window, like that at left, which you 
use to tell RR-Track how to move the selected items. The readouts at the top show how far 
you have moved the selected items vertically and horizontally respectively.    These are 
relative movements;    that is the horizontal and vertical readouts show how far you have 
moved the selected items since you chose the Move command.    The four buttons in the 
center, with arrows pointing left, right, up, and down, move the selected items in those 
directions respectively.    Every time one of these buttons is depressed and released, the 
selected items move in that direction a distance that is equal to the current snap size 
setting ( see setting the snap size).    The Ok button terminates the move command, 
leaving the selected items in their final position, while the Cancel button terminates the 
move command, and restores the selected items to their original position.
The center button, labeled Inc, is used to summon the Set Snap Size dialog, so that you 
may change the step size you are using.    You can also halve the step size by checking the 
half step check box.      This lets you make fine position adjustments without changing the 
snap size setting in RR-Track.
There is no limit to the number of times you can use the direction buttons to move the 
selected items.    You can reposition the Move window by placing the mouse cursor in the 
window (but not on one of the controls, such as the buttons or readouts), and depress the 
left mouse button and hold it down while you drag the Move window to a new position (this
is the same as the procedure used to drag any Windows window, except that you have to 
be in the caption area for a normal window).
Keyboard shortcuts:
You can also move items incrementally by using the up, down, left, and right arrow keys in 
combination with the SHIFT key.    See RR-Track shortcuts for more information.
See also:
moving track     





Locking and Unlocking Items
The Lock selected items and Unlock selected items pair of 
commands lets you fix track and objects on the layout so that 
they cannot be accidentally moved or rotated.    

As an example, you may have constructed an outside loop of track, and now wish to work 
on inner loops or yards, and want to reference the new track to the outside loop.    To keep 
from accidentally moving the outside loop, you can lock it in place.    Later on, when you 
are done, or want to move it, you can simply unlock it using the Unlock selected items 
command.
To lock items in place:
1. Select the items you wish to lock down using the mouse.
2. Pull down the Action menu and choose the Lock Selected Items command.    RR-Track sets

a lock on the selected items, keeping them from any subsequent moves or rotates.
To unlock locked items:
1. Select the locked items you wish to unlock using the mouse.
2. Pull down the Action menu and choose the Unlock Selected Items command.      RR-Track 

removes the lock on all of the selected components.
If you try to move or rotate items in which some are locked, you will be advised of this 
condition and the requested move/rotation will be ignored.    RR-Track will also stop you 
from deleting and editing locked items.



Aligning Track and Objects
Three CAD -like commands are available in RR-Track for aligning 
track, and optionally general purpose objects, with either the 
underlying coordinate grid or other track and objects.    These 
three commands, found under the Align to submenu under the 
Action menu are:

Align to: coordinate grid :    this command lets you align any side or middle of the selected 
track and objects with the coordinate grid, at the current snap resolution.
Align to: designated object : this command is similar to aligning with the coordinate grid, 
except you may instead align the selected track and objects with another piece of track, or 
object, which you designate with the cursor.
Align to: nearest track :    this command lets you practice join the selected track to the 
nearest available track end.    It does everything but actually shove the pins together.



Designating Isolated Electrical Blocks
Electrical block breaks, which created electrically isolated 
sections of track, may be created using the set of electrical block
commands found under the Action menu.

You may designate and change electrical blocks in two ways.    The simplest is to use the 
Create Block command to set block breaks at the ends of all of the selected track, and the 
Clear all block breaks command to remove the electrical breaks within, and at the ends of, 
the selected track..    The second method uses the Set/Clear block breaks command to 
individually designate or destroy electrical breaks.    The display of block breaks, denoted 
by a double circle, is set or cleared using the Layout Options dialog, accessed by pulling 
down the Control menu and choosing Options (you can also get to the Layout Options by 
choosing the Global Options command under the Options menu and then choosing Layout 
Options).    You may only set and clear electrical blocks in track sections that are 
highlighted, as for any other command under the Action menu.
RR-Track distinguishes between soft block breaks, which are those that you create using 
the Create block and Set/Clear block breaks commands, and hard breaks which are 
associated with special pieces of track found in some manufacturers track libraries that are
not electrically continuous at one end.    You cannot remove a hard block break.
To set, and clear, individual block breaks, you use the Set/Clear block breaks and Clear all 
block breaks commands found under the Action menu.    The Set/Clear block breaks 
command lets you toggle the electrical continuity of the nearest track joint in the selected 
(highlighted) track, while the Clear block breaks command removes all electrical breaks in 
the selected track sections.
To set or clear a single electrical break:
1. Select the track sections containing the electrical break junction.
2. Pull down the Action menu and choose Set/Clear block breaks.    The cursor will change to

an arrow with the words 'Block break' under it.
3. Move the tip of the arrow close to the joint you want to change the electrical continuity 

status.    Click the left mouse button.    If the cursor is not inside any of the selected track 
sections, you will here a beep advising you that no joint can be found, otherwise the 
electrical state of the nearest joint will change immediately, with a double circle 
indicating a break (only if you have enabled displaying block breaks in the Global Options
dialog).

4. The cursor returns to the Windows arrow with the new status of the block displayed.    
The track sections remain selected.

To create an electrical block with the selected track:
1. Select the track sections containing the electrical breaks you wish to clear.
2. Pull down the Action menu and choose Create block.    Break points will be placed at the 

ends of the selected track; breaks interior to this are unaffected.
To clear all breaks in the selected track:
1. Select the track sections containing the electrical breaks you wish to clear.
2. Pull down the Action menu and choose Clear all block breaks.    All break points will 

immediately be removed and their status updated.
To display electrical block breaks:
In order to display electrical block breaks on your drawing you must enable this option 
through the Global Options dialog.    In this dialog you change the display status of 
electrical blocks by checking or unchecking the Display block breaks option.



It is useful to be able to select track sections which are not only physically joined to one 
another but also electrically contiguous.    You can change the selection status of track 
using the Selections include joints , Selections include blocks ,    and the Selections Include 
Grades command found under the Options menu.    By choosing Selections include blocks 
you place an additional constraint on the selection of adjoining track sections by requiring 
they also be electrically connected.    For example, if you have set Selections include blocks
and click on a track section between two block breaks, you will highlight that track section 
under the cursor and all of the track connected to it that is between the two block breaks.   
This makes it easy to see which sections of track you have tied together electrically.
see also:
global options dialog, selecting track    



Changing the Drawing Order of Items
RR-Track has two commands which may be used to change the 
default drawing order and apparent height of items added to the 
layout.

Ordinarily, RR-Track renders track, accessories, and objects in the order they are placed in 
the layout; those items placed first are drawn first, while those placed last are drawn last.    
Because of this, in the case of object overlap the most recently placed item will appear on 
top.    This is not always desireable; for instance if you are composing a layout where there 
is an overpass with a railroad bridge in place, you would like the upper track to appear on 
top of (in front of) the overpass and the underlying track.    In order to change the order of 
item rendering, two commands are available under the Action menu for altering the 
drawing order, Send To Back and Move To Front.    Send To Back takes the selected object or
track section and places is at the first of the display list so that it is rendered first, 
appearing to be behind all other objects.    Move To Front is the opposite of Send To Back, 
changing the selected item to the end of the display list effectively making it appear in 
front of all other objects.    In order to change a track or objects drawing list position select 
from these two commands as necessary.
Procedure:
1. Select the item whose display list position you wish to change.
2. Pull down the Action menu and select Move To Front if you want to place this item in 
front of all others, or Send To Back if you want to place is into the background, behind all 
others. 
3. RR-Track redraws the layout with the new display list. The selected item is 
deselected.    



Breaking Individual Track Joints
You can break single track joints instead of breaking all of the 
joints in a track section by using the Break Joint command under 
the Action menu.    

Procedure:
1. Select Break Joint from the Action menu.    The cursor changes to a diagonal arrow 
with the word 'Break'.    All other menu commands, except Help, are disabled at this time.
2. Place the cursor    on the highlighted track section where you wish to break the 
connection.    It should be nearest the joint you wish to break.
3. Click the leftmouse button.    RR-Track will find the closest joint in the track section 
and break it at this time.    If there are no joints in that track section, or if you click outside a
track section, RR-Track makes no breaks.    The cursor returns to the Windows arrow, and 
the menu bar is enabled.
see also:
unjoining track, selecting track    



Relaxing Mismatched Track Sections
RR-Track has the capability to adjust the fit of track sections that 
do not really exactly fit.

If you have been assembling sectional track for any length of time, you have noticed that 
the final 'fit' for a closed loop is not necessarily exact, and may in fact have quite a bit of 
error, well over an inch if all of the sections are properly joined.    This residual 'slop' is 
soaked up by 'adjusting' the fit of a number of track sections on both sides of the closure 
point.    The purpose of the Relax Track command is to do just that; incrementally adjust the
location and rotation of track sections in order to minimize the mismatch at joints.    
RR-Track models the track sections that you tell it to 'fudge' as a set of fixed length objects 
that are connected by springs.    It then moves the track sections searching for a 
configuration that minimizes the overall forces and 'energy' stored in the track-spring 
system.    While not perfect, the resulting configuration isn't far off in most cases from what 
you would do yourself.    As a bonus, RR-Track displays statistics, both during the relaxation 
process and at the end, which can be used to judge for yourself whether this resulting 
configuration will be usable.    While a minimized track configuration will always be found, 
large residual mismatches in both angle and displacement mean that the real track 
configuration will be rather strained, and likely to come apart in use unless well fastened to
support of one kind or another.
When you select some track to let RR-Track move around to achieve a better fit, you will 
see a dialog like that below:

 There are a lot of information displays on this dialog starting at the upper left. 
Relaxation parameters: here there are two items displayed, Moveable which shows the 
number of track sections you allowed RR-Track to move around, and Iteration count 
which is the number of times RR-Track has gone over the moveable track and adjusted 
them for better fit. 
Relaxation rate:    here you have a choice of full, normal, and small. Normal is the default 
and is usually the best choice; when you are in the final stages of relaxing the track you 
can try changing this to small.
Max movement:    this sets an upper limit on the distance RR-Track can move a piece of 
track on each iteration, regardless of how far it would like to move it.    A maximum limit is 
set to minimize the chances of `bouncing around' between two or more similar track 
configurations.    Here you have a choice of 0.5 inches, 0.25 inches, and 0.1 inches.    The 
default choice is 0.25 inches; when you are in the final stages of relaxing the track you can 
try changing this to 0.1 inches.    RR-Track also adjusts this dynamically depending on the 
maximum gap error that it finds. 



Feedback:    RR-Track dumps out a lot of numbers to try to guide you through the 
relaxation process which is as much an art as it is a science.    There are six parameters 
displayed:    average energy,    max energy, average gap, max gap, average angle, and max
angle.        The two most important of these are the average gap and the max gap.    The 
average and max energy readouts show the current average energy and the maximum 
energy (in arbitrary units) of the movable track sections.    If the average and maximum 
energies are similar, then the error is pretty much uniformly spread out over all of the 
movable track (which is what you are aiming for).    The average and max gap are the track 
junction gap errors (in inches) of the movable track sections.    Again, you are trying to 
make these nearly the same.    If the maximum gap is a lot more than the average, this 
means one track section is stuck with most of the error.    The average and max angle are 
the track junction angular errors ( in degrees) for the movable track sections.    Here you 
are usually interested in only the maximum angle since this shows you the worst aligned 
track junction.    The greater this error, the more of a `jerk' trains will experience when they
traverse that junction.    5° is a very large angular error; you want to keep this below 1.5° if 
possible.
Command buttons:    you have four actions you can take.    X1 makes one pass over the 
track sections at the current relaxation parameters adjusting the fit, and then displays the 
results.    X5 makes five passes, adjusting the fit each time, and then displaying the results. 
Restore is used when you decide you have hopelessly messed up the movable track 
sections, and want to get back to the starting configuration. Press Done when you are 
finished and want to go back to laying track.      Press Help to bring up the help topic on 
relaxing track
Procedure:
1. Select  the track you wish to allow RR-Track to move in order to minimize joint 

mismatches.    It is usually a good idea to choose a few track sections on either side of 
the joint with the biggest error;    this is usually the point where the loop was closed (see 
closing track loops).

2. Select Relax Selected Track from the Action menu.    The Relax Track dialog appears;    this
is shown in detail in the tutorial Getting Started.

3. Set the Relax Track parameters as you desire and begin iterating the track minimization 
by pressing either the x1 or x5 buttons.    It is usually a good idea to start with large 
maximum movements, and then steadily constrain the amount that RR-Track can move 
track.    See Relaxation Tips for more information.    The current relaxation statistics, 
which include maximum and average gap error as well as maximum and average 
angular error, are updated after each relaxation cycle.

4. When the maximum track error has reached an acceptably low value, around 0.1 to 0.2 
inches, or whatever you like, press the Exit key

For further information, study both the Getting Started topic and the Relaxation Tips topic.   
One of the simplest ways to relax track joining errors is to just push the x1 or x5 buttons 
until the maximum gap error drops to an acceptable value (such as less than 0.2 inches for
O-gauge).    At this point press the Exit button.    If you don't like the way the track looks 
(RR-track updates the track positions after each relaxation cycle), just push the Restore 
button. The track will be returned to its pre-relaxation state, and the relaxation dialog will 
terminate.
see also:
Relaxation Tips 



Unjoining Track
RR-Track will let you unjoin track sections using either the menu 
commands or the mouse cursor.

In the course of creating and modifying a track layout, you will have occasion to break 
previously made track joints.    The Unjoin command, found on both the Action menu and 
the shorthand menu, is use for this purpose.    This command breaks the connection 
between the lead selection and all track sections joined to it unlike the Break Joint 
command which breaks only single, designated track junctions.
Procedure:
1. Select the track section you wish to unjoin with the mouse cursor.
2. Pull down the Action menu or the shorthand menu and select the Unjoin Selected 
Track command.
3. The joints are immediately severed between the lead selection in the selected track.
Alternative:    you can also unjoin track if you have enabled the 'allow breakaways' option 
in the Global Options dialog.    To do so, you select the track section as above, then move it 
away at least 2 or 5 or 10 per cent of the screen width (depending on the breakaway 
distance you have chosen in the Global Options dialog).    If you move at least this far, RR-
Track will assume you want to unjoin it, sever all connections, and move the track to the 
cursor position.
see also:
moving track, Global Options, breaking individual junctions 



Closing a Contiguous Loop of Track
When you have a loop of track (simple oval, part of a figure 
eight, etc.) which you wish to close upon itself, the various join 
commands are not usable since they will not allow a continuous 
set of track sections to join to itself.    For this purpose, you must 
tell RR-Track you wish to close a loop, or let RR-Track do this 
automatically (suggested) by setting the Auto-close loops option.

The more complex the track configuration, the greater the number of loops.    A simple 
figure eight using one cross has two loops.    An oval with two turnouts that are connected 
by an outside loop of track also has two loops.    A loop is any set of continuous track 
sections that is joined to itself. The track list will be scanned for the continuous set of track 
sections that has the closest pair of unused ends (control points) with a minimal amount of 
angular mismatch.    You will be asked to confirm that you wish to close this loop; if so, the 
unmatched ends are 'joined', which closes the loop.
You may also elect to have RR-Track close loops for you in an automatic manner by 
checking the auto-close loops option in the Global Options dialog.    When you do this, RR-
Track will scan all of the track joined to a track section just added to the layout for loops 
that meet criteria for closing.    If RR-Track finds track ends that meet this condition, it will 
highlight them and ask if you wish to close this loop.    You can also set the auto-close loops 
option, or check its current state, by using the multifunction status bar.
Procedure:
1. Select the loop of track you wish to close on itself using the mouse cursor.
2. Pull down the Action menu and select the Close Contiguous Loop command.
3. When a suitable loop is located, RR-Track highlights the ends that must be joined in cyan,

informs you of the mismatch in location, and asks for confirmation.    Press OK to close 
the loop, and Cancel to abort.    If no suitable loop is found, you will be told of this, and 
the closing operation aborted.

4. If confirmed, RR-Track closes the loop.
A related feature to automatic loop closing is proximity joining, also found in the Global 
Options dialog.    Proximity joining, when enabled, will join track ends that happen to lie in 
close proximity to each other, with no more than 0.25 track width gap error and no more 
than 2.5° directional misalignment.    There is no requirement that the track loop back on 
itself for proximity joining.
see also:
selecting track , multifunction status bar



Aligning Items to Other Items
You can align the selected track/objects to another object which 
you designate, by selecting the Align to| Designated Object 
command found under the Action menu.    

In order to use this dialog to align the selected track, none of the selected track items may 
be joined to track that is not selected, i.e. the selected track must be free, exactly as 
require to rotate it (RR-Track will not break track junctions in order to align track).    When 
you invoke the Align To| Designated Object command, you will see the following dialog:

 
The following buttons and control groups appear on the Align To Object dialog:
Align with group:    this contains four check boxes used to designate one or more sides 
which you wish align to another object.

Left:    checking this box tells RR-Track you wish to align the left side of the selected items.
Right:    checking this box tells RR-Track you wish to align the right side of the selected 
items. 
Top:    checking this box tells RR-Track you wish to align the upper side of the selected 
items. 
Bottom:    checking this box tells RR-Track you wish to align the lower side of the selected 
items.
Align to group:    this contains four check boxes used to designate one or more sides which
form the reference track or object.    This is the object to which the selected items are 
aligned.
Left:    checking this box indicated you want to use the left side of the item as a reference.
Right:    checking this box indicated you want to use the right side of the item as a 
reference.
Top:    checking this box indicated you want to use the bottom side of the item as a 
reference.
Bottom:    checking this box indicated you want to use the lower side of the item as a 
reference.
Remember, these side designations refer to the entire selection and not just the lead 
selection for the Align With or source objects, and they refer to the single track or object 
you designate for the Align To or reference object.    These check boxes may be combined in
any manner that you see fit.    For instance, to align the upper left side of the selected track
or objects to another object, check the Left and Top boxes.    In order to align the middles of
the selections to the another object, you check both of the appropriate boxes.    



Example:    to align the left and right middle to another object check both the Left and 
Right boxes.    
To align the geometric center of the selections to the coordinate grid, check all four boxes.   
These combinations also apply to the Align To or reference object.    
Example:    to align the left side of the selections with the left/right middle of another 
object, check the Left box in the Align With group and both of the Left and Right boxes in 
the Align To group.
Obviously, it does not make sense to try to align left and right sides to upper and lower 
sides, and RR-Track will let you know when you try to carry out a meaningless alignment.
Align:    depressing this button causes RR-Track to evaluate the alignment conditions set by 
the Align With and Align To check boxes.    If a legal alignment is indicated (no attempt to 
align horizontal and vertical features with each other) the cursor changes to an arrow with 
the word Align beneath it.    At this point you designate the object to align to and RR-Track 
moves the selections as appropriate.
Cancel: this button lets you bail out without aligning anything, or terminate the Align To 
Object dialog after carrying out your alignments.
Help:    displays this topic.
When using the Align To Object dialog, the setting the current snap resolution has no effect 
on the alignment of the selected track/objects.
Procedure:
1. Select the track or objects you want to align with another object, and then select the 
Align to: Designated Object command from the Action menu.
2. Check the Align With and Align To boxes as appropriate.    Be sure and remember 
that Left means the left side of the entire selection, not just the lead selection.
3. Press the Align button.    If the alignment you have set is legal, RR-Track changes the 
cursor to an arrow with the word 'Align' beneath it.    At this point you move the cursor to 
designate the object you wish to Align To.    This is done by positioning the cursor over the 
object and clicking the left mouse button.
4. RR-Track immediately aligns the selected track/objects to the reference object you 
designated.    The cursor changes to the Windows arrow, while the Align To Object dialog 
stays up.    At this point you can either carry out further alignments or return to the main 
menu by pressing the Cancel button.
If you wish to abort the alignment after you have gotten to the point where RR-Track 
displays the align cursor, move the cursor to a spot that is over nothing, and click the left 
mouse button.    RR-Track will beep to let you know you have designated no reference 
object, and return the cursor to the Windows arrow.    You can now alter your alignment 
criteria, or press Cancel and return to the main menu. 
see also:
aligning track to the coordinate grid    
 



Aligning Items to the Coordinate Grid
You can align the selected track and objects to the underlying 
coordinate grid by selecting the Align to | Coordinate Grid 
command found under the Action menu.    

In order to align the selected track, they must be free of connections to track that is not 
selected, exactly as required when rotations are performed (RR-Track will not break track 
joints in order to align track to the coordinate grid).    When select the Align To | Coordinate 
Grid command, you will see the following dialog:

 The Align To Coordinate Grid dialog is similar in appearance and controls to the Align To 
Object dialog, with the simplification of having no Align To: controls since alignment is to 
the coordinate grid.    The following buttons and controls appear on the Align To Coordinate 
Grid dialog:
Align with group:    this contains four check boxes used to designate one or more sides 
which you wish align to the coordinate grid.
Left:    checking this box tells RR-Track you wish to align the left side of the selected items 
to the coordinate grid.
Right:    checking this box tells RR-Track you wish to align the right side of the selected 
items to the coordinate grid.
Top:    checking this box tells RR-Track you wish to align the upper side of the selected items
to the coordinate grid.
Bottom:    checking this box tells RR-Track you wish to align the lower side of the selected 
items to the coordinate grid.
These check boxes may be combined in any manner that you see fit.    For instance, to align
the upper left side of the selected track or objects to the coordinate grid, check the Left 
and Top boxes.    In order to align the middles of the selections to the coordinate grid, you 
check both of the appropriate boxes.    
Example:    to align the left/right middle to the coordinate grid check both the Left and 
Right boxes.    To align the geometric center of the selections to the coordinate grid, check 
all four boxes.      
OK : this button aligns the designated side(s) of the selected track to the coordinate grid at
the current snap resolution.
Set snap size :    this button lets you change the current snap resolution.    See setting the 
snap size for more information on this topic.
Cancel :    this button lets you bail out without aligning anything.
Help : this button displays this topic.



Procedure:
1. Select the track or objects you want to align with the coordinate grid, and then select
the Align to: Coordinate Grid command from the Action menu.
2. Check the Align To boxes as appropriate.    Be sure and remember that Left means 
the left side of the entire selection, not just the lead selection.
3. Press the OK button.    RR-Track immediately moves the selected items into the 
demanded alignment with the coordinate grid, at the current snap resolution.    The Align 
dialog stays up until you press the Cancel button so that you may execute multiple 
alignments without having to re-invoke the Align command. 
You can abort the Align command at any time by pressing the Cancel button.
see also:
aligning to other track or objects 



Align To Nearest Track
Align To Nearest Track is exactly analogous to Join To Nearest 
Track, except that the track sections are not physically joined, 
just moved into alignment as if they were joined.    

Alignment of track can be very useful for what if scenarios, and test configuration of track, 
saving you the trouble of breaking joins you don't wish to keep.    You can also use the Align
To Nearest Track command to align test track sections for purposes of matching the ends of
more complex track sections, such as switches, crosses, and configurations of track 
containing these items.
RR-Track scans the non-selected portion of the track list for the nearest unused control 
point, and matches that with the closest unused control point in the selected track list.    
These points are then brought into alignment as if they were physically joined.    
Procedure:
1. Select the track you wish to move into alignment.    The track is highlighted in red.
2. Move the selected track near to the track you wish to align with.    RR-Track will align 
in both position and orientation the closest pair of unused control points.
3. Select Align To Nearest from the Action menu.    The track is aligned immediately. 
see also:
selecting track, moving track, join to nearest track 
 
    



Join To Nearest Track
The Join to Nearest Track item is the user initiated analog of 
automatic track joining which is operative when placing new 
track sections.    

RR-Track scans the track list for the nearest unused track control point to the nearest 
unused control point in the selected track.    When found, the track in the select list is 
joined as a unit to the nearest track in the unselected portion of the track list.    If confirm 
track joining is enabled, the closest track and joining points are highlighted in cyan, with a 
line drawn between the chosen control points, and user confirmation is asked for.
Procedure:
1. Select the track you wish to join.    The track is highlighted in red.
2. Move the selected track near to the track you wish to join.    RR-Track will join the 
closest pair of unused control points.
3. Select Join To Nearest from the Action menu.    The track is immediately joined, 
subject to confirmation if that has been enabled.    
see also:
automatic track joining, confirm track joining, moving track  



Rotating Items
The Rotate... item under the Action menu performs rotations on 
selected (highlighted) track or other objects in the track layout.    
The Rotate... command under the shorthand menu performs the 
same function, but in a more quickly accessible manner (Quick 
rotate).    

Most of the time you will not need to rotate items, especially track, since RR-Track carries 
out this function automatically when you join track.    However, from time to time you need 
to manually rotate items, such as objects you create or accessory items, in order to align 
them with track sections in locations such as sidings, or bridges over waterways, etc.    
After selecting this item, you are presented with a dialog like that shown below:

 
There are four primary control groups in the rotate dialog.    The angle controls are on the 
left side, extending from top to bottom.    The direction controls are immediately to the 
right of the angle controls, and at the top of the dialog.    Immediately below the direction 
controls are the rotate about controls, while below these, at the bottom of the dialog, 
are the coordinate controls.    There are four push buttons at the bottom    labeled Rotate,
Done, Undo, and Help...    At the left bottom is a readout which displays the relative angle 
that the selected items are rotated through.
Angle controls:    when rotating track, or other objects, RR-Track 'thinks' in terms of 
angles, expressed in degrees and decimal degrees, just like those on a common school 
protractor.    However, when assembling sectional track, people tend to think in parts of a 
circle i.e. 12 sections to a circle, 16 sections, and so on.    The angle controls contain a 
number of preset rotation angles which may be selected by pressing the button next to the
angle you wish to rotate track.    These span from 7.5° to 180°, and are chosen to represent
the angular arcs that most sectional track systems have.    For convenience, these preset 
angles are also labeled in terms of the fraction of a circle equivalent to the angle ( for 
example, 15° is 1/24th of a circle, 45° is 1/8th of a circle, 90° is 1/4th of a circle).    If the 
angle you wish to rotate through is not found in the list of preset angles, you may select 
other.    This action puts up a text cursor in the box immediately below the other radio 
button, at which point you type in your angle (in degrees).
Direction controls:    you may also rotate track, or other objects, in either direction, 
clockwise (cw) or counterclockwise (ccw).    RR-Track defaults to counterclockwise, but 
clockwise rotations may be selected by clicking the cw button.
Rotate about controls:    you may also tell RR-Track the point you wish to rotate the 



objects about (the center of the rotation circle).    The choices consist of the origin and the 
center.    The origin here is the origin of the lead selection.TRM_leadselection_ID    This will 
be the end of the track which is under the cursor when the track is first added to the layout
( if you watch, you will see that new pieces of track have one end at the mouse cursor).    If 
you select center, the rotation will be about the center of the lead selection.
Coordinate controls:    finally, you may select whether the rotation you have chosen is to 
be absolute or relative.    Absolute rotations rotate the selected track to an angle in terms
of the overall coordinates of the track layout, i.e. 0° is horizontal running from left to right, 
90° is vertical, running from bottom to top, 180° is horizontal, but runs from right to left.    
Relative rotations rotate the selected track by the chosen angle relative to the current 
angle of the track, not the overall layout coordinates.    For example, if you have track that 
is oriented at 45° and you choose a 30° counter-clockwise relative rotation, the new track 
angle will by 45° + 30° = 75°.    Had you chosen a clockwise rotation instead, the new 
angle would be 45° - 30° = 15°.    RR-Track defaults to relative, counter-clockwise rotations. 
When you have finished selecting your rotation, apply it by clicking the Rotate button.    The
selected track will be rotated to its new position, and the angle readout will be updated.    
When you are finished rotating the selected items, press the Done button.    If you need 
help while selecting your rotation options, click on the Help button.    Press the Undo button 
to remove any applied rotations.    When joined track sections are rotated, the track is 
rotated as a contiguous unit about the origin or center, as chosen, of the lead 
selectionTRM_leadselection_ID.    If items in the select list are joined to items not in the 
select list, RR-Track will not carry out the rotation unless the allow track breakaways item in
the Global Options dialog is checked.
Procedure:
1. Select the track sections or other objects you wish to rotate.
2. From either the Action menu or the shorthand menu, choose the Rotate... item. 
3. In the Rotate Options dialog, click the radio buttons that correspond to the angle you 
wish to rotate, the direction, the origin, and whether the angle is relative or absolute.    RR-
Track defaults to counter-clockwise relative rotations about the track origin.
4. Click the Rotate button.    The selected track rotates to the new position.    The Rotate 
dialog stays up until you press the Done button to dismiss it.    In this manner you can 
perform several trial rotations to get the angle right before leaving the Rotate dialog.    If 
you want to return the track to its starting configuration, press Undo.

Quick rotate
If you choose the Rotate.. command from the shorthand menu brought up by clicking the 
right mouse button when over an empty area, you will get a dialog that looks like that at 
left:



    To rotate the selected items, simply grab the slider with the cursor and move it to the 
angle you want, or click the + and - buttons until you reach the orientation you want.    You 
can also move the slider by placing the mouse cursor on the slider track, and clicking once 
with the left mouse button.    RR-Track rotates the selection when you stop moving the 
slider, or when you click the + and - buttons.    
You can change the resolution of the slider and the +/- buttons by clicking on the button 
immediately below the + button.    This button shows the current resolution of the slider.    
Each time you click on it, you will move to the next coarsest resolution, until the coarsest 
resolution of 22.5° is reached, at which point it will start over at 1°.    Resolutions of 1°, 
2.5°, 5°, 7.5°, 15°, and 22.5° are available.    
You can change the center of the rotation by clicking on the button immediately below the -
button.    This button lets you toggle between the origin of the lead selection (Org) and the 
geometric center of all of the selected items (Ctr).    RR-Track displays a small crosshair 
which shows the current center.    When you are finished rotating the selection, press the 
Done button.
Keyboard shortcuts:
You can also use the up and down arrow keys in combination with the CONTROL key to 
rotate items incrementally.    See RR-Track shortcuts for more information.
see also:
selecting track and objects, moving track and objects                    
 



Printer Page Setup Dialog
The Page Setup dialog contains the controls for configuring 
printed views of the track layout.    

 The controls are divided into those which control the Accents and special items, such as 
the date and time, and those which control the coordinate upon which the track sections 
are overlaid.
Accents:
show coordinates:        toggles the printing of coordinate labels on the coordinate grid.
show layout credits:    toggles the printing of the credit bar at the bottom of the page.
Other options:
track and grid in color:    toggles whether or not track sections are printed using their 
screen colors, or in black.    This also toggles whether the coordinate grid overlay is printed 
in its screen color or in black.    This is mostly effective for color capable printers, but can 
also affect black-only printers such as lasers.      

Color printing
When the Track in Color box is checked, track sections are printed using their screen colors.
The disadvantage here is that some colors are dithered; depending on the make/model of 
your printer and the current color settings, some colors (such as gray) are rendered poorly 
for thin lines used to draw the track sections.    In this case it is better to turn off colors for 
track.    Regardless of the setting of this switch, all objects and accessories are rendered 
using their native colors.    We have tested the color capabilities of RR-Track using a Canon 
BJC-4000 and have found the rendering quite good when the printers is set to the highest 
quality.    This also yields the slowest printing speed;    even on a Pentium your PC will take 
quite a while to output one page.



Printer Setup Dialog

The printer setup dialog allows you to configure your current RR-
Track printer settings.    

 Among others, these control the orientation of the page (landscape or portrait), the 
resolution (dots per inch or DPI), and in the case of PostScriptÔ printers, whether you wish 
the output to an Encapsulated PostScript file (.EPS).    See your Windows 3.1, Windows 95, 
or Windows NT manual for more information on this dialog.



Save File Dialog

The Save File dialog is a Windows standard interface for saving 
files.    

 RR-Track uses it to save track layout (.rrt) files, which is the default file type, but you may 
use any name for your files as long as you remember what it is.    There are four major 
sections to this dialog:    File Name listbox (upper left), Folder Listbox (middle right), File 
Type listbox (lower left), and the Drive listbox ( lower middle right).    
The File Name     listbox is used to enter the name of the track layout file you wish to save, by
either entering it from the keyboard or selecting it from the list of .rrt files below.    The 
Folder listbox is used to traverse the file system directory tree:    folders to the left are 
higher up the tree and more fundamental, while those indented to the right represent lower
branching levels.    You move from one to the other by selecting and clicking with the left 
mouse button.    The Drive listbox is similar to the folder listbox, but lets you move from 
drive to drive on your PC (think of it as a super folder).    Finally, the File Type listbox lets 
you select the file types displayed in the File Name listbox.    As previously mentioned, RR-
Track defaults to .rrt    as the file type.    More information on this dialog is contained in your 
Windows 3.1 manuals. 



Open File Dialog

The Open File dialog is a Windows standard interface for opening 
files of all kinds.    

 RR-Track uses it to open .rrt files, which are the default file type for track layout files, but 
you may use any name for your files as long as you remember what it is.    There are four 
major sections to this dialog:    File Name listbox (upper left), Folder Listbox (middle right), 
File Type listbox (lower left), and the Drive listbox ( lower middle right).    
The File Name     listbox is used to enter the name of the track layout file you wish to open, by
either entering it from the keyboard or selecting it from the list of .rrt files below.    The 
Folder listbox is used to traverse the file system directory tree:    folders to the left are 
higher up the tree and more fundamental, while those indented to the right represent lower
branching levels.    You move from one to the other by selecting and clicking with the left 
mouse button.    The Drive listbox is similar to the folder listbox, but lets you move from 
drive to drive on your PC (think of it as a super folder).    Finally, the File Type listbox lets 
you select the file types displayed in the File Name listbox.    RR-Track defaults to .rrt files.    
More information on this dialog is contained in your Windows 3.1 manuals. 



Selecting All of the Items in a Layer
For moving a lot of items from layer to layer, or to just clear out a
layer, a useful command is the Select all in layer command found
under the Edit menu.    

Selecting all of the items in a layer is very easy.    The procedure is very simple:    you pull 
down the Edit menu, choose Select all in layer, choose the target layer, and press OK.    
When you choose the Select all in layer command, you will see a dialog such as that to the 

left: 
    Use the mouse or keyboard to highlight the target layer (the working layer is shown with 
a prepended <W>) and then choose OK, or choose Cancel if you don't want to select any 
items.    You can combine these steps by double-clicking on the target layer instread of 
single-clicking and then pressing OK.    
RR-Track selects and highlights all of the items in the target layer.    You can then 
manipulate these items in any manner you see fit, such as move them to another layer, 
lock them, unlock them, etc.
see also:
select all , select all visible



Duplicating Track and Objects
The Duplicate item on the Edit menu lets you duplicate any items
that you have selected (highlighted).    

RR-Track pastes a copy of the items starting at the last point the left mouse button was 
clicked on in the layout.    The duplicated items are highlighted.    This is basically a one 
mouse-click combination of Copy and Paste, except that the duplicate command clears the 
RR-Track clipboard contents.
You can also create parallel duplications of track at a given offset by choosing the Duplicate
Parallel item on the Edit menu.

 Using the Duplicate command, as well as the Duplicate Parallel command, clears the 
contents of the RR-Track clipboard.    Anything you copied to the clipboard will no longer be 
present.
see also:
cut, copy, paste , duplicate parallel



Un-deleting Track and Objects
The Undo Delete item on the Edit menu lets you undo the last 
deletion of 100 or fewer items from the layout.    If you delete 
more than 100 items, you will be asked to confirm this.    There is 
no undelete recovery from a positive choice in this case.    

{ewl hmew2,ewBitmap2,WARNING.BMP} You must use the Undo delete command 
immediately after deleting the items;    any further changes to the layout, such as 
track/object addtions and deletions or moves and rotations, will eliminate the possibility of 
recovering from the deletion.    



Cutting Track or Objects From the Layout
The Cut item from the Edit menu 'cuts' the selected items out of 
the current layout and places them in the RR-Track clipboard.    

The cut items are available for pasting into other parts of the layout as many times as you 
desire, until the RR-Track clipboard contents are changed to some other track or objects by 
a subsequent Cut or Copy command.
Procedure
1. Select one or more track sections using the mouse or other pointing device.
2. Choose the Cut command from the Edit menu, or from the shorthand menu called up by 

clicking the right mouse button, or hit CTRL-X from the keyboard.
3. The selected track or objects are deleted from the layout and placed in the RR-Track 

clipboard.    This action enables the Paste command in both the main and shorthand 
menus.

See also:
copy, paste, delete 



Pasting Track or Objects into the Layout
The Paste command from the Edit menu allows you to paste 
track sections or other objects from the RR-Track clipboard into 
the current layout.    

The pasted items will be placed at the upper left corner of the current view, and 
automatically selected (highlighted), replacing any previously selected objects.    The 
contents of the RR-Track clipboard are not changed by this command.    If the clipboard is 
empty, this command will be grayed out and you will not be allowed to select it.
Procedure:
1. Select the Paste command from the Edit or shorthand menus, or hit CTRL-V from the 

keyboard.
2. The track or other objects in the RR-Track clipboard will be added to the track layout near

the upper left corner of the current view, and will be selected (highlighted).    Both the 
display list and the select list are updated reflecting this change.

See also:
cut, copy, delete 
 



Deleting Track or Objects From the Layout
The Delete command from the Edit menu allows you to delete 
selected track or other objects. 

Unlike the Cut command, the delete command does not copy the selected (highlighted) 
objects to the RR-Track clipboard.    The contents of the RR-Track clipboard are not changed 
by this command.      You can recover from a deletion of 25 or fewer items by immediately 
selecting the Undo delete command found on the Edit menu. 
Procedure:
1. Select one or more track sections using the mouse or other pointing device.
2. Choose the Delete command from the Edit menu, or from the shorthand menu accessed 

by clicking the right mouse button.    From the keyboard you may use the delete key.
3. The selected track/objects are removed from the current layout and the display list, 

which is updated to reflect this change.    The contents of the select list are cleared, with 
the select list window reflecting this change.

see also:
cut, copy, undo delete 
 



Duplicating Parallel Track
You can create parallel duplications of track, that is replicate 
track parallel to, and offset from, the selected track, by choosing 
the Duplicate Parallel command under the Edit menu. 

When you choose the Duplicate Parallel command you will see a dialog like the one below:

 The Duplicate-track parallel dialog has a preview window to the left which dynamically 
shows you the position of the newly duplicated track.    There are a number of controls to 
the right which are used to both set and display the offset distance, as well as control the 
offset increments. 
The vertical control to the right of the preview window that looks like a stereo amplifier's 
fader is used to set the offset distance.    Positive values correspond to offsets that raise the
track up, while negative values correspond to those that push it downward (for horizontal 
track).    Directly below the fader is a panel readout which is used to display the current 
offset distance, with up/down spin buttons adjacent to the panel readout.    The radio 
buttons directly below the Ok and Cancel buttons, labeled as an Increment group, are used 
to set the current increment resolution for the offset distance.    As you select different 
increment values, the range of available offsets shown on the fader control change.    The 
fader control can reach any offset in the range shown, while the up/down spin buttons 
increase/decrease the offset by the value indicated with the radio buttons in the Increment 
group.    Using the up/down spin buttons, you can reach any offset distance, and are not 
limited to those shown by the fader.
Procedure:
1. Select the track of which you wish to create a parallel duplicate.
2. Pull down the Edit menu and choose Duplicate parallel.    The duplicate parallel dialog 

appears.
3. Using the fader control, and/or the up/down spin buttons, set the parallel offset that you 

want.    The preview window updates every time you change the offset so that you can 
see exactly where the parallel track will be placed.

4. When you are satisfied with the parallel offset, push the Ok button.    The selected track 
is parallel duplicated in the indicated offset position.    The selected track remains 
highlighted after duplication and you are returned to the layout window.    If instead you 
wish to abort the parallel duplication, press the Cancel button.



 Using the Duplicate command, as well as the Duplicate Parallel command, clears the 
contents of the RR-Track clipboard.    Anything you copied to the clipboard will no longer be 
present.
see also:
 cut, copy, paste,selecting track and objects , duplicate
 



Copying Track or Objects
The Copy command from the Edit menu allows you to copy 
selected track or other objects to the RR-Track clipboard.    

Unlike the Cut command, the Copy command does not delete the selected (highlighted) 
track or other objects.    The copied objects replace whatever was previously in the RR-track
clipboard.    Like any clipboard objects, these are available for pasting into the active layout 
at any time, using the Paste command.    Note:    RR-Track can only copy approximately 400
items to its clipboard at any given time;    if you try to exceed this you will be advised that 
the copy operation cannot be completed.
Procedure:
1. Select one or more track sections or objects using the mouse cursor.
2. Choose the Copy command from the Edit menu, or from the shorthand menu called 
up by clicking the right mouse button.
3. The selected track or objects are placed in the RR-Track clipboard.    This action 
enables the Paste command in both the main and shorthand menus.
See also:
cut, delete, paste, selecting track , duplicate
 



Creating a Clone of a Layout
When you are considering different variations on a given layout 
design, it can be very useful to quickly create a clone (copy) of a 
layout in a new window.    

In this manner you do not have to do your editing in the original layout window and risk 
failing to remember to save the edited layout under a new name.    You can use the Clone 
Layout command, found under the File menu to make an exact copy of the active layout, 
open a new layout window, and then put the copy in as an untitled layout.
In order to create the clone, simply pull down the File menu and choose Clone Layout.    RR-
Track immediately creates a new layout window containing the clone, while the source 
layout remains unchanged.    The clone becomes the active layout.

 When RR-Track creates a clone, it does so by writing a temporary layout file to your disk.    
This file has the name XYZ000.TMP.    In order to avoid accidents, do not name any of your 
layouts XYZ000.TMP.
see also:
creating a new layout



Printing Your Layout
A layout may be printed by selecting the Print Layout command 
under the File menu.    When you do so, you are shown a dialog 
such as the one shown below:

 The Print Layout dialog shows the name of the layout and the printer it is going to in the 
caption, has a layout preview window on the left which shows a thumbnail view of your 
layout as well as an overlay of the printer page mapping, readouts showing the page sizes 
on both the layout and the printer, the current scale between the printer page and the 
layout, and command buttons that let you set things like the fonts used for track labels and
coordinates, the printer used, the appearance of the printed page, and send the layout 
pages to the printer.    When you print, your layout can be scaled to fit on one page, or 
blown up to cover up to 64 pages.    You have complete control over how many, if any of 
these pages you actually print.

 Layout preview: A numbered grid is superimposed on the layout preview, depicting the 
printer pages required at the current zoom level. The example at left will be fully covered 
at the current scale by using eight printer pages in portrait mode.    A given page is marked 
for printing if it is displayed in cross-hatch; only those pages marked are printed.    You 
mark a page for printing by positioning the cursor over it and clicking the left mouse 
button.    
To choose a page for printing:
1.Position the mouse cursor over the page you want to print.
2.Click the left mouse button to change the print marking. If the page was not marked for 
printing, it will now be marked, and if it was marked for printing, it will now be cleared.
Marked pages are not printed until you press the Print button.



 Page sizes:    this is an informational area that shows you the size of the area that can be 
printed on both the printer page and what dimensions that corresponds to on your layout.   
The ratio between these two is the scale, which is shown below.    

 Printing Scale:    RR-Track gives you a choice between automatically scaling the layout to 
the printer page to maximize the use of the page area in the current page orientation 
(portrait or landscape), or printing at a fixed scale which you select.    When using 
automatic scaling (which is the default and is shown at the left) the +2x and -2x push 
buttons allow you to increment and decrement the zoom level by amounts of 2x, hence 
changing the scale by amounts of 2 or 1/2.    When you change the zoom level, all 
previously marked pages will revert to unmarked since the page location will change.    
Zoom levels from 1 to 8 are allowed; a zoom of 8 results in 64 printer pages if you mark the
entire layout for printing.

 You can change to specifying a fixed scale by pressing the Set scale button.    When you do
so, the scale section of the Print Layout dialog changes to look like that at left:
Here you can use the radio buttons to choose fixed scales between the layout dimensions 
and the printer dimensions.    For example, in English units you have a choice of 1:1 (i.e. 1" 
on the printer is 1" on the layout), 1:6 (1" on the printer is 6" on the layout), all the way up 
to 1:120 ( 1" on the printer is 10 feet on the layout).    Any fixed scales which will exceed 64
printer pages are grayed out and not accessible (most O-gauge layouts cannot be printed 
at 1:1 in 64 pages or less).    To go back to automatic scaling, press the Auto-scale button. 

 Page Selection:    these two radio buttons control whether or not the entire layout is 
marked for printing, or just individual pages.    All pages marks the entire layout, while 
selecting only marked pages lets you control which pages are printed, by marking each 
individually as described above.
Print to file:    check this box if you wish RR-Track to print your layout to a file (such as an 
Encapsulated PostScript file) for either later printing or inclusion in other documents.



Note:    not all printers and printer drivers have the capability to print to a file that you can 
use in another document.    This capability is mainly confined to printers whose drivers 
support Adobe PostScript.    This feature is not 'sticky'; you must set it each time you wish 
to print to a file.
Command buttons

 Print:    depressing this button sends all of the marked pages to the printer for printing.    
You will see a dialog box that has a Cancel button to let you cancel printing the current 
page.    This will only work if pressed before the progress meter below the button makes it 
all the way to right; after that you cannot abort the page.    Note that on some laser 
printers, you may not be able to press the Cancel button quickly enough to abort the page. 
RR-Track does not send any page(s) to the printer unless they have beenmarked for 
printing as discussed above.
Track font:    depressing this button lets you change the font used for labeling track 
sections, if this has been enabled using the Global Options dialog.    See track fonts.
Coords font:    similar to the track font button, pushing this button lets you change the 
font used for printing the coordinate overlay labels.
Page setup:    depressing this button lets you set up the details of the page layout, 
controlling which kind of coordinate overlay is used, whether a scale marker is displayed, 
and what kind of credits are displayed
Printer:    pushing this invokes the Printer Information dialog, shown below.    From this 
dialog you can change printers, reset the printer's configuration, and preview where RR-
Track will place things on the page.

Printer Information Dialog



 The Printer Information dialog both lets you set and configure the RR-Track printer, but 
also previews where RR-Track will place your layout drawing and other items on the printer 
page.    The caption shows the name of the current RR-Track printer.
The page preview window is the large rectangular window at the upper left.    RR-Track 
draws the paper size and orientation in white, the printable area of the page outlined in 
dotted red, the area of the page used for the layout drawing in cross-hatched red, the area 
of the page used for the coordinate labels in light gray, and the area of the page reserved 
for the credits (at the bottom) in blue.
Immediately adjacent to the preview window are a set of text displays which show you the 
current settings for the RR-Track printer.    These are: Phys, the physical size of the page in 
inches.    This is the actual size of the paper.    Size:    the printable area, in inches    This is 
the maximum area that can be used for printing.    Res: the resolution of the printer in dots 
per inch (DPI).    MRG: the horizontal and vertical printer margins, in inches.    Landscape or
portrait:    the current page orientation.
Available printers list:    Immediately below the text displays is a list box of all the 
printers currently recognized by your PC. The current RR-Track printer is highlighted.    To 
change RR-Track printers, double-click on the printer name in the list.    RR-Track will switch 
to the new printer,    using the default printer driver parameters for starters, and show the 
new page preview window and the new printer parameters.
Command buttons:    the Toggle button lets you change between Landscape orientation 
and Portrait orientation without going to the printer setup dialog.    The Printer Setup button
brings up the Windows Printer Setup dialog for the current RR-Track printer.    Using the 
Printer Setup dialog, you can reconfigure the current RR-Track printer's settings.    Whatever
you change will affect only RR-Track; other applications and the printer's default settings 
are not affected.      When you are finished with the Printer Information dialog, press the OK 
button to return to the Printer Layout dialog.
see also:
page setup 



Page Setup
Selecting File|Page Setup command activates the Page Setup 
dialog which allows you to configure the secondary features of 
the printed version of the current view.    

 These include the primary and secondary coordinate grids, whether or not a scale marker 
and coordinate labels are displayed, and whether or not the layout file name and time of 
printing are displayed. 
Procedure:
1. Select the Page Setup command under the File menu.    This will cause the Page Setup 

dialog to appear.
2. Select the features which you wish displayed or excluded from the check box and radio 

button groups in the dialog.
3. When you are satisfied with your choices, click the OK button to record these and return 

to the RR-Track main window.    Alternatively, if you have changed your mind and do not 
wish to change the page setup settings for the current view, select the Cancel button 
which immediately returns you to the RR-Track main window.

see also:
setting up the printer , printing layouts
 



Setting Up the Printer
Selecting the File|Printer Setup command causes Windows to 
display the Printer Setup dialog for the current default printer.    
This dialog may also be accessed by selecting the printer icon in 
the Windows Control Panel.    

 The printer setup dialog allows you, among other features, to select the orientation of the 
printer page (landscape or portrait), along with other features specific to your printer.    If 
you wish to change the default printer, you must use the Windows Control Panel.    
Procedure:
1. Select the Printer Setup command from the File menu.    This displays the printer setup 

dialog for the current system default printer.
2. Select the options you wish from the printer setup dialog, and click Close if you wish to 

retain them, or Cancel if you change your mind and wish to return to the RR-Track main 
window.    

 
    



Saving a Track Layout
You can save the current layout using either the Save or the Save
As... commands found under the File menu.    If you use the Save 
command, RR-Track will save your layout using the current layout
file name.    If you choose the Save As... command, RR-Track will 
call up the Windows Save File dialog and let you enter a new file 
name.    

When you choose the Save As... command, you have your choice of names to use for the 
layout file.    If you want to save the layout file's screen image as a Windows Bitmap, 
choose the File | Export | Windows BMP command.    The Save command will prompt you for
confirmation if no changes have been made to the track layout since the last save.
If you are running RR-Track under Windows 95, you can use long file names (up to 255 
characters) in order to be more descriptive in naming your layout files.    
Procedure:
1. From the menu bar, select either File|Save or File|Save As... from the drop down menu.    

If    there have been no changes to the current layout since either opening it or the last 
save, you will be asked to confirm a Save command.    If you answer yes, or there have 
been changes, RR-Track saves the layout file under the same name, and returns 
immediately.

2. If you choose File|Save As..., RR-Track displays the Windows save file dialog.    Using the 
drive and directory folder icons, and the names in the file name listbox, you select an 
appropriate file name ( such as myfile.rrt).    You can also manipulate the file types icon in
the lower left corner to change between saving as a track layout file (RRT) or a Windows 
bitmap file (BMP).    

3. When you are satisfied with the file name you have chosen, click the OK button to save 
the current layout, or the Cancel button if you have changed your mind and wish to 
return to the RR-Track main window.

see also:
opening a file 



Exiting RR-Track
The Exit command from the file menu closes RR-Track.    The 
current layout file, if any, will be closed.    If any changes have 
been made to the current file since it was opened, you will be 
asked if you wish to save it.      After taking action on the current 
file, RR-Track closes, returning you to the desktop.

Procedure:
1. From the menu bar, select File|Exit from the drop down menu.
2. You will be asked to confirm that you wish to exit.    If you do, click the OK button, or click 

the Cancel button if you have changed your mind and do not wish to leave RR-Track.
3. If any open layouts have been changed since your last save, you will be asked if you wish

to save them.    Click Yes to save the layout file, or No if you do not wish to save the 
layouts.

4. If you elected to save the layouts, RR-Track displays the Windows save file dialog.    You 
may then use the drive and directory folder icons, and the file name listbox to select a 
save file name.

5. RR-Track terminates, returning you to the desktop.  



Opening a Layout File
To open an existing layout file for viewing or editing, use the File|
Open... command from the file menu.    The current layout file, if 
any, will be closed.    If any changes have been made to the 
current file since it was opened, you will be asked if you wish to 
save it.    After taking action on the current file, RR-Track displays 
the Windows open file dialog, at which point you may indicated 
the drive, directory, and file you wish to open.

If you are running RR-Track under Windows 95, you can use long file names (up to 255 
characters) in order to be more descriptive in naming your layout files.    
Procedure:
1. From the menu bar, select File and then Open... from the drop-down menu. The current 

layout, if any, will be saved.
2. From the choices shown in the open file dialog, select the layout file (yourname.rrt) 

which you wish to open by manipulating the drive icon, the directory folder icon, and 
selecting the layout file from the file names listbox.

3. When satisfied with your choice, click the OK to open the file, or Cancel if you have 
changed your mind and wish to return to the RR-Track main window.

    if you are using the File Manager or Explorer to sort through layout files (those with 
the .RRT type) you can open them by double-clicking on them since RR-Track v3.0 is a 
registered drag-and-drop client.    You can also open them by dragging them from the 
Explorer or File Manager window to the RR-Track icon.    In Windows 95 or Windows NT 4.0 
you can right click on a track layout file and choose Open.
see also:
saving a track layout file 



Creating a New Layout
You may create a new layout at any time using the File|New 
command found under the File menu. The current layout file, if 
any, will be closed.    If any changes have been made to the 
current file since it was opened, you will be asked if you wish to 
save it.    After taking action on the current file, the drawing size 
dialog will be displayed, at which point you set the new layout's 
width and depth (these may be altered at any time using the 
drawing size command in the Options menu).

Procedure:
1. From the menu bar, select File|New... from the drop-down menu.    The current layout, if 

any, will be saved.
2. Using the spin buttons set the width and depth of the new drawing.    
3. Click the OK button if you are satisfied with the new dimensions, or Cancel if you change 

your mind and wish to return to the RR-Track main window.
see also:
opening a layout file, saving a layout file , cloning a layout
 
 



Credits Font
The font used to print the layout credits at the bottom of the page is fixed at Arial, 12pts.



Status Bar Font
The font used in the Status Bar is configured using the Choose 
Font dialog contained in Windows 3.1, Windows 95, and Windows
NT.    

In this dialog there are three main sections:    Font listbox, Font Style listbox, and the Size 
listbox.    

 There is also a window which shows the results of your selection, radio buttons for extra 
elements such as underlining and strike through, and a listbox for the color, which is 
inoperative in RR-Track.    The Font listbox (upper left) is used to select the font family (i.e. 
Arial, Courier, Times Roman, etc.), the Font Style box is used to select the face style 
(normal, italic, bold, bold italic), and the Size listbox (right side) is used to set the point 
size.    The results of your configuring are shown in the Sample window.    Selecting OK 
immediately redraws the Status window with the new font, while Cancel returns you to the 
main window.    For more information on font selection with the Choose Font dialog, see 
your Windows 3.1 manuals.
{ewl hmew2,ewBitmap2,WARNING.BMP} If you choose a font that is too large, you may not
leave enough space on the status bar for some of the information RR-Track conveys, such 
as the current working layer and the last track selections.



Track and Select List Windows Font
The font used in the Track List and Select List windows is 
configured using the Choose Font dialog contained in Windows 
3.1, Windows 95, and Windows NT.    

In this dialog there are three main sections:    Font listbox, Font Style listbox, and the Size 
listbox.    

 There is also a window which shows the results of your selection, radio buttons for extra 
elements such as underlining and strike through, and a listbox for the color, which is 
inoperative in RR-Track.    The Font listbox (upper left) is used to select the font family (i.e. 
Arial, Courier, Times Roman, etc.), the Font Style box is used to select the face style 
(normal, italic, bold, bold italic), and the Size listbox (right side) is used to set the point 
size.    The results of your configuring are shown in the Sample window.    Selecting OK 
immediately redraws the Track List and Select List windows with the new font, while Cancel
returns you to the main window.    For more information on font selection with the Choose 
Font dialog, see your Windows 3.1 manuals.



Track Labels Font
The font used for labelling track and accessory items is 
configured using the Choose Font dialog contained in Windows 
3.1, Windows 95, and Windows NT.

In this dialog there are three main sections:    Font listbox, Font Style listbox, and the Size 
listbox.        

 There is also a window which shows the results of your selection, radio buttons for extra 
elements such as underlining and strike through, and a listbox for the color.    The Font 
listbox (upper left) is used to select the font family (i.e. Arial, Courier, Times Roman, etc.), 
the Font Style box is used to select the face style (normal, italic, bold, bold italic), and the 
Size listbox (right side) is used to set the point size.    The results of your configuring are 
shown in the Sample window.    Selecting OK immediately redraws the track layout with the 
new font, while Cancel returns you to the main window.    For more information on font 
selection with the Choose Font dialog, see your Windows 3.1 manuals.
 



Track Laying Tips
Here are some handy tips that will speed up track laying and 
positioning.    We are sure there are many other helpful hints that 
you have garnered together; we would be interested in hearing 
about them

(1) Use the zoom-in and zoom-out commands and the view stack.    I have found it 
to be effective to start with a large overview, not necessarily of the entire layout but a 
large fraction of it, and then zoom in to where I want to do some work, the return to my 
overview using the Last View command under the View menu.    Occasionally I move 
around the layout at high zoom factor using the scroll bars, or holding down the SHIFT key 
while moving the pointer near a border, but I find this less effective.
(2) Make use of the selection modes.    Remember, clicking once with the leftmouse 
button on a track section selects just that section; double-clicking with the leftmouse 
button selects that section and all of the contiguous track sections.    Which sections are 
chosen depends on the extended selection mode you have checked on the Options menu:   
Selects Include Joints selects all of the physically joined track (the whole loop, sidings, etc.)
while Selects Include Blocks chooses all of the electrically connected track (everything 
between the block break symbols); Selects Include Grades only chooses track either on the 
same grade or elevation.    If you haven't set any block breaks, then Selections Include 
Joints and Selections Include Blocks are identical in action.    Double-clicking on an 
extended selection    causes that selection to collapse to only the track section under the 
pointer.    By using these, and pausing for the Move cursor to come in, you can quickly go 
back and forth between choosing one piece of track and many pieces of track.
(3) Use Align to Nearest Track.    I use this command, under the Action menu, to find out 
where to place a curve when I am closing a loop, or lining up turnouts, to place a couple of 
long straight sections on both sides of the closure point, letting them overlap and 
graphically show me the intersection.    I can then place the curve or turnout I need pretty 
accurately by the 'calibrated eyeball' method, especially if you zoom in on the intersection. 
Be wary of zooming in too far on curves though;    Windows graphics engine has trouble if 
the center point of a curved arc is too far off screen, and throws in the towel by not 
drawing the arc, leaving you with nothing to show you the location of the curved section.    
When done, just delete the unneeded alignment tracks, and replacement them with 
properly cut sections.
(4) Work with AutoJoin turned on.    I always use the Autojoin mode, and override this as
necessary by hitting the escape key as needed, to temporarily turn Autojoin off.    You may 
also override automatic joining simply by placing the newly added track far enough away 
from existing track to be outside the capture radius ( 6" for HO, 12" for O-gauge, 18" for G-
gauge, etc.).    I bring the ends that I want joined as close as possible, and then click the 
mouse.    Autojoin can fail if you are trying to add track in a densely populated area with a 
number of loose ends;    sometimes the end you aren't watching is closer to another section
of track than the end you are watching.    Remember that the Autojoin mode also applies to 
moving pieces of track.    If you get free ends within a track width, RR-Track will join them 
for you without you having to do this yourself.    This can be a problem in dense areas, such 
as switch yards, where you may want to turn this off.
(5) Work with Allow breakaways turned on.    This makes it much faster to unjoin track 
from existing configurations.    You merely have to drag it 10 per cent or more of the screen 
size, and RR-Track will break the junctions for you.    When combined with Automatic Track 
Joining, which lets you put track back together simply by bringing the ends within one track
width, reconfiguring layouts is much quicker.
(6) Work with automatic loop closing and proximity joining turned on.    I generally 



use these modes since mistakes are rare and it forces me to not try and bend too many 
track sections to close gaps bigger than a track width, minimizing the chances of designing
a layout that has sections likely to cause derailments.
(7) Make use of Copy ,Paste, Duplicate, and Duplicate Parallel.    I use this 
combination frequently to duplicate 90° and 180° curved arcs of track in order to quickly 
throw a new loop together, or whole parallel sidings when designing a switch yard.    The 
Duplicate function is very useful for replicating custom bent or cut track sections where 
you aren't interested in making a number of copies.    Duplicate Parallel is handy for 
creating sets of parallel tracks in switch yards, etc. 
(8) Use multiple drawing layers.    Setting up even simple, small layouts with multiple 
layers is a real help.    You can put scenery in a layer, accessories in a layer, track in a layer. 
In this way you can set the track layer to inactive so that you can see it but you can't select
it so that it doesn't get in your way when you are setting up accessories and scenery.    This 
same thing is true for scenery:    you can draw some scenery, then set that layer to 
inactive, and then adjust track and/or accessory positions as necessary without the scenery
getting in the way.    See working with layers for more information.
(9) Use the Select List Window to tell you details on selected track.    The select list 
window automatically totals the highlighted track sections, giving you the total length and 
the estimated number of average size cars this track will acommodate.    This is a handy 
way to find out if either a passing siding, or a reversing loop, is long enough to handle the 
trains you plan to run.    You can also use the listing to see if you have a track power section
in an electrical block when you set the extended selection mode to Selects Include Blocks.   
For track systems that have dedicated electrical connection tracks, this is a handy way to 
make sure you have adequately set up your track power connections.    By setting the 
extended selection mode to Selections Include Grades, you can use the Select List Window 
to show you the length of all of the track on a grade; this informatin can also be obtained 
by pulling down the Grades menu and choosing Information...
(10) Use the Lock/Unlock functions to fix track sections you don't want to move.    
One of the most irritating things is moving the wrong block of track accidentally.    If you 
have a hard, or a large loop and want to use this as a fixed reference for other track, then 
select it and choose the Lock command from the Action menu.    This will keep you from 
accidentally moving, deleting, or rotating these items.
(11) Add elevations and grades last.    It is usually better to design all, or almost all of 
the track plan before you begin raising/depressing track sections.    Introducing elevations 
and grades always adds to the complexity of the layout, and makes it more difficult to 
change design parameters later (short of removing the entire elevation, which you can do 
by either using the Remove Elevation command or Zero Track Height command). 

.        



Library Menu
The Library drop-down menu is used to set the active track or 
accessory library.    

Entries exist on the menu for all of the track libraries in your copy of RR-Track; a check 
mark indicates the currently active library whose components are represented on the Track
menu (this will be title the Accessory menu when the current library is an accessory 
library).    The current track libraries are (those in dark blue are available now, those in red 
are planned):
Track libraries:

Lionel®/K-Line® O-27
Lionel® O-gauge
Lionel® Super-O
Curtis HiRail O
Ross Custom Switches O
GarGraves O
MTH O
Atlas O
 
LGB® G
MicroEngineering G
AristoCraft® G
TDV G
Llagas Creek G
 
American Flyer/GarGraves/American Models S
Lionel®/Rydin standard gauge
 
Atlas® HO
Pilz®/RailTech code 100 HO
Pilz®/RailTech code 83 HO
Shinohara® HO
Kato® HO
Peco® OO/HO
Märklin®-C HO
Märklin®-K HO
Märklin®-M HO
Hornby OO/HO
 



Atlas® N
Kato® Unitrack N
Peco® N
Tomix® N
Fleischmann N
 
Pilz®/RailTech code 80 TT
Märklin® Z
Peco® Z 

accessory libraries 
Lionel® pre-war accessories
Lionel® post-war accessories
Lionel® modern/MPC accessories
Gilbert post-war accessories
Plasticville® accessories
Pola® G-gauge accessories
Piko G-gauge accessories
MTH accessories

For up-to-date information on the availability, and contents of, these are other future track 
and accessory libraries, please access our web site at:

http://www.rrtrack.com/rrtrack



Grades Menu
The Grades menu contains commands that allow you to elevate 
track, remove elevations, show elevated and grade track, and 
get information on elevations and grades. 

Many of these commands will be grayed out unless there is both selected track and the 
extended selecting mode is set to selections include grades.
Change elevation...    this is the fundamental command for elevating or depressing a 
section(s) of track.    Choosing this command will bring up the Change Track Elevation 
dialog with the currently selected track sections highlighted.    You interact with the controls
in the dialog to graphically alter the elevation of the selected track sections while RR-Track 
automatically carries out grade calculations.    For more information seeelevating track.
Remove elevation    this command returns the elevated track and all of its connected 
grades to zero height.
The following four commands let you manually set various aspects of elevations and 
grades.
Reconcile grade    this command examines the selected grade and removes any non-
uniformity's which may have resulted from the interaction and collision of grades from the 
elevation of several pieces of track.      The track junction heights are recalculated as a 
result of this command.
Create grade:    this command takes the selected track sections and creates a grade from 
them, with the height of the track sections connected to either end determining the per 
cent grade.    This command, along with the Set Track Height command, let you manually 
insert grades and elevations into a layout.
Set Track height:    a catchall command that will allow you to set the absolute height of the 
selected track.    This command sets the height of the selected track or objects to that set 
in the dialog, removing any grade attributes that may have been set.    Any grade track 
connected to the selected track is automatically reconciled.    This command, in conjunction
with the Create grade command, let you manually insert elevations and grades into a 
layout.
Zero track height:    another catchall command that will take the height of the selected 
track, regardless of whether it is connected to other elevated track sections, and set it to 
zero.    This command is used when all else fails to remove unwanted dangling grades.
The next four commands are for informational purposes on elevations and grades.
Information... summons the grade information dialog which displays the number of track 
sections, change in height, total length, and per cent grade for the selected grade.    Useful 
for checking up on the exact slope parameters for a given grade.
Calculator...    summons the grade calculator, a dialog that lets you play around with track 
height changes, lengths, and the per cent grade.
Show grade track    selects and highlights all of the track in the layout that is on a grade.    
Graphically shows you where the grades are at on your layout.
Show elevated track    similar to the above command, but instead shows all of the track 
sections at non-zero height and not on a grade.
For more information on all of these commands and their interactions, seeelevating track 



Object Menu
The object menu contains commands that allow you to create 
simple geometrical shapes and add them to your layout.    

The simple objects available consist of rectangles, circles and lines.    Once placed into your
layout, these objects may be selected, moved, and rotated just as you would manipulate 
track sections.    They may not, however, be joined to track sections.    One exception is text
labels, which may not be rotated and will not respond to the Rotate command.
Somewhat more specialized objects such as a railroad bridge, hip-roof building (both 
subtypes of the rectangle object), and various trees (a subtype of circles) are available for 
placement in your layout.
The Object menu is divided into four submenus: Basic shapes, Buildings, Scenery, and 
Special objects, as well as a command use to set object drawing properties found at the 
bottom of the menu.    The submenus may be torn off and left on screen just as for any 
other menu in RR-Track.
Basic shapes:    these include rectangles, circles,    straight lines., polygons , polylines , 
filled rectangles,    filled circles , and filled polygons , filled rectangles with X-ing to denote 
structural members.
Buildings:    these include a plain building, hip-roof building, a railroad bridge/overpass, 
turntable, and a water tower.
Scenery:    these include deciduous trees, evergreen trees, a more realistic randomized 
tree,    spring and fall trees with colors randomized around medium green and orange-
yellow respectively, winter trees with 12 random forked branches, 2-tone and 3-tone spring
and fall trees, boulders.and random colored boulders, embankments ,    ponds , and multi-
level mountains.
Special objects:    these include electrical connections. and text labels .
Set Object Properties :    this command calls up a dialog which you use to set the drawing 
properties of current and future objects.
see also:
editing objects



Shorthand (right mouse) Menu
The shorthand menu contains a subset of the most used 
commands from the main menu accessed though the menu bar.   

This menu may be called up by clicking the right mouse key when not engaged in some 
other graphical operation such as moving track or drawing a selection rectangle.    The 
commands on the shorthand menu are:
Last track:    selects another    piece of track identical to the last one added to the track 
layout.    This item will be grayed out if track families have been changed and a new track 
section from the current family has not been added to the layout.
Undo last track:    removes the last track section added to the layout from the track list.    
This item will be grayed out if the last track section has just been removed, and another 
has not been subsequently added to the layout.
Copy:    copies the selected track or other objects to the RR-Track clipboard.
Paste:    pastes the RR-Track clipboard contents into the track layout.
Delete:    deletes the selected track or other objects from the track layout.
Duplicate : duplicates the selected track or objects.
Rotate...:    rotates the selected track or other objects.    Choosing Rotate from the 
shorthand menu calls up the Quick Rotate dialog in contrast to the Rotate command under 
the Action menu which calls up the more detailed Rotate dialog.
Toggle overpass:    toggles the overpass characteristics of the selected track in libraries 
which support this.
Snap size: calls up the Set Snap Size dialog.    This is the same as pulling down the Options 
menu and choosing Set Snap Size.
Zoom in 2x:    actives the zoom window for zooming in by a factor of 2.
Zoom out 2x: moves the view out a factor of 2. 



Options Menu
The options menu controls properties of the active layout.    

These span a wide range and include the current track family, the physical size of the 
drawing, the type of coordinate overlay, what style of track/object rendering is desired, and
the joining and selecting modes.
The following command sets the drawing size and attributes:
Drawing size... allows the physical size of the current layout to be changed.
The following command lets you manipulate the drawing layers in the layout:
Layers... this brings up the Layer Setup dialog which lets you add, rename, delete, and set 
the visibility properties of layers in your layout.
The following commands set the scale of the display coordinate grid:
6" grid sets the display coordinate grid to 6-inch boundaries.
12" grid sets the display coordinate grid to 12-inch boundaries
24" grid sets the display coordinate grid to 24-inch boundaries.
48" grid sets the display coordinate grid to 48-inch boundaries.
No grid turns off the display coordinates.
The following commands controls the layout rendering:
Detailed track render toggles the track rendering between simple and detailed.
Snap objects to grid : toggles the sizing and placing of general purpose objects (rectangles,
circles, lines, etc.) from any position on the layout to only those set by the Set Snap Size 
command.
Set snap size:    displays a dialog box showing your choices for the size of the snap grid.
Set joining error    displays a dialog box that lets you introduce a small error at each track 
junction when assembling track.    This allows for small expansions of the layout due to 
inaccurate track joining.
Label track : toggles the display of abbreviated track labels on track and accessories.    The 
same as setting this option in the Layout Options dialog.
Set track color : displays a dialog box which lets you set the draw and fill colors for 
individual track libraries.    These will then be the default colors for track of that 
manufacturer.    These colors can be overridden by setting the default track colors for the 
layer the track is in.    See Layers for more information.
The following commands control the track joining modes.    These apply to all 
layouts. These modes can also be changed on the multi-function status bar.
Autojoin new track toggles the joining mode for newly added track between automatic and 
manual.
Automatic loop closing toggles the loop closing mode between automatic (sensed by RR-
Track), and only manual.    Manual loop closing (Close Contiguous Loop) is still enabled 
when automatic loop closing is turned on.
The following commands control the extended selecting modes.    These apply only to the 
active layout; each layout can be individually configured for extended selection modes.    
These modes can also be changed on the multi-function status bar.
Selections include joints sets the extended selecting mode to all track connected to the 



track under the cursor.    Setting this mode disengages all other extended selection modes.
Selections include blocks sets the selecting    mode to all track electrically connected to the 
track under the cursor.    Setting this mode disengages all other selection modes.
Selections include grades sets the extended selecting mode to all track either on the same 
grade or at the same elevation.    Setting this mode disengages all other extended selection
modes.
The following command enables access to further application controls:
Options...displays a dialog box which lets you configure settings that apply to all layout 
windows such    as joining modes, background colors, move transition time delays, track 
library colors; and allows you to access the Layout Options dialog which controls settings 
that affect only the active layout.
see also:
setting local layout options 



Track Menu
The track menu consists of track types available in the current 
track family.    

This menu changes when a different track family is selected since the detailed varieties of 
track sections vary between the different families.    In general, all track families have 
straight sections, curved sections, turnouts, and a number of special purpose track sections
such as bumpers, uncoupling sections, insulated sections, etc.    Some track libraries have 
other submenus reflecting items unique to that track family.    Accessory libraries have 
submenus typically divided up into bridges/trestles, lights/lamps, trackside items, 
stations/buildings, and action items.    When you use the Library command to switch to an 
accessory library, the top level menu bar changes the Track menu to Accessories.
The first item on the track menu is last track and simply allows you to add a track section 
to the layout that is identical to whatever section was previously added.    You may also 
accomplish this task by double-clicking the left-mouse button with the cursor in an empty 
area of the layout, i.e. not an area occupied by either an object or track.    You can access 
the last 10 distinct track or accessory items added to the layout by going to the Last track 
button on the multifunction status bar. 
Track libraries that have track wizards will have a command, Setup wizard,    that lets you 
set various parameters to control the operation of the track library wizard.



Action Menu
The action menu contains the commands that carry out 
operations on selected objects in the layout.    

These operations consist of rotating track and other objects, creating or breaking joints 
between track sections, aligning joints between track sections, and moving track sections 
in order to minimize the alignment errors at junctions.
Rotate... perform angular rotations on selected objects.    This command calls up the 
standard Rotate dialog;    the Rotate command under the shorthand menu calls up the 
Quick Rotate dialog.
Move...  carry out incremental movement of the selected objects without using the mouse.
Move to layer    this lets you move all of the selected items to another drawing layer.    This 
is most useful when you add new layers to an existing layout in order to minimize visual 
clutter.
Unjoin selected track break all joints in, and between the selected track and the rest of the 
layout.
Join to nearest create a joint between the selected track and the nearest unjoined track.
Close contiguous loop closes loops in the selected track.    Normal track joining will not 
close a contiguous loop when automatic loop closing is enabled if the gap between track 
ends is too large.    You will generally not need to use this command.
Align : this submenu allows you to access three commands for aligning track and objects 
with the coordinate grid, or other track/objects.    The alignment commands consist of:

Align to coordinate grid:    lets you align one or more edges or centers of the selected 
track to the coordinate grid at the current snap resolution.
Align to designated object : lets you align the edges and/or centers of the selected track 
to another track section or object.
Align to nearest track : lets you align the selected track with the nearest unjoined track.   
Like joining, but the track sections are not actually joined.

Break Joint breaks single joints in the selected track.    This is different from Unjoin track, 
which breaks all the joints in the designated track.    This command is only needed for 
special purpose, such as severing the connection between track sections which are then 
allowed to remain in place.    You normally break track junctions by dragging the track away
with the mouse. 
Group objects groups all objects in the select list.    
Ungroup objects ungroups the first grouped object in the select list.
Move to front changes the position of the lead selection, either track or object,    in the 
display list, so that it will appear in front of (on top of) all other track.
Send to back : the reverse of Move To Front, this changes the position of the lead selection 
in the display list so that it appears to be behind all of the other track sections.
Set/Clear block breaks: toggles the placement of an electrical block break at the 
designated joint in the selected track.    The track is still physically joined.
Clear all blocks: removes all of the electrical block breaks in the selected track.    The track 
is still physicall joined.
Create block: sets electrical block breaks at all of the ends of the selected track.    The track
is still    physically joined.    This is a faster way to create blocks than using the Set/Clear 
block break command, which is used to set/clear a single break.



Lock selected items :    locks the selected track and objects into position on the layout.    
Any attempt to move or rotate locked items will fail.
Unlock selected items : unlocks the selected track and objects so that they may now be 
moved and rotated.
Relax selected track configuration adjust the position of the selected track to minimize 
junction alignment errors.
The items in this menu will only be enabled if track or other layout objects have been 
selected (highlighted).



File Menu
Under the file menu are the commands that create new layout 
files, open existing layout files, save layout files, and print layout 
files.    

The file menu commands vary depending on the current state of RR-track.    When first 
started, the available commands are:
New...create a new track layout
Open...open an existing track layout (for example, mylayout.rrt).
Exit close the RR-track application
When either a new track layout has been created, or an existing layout is opened, the file 
menu changes, adding the following commands:
Save saves the active track layout to a disk file using the current name.    This over writes 
the old layout with the active layout.
Save as...saves the current layout to a disk file.    The Save as... command lets you save the
active layout under a new name.
Print layout... print the entire layout.    You can indicate on the preview window which pages
of the layout you wish to print, as well as configure fonts and labels.
Printer    this calls up the printer information dialog which you can use to both select the 
current RR-Track printer, and configure the printer settings.
Page setup setup the look and style for the current screen view when printed
Clone Layout lets you create an untitled copy (clone) of the active layout.    Good for 
creating variations on a layout design.
Export...    lets you save the current screen image as a Windows Bitmap (BMP) file for 
inclusion in other documents.
RR-Track appends the names of the last four layout files after the Exit command on the File 
menu.    You can re-open one of these by simply clicking on it.
 



Edit Menu
The Edit menu encompasses the commands that operate on 
track and other layout objects.    

As is the case for many menu items, the commands under the edit menu will be enabled 
and disabled reflecting the current state of the track layout.
Undo delete undoes the last deletion of less than 100 items from the layout.
Cut delete the selected object from the layout and copy it to the clipboard
Copy copy the selected objects to the clipboard.
Paste paste the clipboard contents into the layout.
Delete delete the selected objects from the layout.
Duplicate : duplicate the selected objects on the layout.    This command combines Copy 
and Paste, destroying the clipboard contents in the process.
Duplicate parallel : creates a duplicate set of track parallel to, and offset from, the selected
track.    You work through the Duplicate Parallel dialog to set and preview the offset.    This 
command, like the simpler duplicate command, combines Copy and Paste, and destroys 
the clipboard contents in the process.
Select all    selects all of the track and objects in the layout.    Easy way to grab everything 
at once.    This is the same as dragging a selection box around everything.
Select all in layer    . this selects all of the items in the layer that you choose.
Select all visible    this selects all of the items in the active layout that are currently visible 
(i.e. not hidden or grayed).
In order for the cut, copy, duplicate, duplicate parallel, and delete items to be enabled, 
track or other layout objects must be selected (highlighted).    The paste command is 
disabled when the RR-track clipboard is empty, but enabled otherwise.    The commands in 
this menu are also accessible using the keyboard shortcuts shown in the drop-down menu.  
The Undo delete command must be used immediately after you delete the items you want 
to restore;    any further changes to the layout will disable this command.



View Menu
The view menu contains the commands that manipulate the 
location and zoom of the RR-track windows.    

These include zooming in and out on the track display, redrawing the display at any time, 
and showing or hiding the auxiliary information windows.    The center position of the track 
display may also be adjusted by using the horizontal and vertical scroll bars at the bottom 
and right margins.
Zoom in 2x zoom in on the layout by a factor of 2.    Also found on the shorthand menu.
Zoom in 4x zoom in on the layout by a factor of 4.
Zoom out 2x zoom out the layout view by a factor of 2.    Also found on the shorthand 
menu.
Zoom out 4x zoom out the layout view by a factor of 4.
Last view return to the previous view.    Also accessed using the F3 key.
Home view set the upper left corner of the screen to the upper left corner of the layout, 
and zooms out to show the entire layout.    Also accessed using the F2 key.
Fit in window    this takes the layout, at the current zoom factor, and adjusts the scale to get
the best fit to the current layout window size.    Whenever you maximize a layout, and the 
zoom factor is 1, RR-Track automatically does a best fit to the maximized window.    This is 
so that you can get the best possible view of your layout.
Redraw force a redraw of the current view.
Show status toggle between showing and hiding the status window.
Show track list toggle between showing and hiding the track list window.    RR-Track displays
the track list for the active layout window.    If the Track List window is visible, RR-Track 
automatically changes the contents as you change the active layout.
Show select list toggle between showing and hiding the select list window.
Show locked items    highlights all locked track, accessory, and drawing objects in the 
layout.    You can use this command to quickly unlock all locked items by choosing Unlock 
Selected Items from the Action menu subsequent to using this command.
The four zoom commands, together with the home view command, the Fit in window 
command, and the scroll bars at the bottom and left margins, collectively control the 
display scale for the screen display.    The three show commands control the display of the 
auxiliary information windows that show mouse location and display mode, the list of the 
track in the layout, and the list of objects that are currently selected(highlighted).

 RR-Track maintains a view stack with a depth of 2.    This means that whenever you change
views (change zoom factor), RR-Track remembers the previous view (both position and 
zoom factor).    You can then choose Last View to go back to where you were.    For example,
suppose you are viewing part of your layout (we will call this view 1).    You then choose 
Zoom In 2X and examine another part more closely (we will call this view 2).    .    When you 
choose last View, RR-Track returns you to view 1.    If you choose Last View again, RR-Track 
returns you to view 2 since it is now the previous view from view 1.    In this manner you 
can toggle back and forth between an overview of your layout and a small closeup view for
detailed work.
 



    



Help Menu
The help menu commands control the access to the Windows 
hypertext help utility.    

The help RR-track help file, part of which you are reading, contains help and information on
topics germane to the track layout application.    The help topics may be accessed using the
commands in this menu and the Help button found in most dialog boxes.
Contents.. starts the help utility and displays the RR-track help table of contents.
Search for help on..starts the help utility and opens the keyword search window.
Getting started    starts the help utility and opens it to the tutorial on getting started with 
RR-Track.
About... displays the About message for the RR-track application.    This shows you both the
current version and the build sequence number.
 



Window Menu
The Window menu in RR-Track contains the commands that are 
used to manipulate the various layout windows.    

These are:
Cascade choosing this resizes all layout windows to a standard size (that is determined by 
Windows) and arranges them in a cascade starting at the upper left of the main RR-Track 
window, with the active layout window on top.
Tile    choosing this tiles all of the open layout windows in the main RR-Track window.    
Again, the sizes are chosen by Windows.
Arrange icons    this neatly arranges the minimized layout windows along the bottom of the 
main RR-Track window.    The order is determined by the order of minimization.
Close all    this closes all layout windows.    You are prompted to save the layout files if you 
have not done so since the last change.
Appended below the Close All command is a list of the open layout windows.    You can 
switch to any of these simply by choosing the layout.
 



The Goal of RR-Track, MTH RealTrax Edition
The principal goal of RR-Track, MTH RealTrax Edition    is to enable anyone to quickly, easily, 
and accurately create a track layout for toy trains from the principal building blocks, 
sectional track from MTH Electric Trains.    Whether the layout be a simple Christmas display
looping under and around the Yule tree, or a complex miniature railroad consisting of 
hundreds of pieces of sectional track connecting whimsical towns, village, factories and 
farms, it can be designed with RR-Track.    RR-Track turns any Windows-based PC into a 
sheet of electronic graph paper, allowing for endless combinations and what-if scenarios 
without involving messy erasures and clumsy templates.    The major advantage of 
computer-aided-design (CAD) is that the computer's drafting table is infinitely erasable and
reconfigurable.    Further, layout drawings may be saved at intermediate points in the 
design process, making retracing your steps to an earlier stage fast and easy.
In the course of design of your toy train layout/model railroad you will rapidly discover that 
it is much quicker and easier to 'game out' track configurations using RR-Track and your PC 
than to discover, on the floor, that O-72 curves won't quite fit between Grandma's antique 
china buffet and the Xmas tree.    If the track doesn't fit in RR-Track, then it won't fit on the 
layout.    All of the sectional track in the track libraries is accurate to less than 0.1 inch, 
making accurate assessments of clearances and distances easy.
RR-Track, MTH RealTrax Edition has track libraries containing all of MTH Electric Train's 
RealTrax sectional track components as well as MTH RailKing accessories.      Additional 
libraries for track from other manufacturers may be purchased from R & S Enterprises.    For
more information on track and accessory libraries available for RR-Track, MTH RealTrax 
Edition, visit the RR-Track website at 

www.rrtrack.com/rrtrack.
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RR-Track Licensing Information
RR-Track copyright 1993 - 1998 by Russell S. Becker

R & S Enterprises
all rights reserved.

retail version
License agreement:    This is a legal agreement between the purchaser and R & S 
Enterprises, a private company under the laws of the Commonwealth of Pennsylvania.    If 
you have purchases a licensed version and do not wish to abide by the terms of this 
agreement, return the diskette and all accompanying items, manual, etc. to R & S 
Enterprises for a full refund.
Use of this application for any period of time implies acceptance of the license terms.    RR-
Track is only one possible method for toy train layout design.    No claims beyond those 
explicitly stated are made for the accuracy of this software.    This application is provided 
AS IS with no warranty expressed or implied.
A single user license permits users to use RR-Track only on a single computer.    Licensed 
users may use the program on different computers as long as the program is not used on 
more than one computer at a time.      Site license    or network use requires a separate 
license.    No one may not copy or distribute any portion of the registered documentation,    
files, or executables except for registered users with the express purpose of backing up 
these files for personal use on a single computer.
Notice of copyright:    This is a copyrighted program.    This version is copyrighted by 
Russell S. Becker and has full protection under United States and international copyright 
law.    This program is to be sold only under written agreement between R & S Enterprises 
and the distributor.    This program is licensed for use only by the purchaser on a single 
computer.    Copying, distribution, or use by any person, business, corporation,    
government agency or any other entity without explicit written permission from R & S 
Enterprises is strictly prohibited and may subject the user to prosecution under copyright 
law.
GENERAL TERMS:    R & S ENTERPRISES HEREBY DISCLAIMS ALL WARRANTIES WITH 
RESPECT TO THIS PRODUCT, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.    SHOULD THE PRODUCT PROVE DEFECTIVE IN ANY WAY THE PURCHASER 
ASSUMES THE RISK OF SERVICING, REPAIR, CORRECTION, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES.
LIMITATION OF LIABILITY:    RR-Track IS PROVIDED COMPLETELY AS IS.    R & S 
ENTERPRISES HEREBY LIMITS ITS LIABILITY TO, AT R & S ENTERPRISES' SOLE DISCRETION 
1) THE ORIGINAL PURCHASE PRICE OF THE SOFTWARE OR 2) REPLACEMENT OF A 
DEFECTIVE DISK.    PURCHASER OF SOFTWARE AGREES NOT TO HOLD R & S ENTERPRISES 
AND IT'S OWNERS LIABLE FOR ANY DAMAGES WHATSOEVER BEYOND ONE OF THE TWO 
REMEDIES DESCRIBED ABOVE.    FOR REFUND OR REPLACEMENT, RETURN YOUR DISK TO 
THE ORIGINAL PLACE OF PURCHASE.
Shareware 30-day trial period:    Users of demonstration versions of RR-Track are 
granted a 30 day trial period to evaluate the program.    To use RR-Track beyond the 30-day 
trial period, you must register the product by remitting a fee to R & S Enterprises as 
described in the ORDER.TXT file.
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Font Menu
The Font menu is used to specify the fonts used for various 
elements in RR-Track.    

Currently, the only font configuration supported is that for the track labels.    
Track labels...    this command allows you to set the font used for the track labels (which are
themselves enabled/disabled by the global options command under the Options menu
List windows... this command allows you to set the font used for both the Track List and 
Select List windows.
Status bar... this command allows you to set the font used for the multifunction status bar.



Control Menu
The control menu is the small menu that you can pull down by 
single-clicking on the little icon at the upper left of a layout 
menu.    

It is called a control menu because most of the commands are provided by Windows and 
have to do with sizing and closing the window.    RR-Track appends two commands to this 
menu that let you access local layout options and layout information.
Restore    this restores a maximized or minimized window to its former size and position.
Move    this tells Windows you want to move the layout window, changing the cursor to the 
move cursor. This is exactly like grabbing the layout window in the caption area.
Size    this tells Windows you want to resize the window.    This is exactly like grabbing one 
of the window resizing edges. 
Minimize    collpases the window to an icon.
Maximize    blows the window up to the entire RR-Track main window client area.
Close    closes the window.    Exactly like choosing Close from the File menu.
Next    changes the focus to the next sibling layout in the window list.
Options    calls up the Layout Options dialog where you can set RR-Track options that apply 
only to the active layout.
Info    pops up a dialog showing you statistics on the active layout.
 



    
RR-Track 
MTH RealTrax®

Edition
Contents

RR-Track is a toy train layout visualization application.    It is designed to easily enable 
anyone to create, view, and edit toy train layouts consisting of Z-, TT-, N- HO-, O-, O-27, G-, 
S, and standard/wide gauge track.    Using RR-Track you can create layout designs ranging 
from a simple loop to complex layouts such as that typified by the Lionel® 1948 showroom
layout containing nearly 500 pieces of track and over 100 accessory and scenery items. 
RR-Track is designed as a layout tool for constructing toy train layouts but is just as, if not 
more, useful for considering "what if" situations in existing layouts, both in and out of 
doors, as well as "dream layouts" that are likely never to see the light of day.
This edition of RR-Track contains track and accessory libraries specifically tuned for MTH 
RealTrax® and RailKing® accessories.    Example layouts and descriptions of other track 
and accessory libraries that may be purchased for RR-Track can be found on the RR-Track
website at 

www.rrtrack.com/rrtrack

Overview
 Overview    

Tutorials
Getting started 
Drawing benchwork    
Making concentric curves    
Using overpass track sections    

Menu Items
File menu Track menu Grades menu  
Edit menu Object menu Options menu  
Action menu Font menu Window menu  
View menu Library menu Help menu 
CONTROL menu 

How do I ?
Align track sections
 
Change the working track family    
Change layer attributes 
Close a loop of track 



Copy track 
Copy track from one layout to another 
Copy a layout 
Create a new track layout 
Create a new layer 
 
Delete track 
 
Elevate track    
Edit objects 
 
Get layout information 
Get object information
Group or ungroup drawing objects 

Hide track

Join track sections 

Measure distances on your layout 
Move track 
Move items between layers 
Move items with the keyboard

Open an existing track layout 

Paste track into the layout 
Print a layout 
Print the track list 

Rotate track    
Remove a layer 

Save a layout to a file 
Select track and objects 
Set or change object drawing properties 
Set overall or global options 
Set individual layout options 
Show overpasses on the layout    
 
Tear off a menu 
 
Unjoin track sections 
Ungroup drawing objects    
Use the mouse or pointing device    
Use the multifunction status bar 

Miscellaneous
Tips 
Mouse uses and pitfalls      
shortcuts



Table of MTH RealTrax® length combinations
License 
How to order additional libraries for RR-Track 
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RR-Track shortcuts
The following keys provide shortcuts to commands in RR-Track:

Left-mouse double-click:    double-clicking the left mouse button when the cursor if over 
nothing is the same as pulling down the Track menu and choosing Last Track.    RR-Track 
gives you a track section identical to that last chosen from the Track menu.    This is the 
same as the first item on the Last Track List on the multifunction status bar.
CNTRL left mouse double-click:    holding down the Control key while double clicking the
left mouse button when the cursor is over nothing tells RR-Track to repeat the last object 
selected from the Objects menu.    
Space bar:    pressing the space bar tells RR-Track to repeat the last object chosen from 
the Objects menu.
Arrow keys
The arrow keys can be used to move    around the layout, to move selected objects, and to 
rotate selected objects.    
To use the arrow keys to move around the layout:

Hit the left arrow key to scroll 2 per cent of the view to the left, the right arrow
key to scroll 2 per cent to the right, the up arrow key to scroll up 2 per cent, 
and the down arrow key to scroll down 2 percent.

To move items with the arrow keys:
To move items with the arrow keys they must be selected (highlighted), and, if
track sections, not joined to other non-selected track sections. Hold down the 
SHIFT key and hit the left arrow key to move left, the right arrow key to move 
right, the up arrow key to move up and the down arrow key to move down.    
Each time you hit the arrow key the selected items move a distance equal to 
the current snap size setting.

To rotate items with the arrow keys:
To rotate items with the arrow keys they must be selected (highlighted) and, if 
track sections, not joined to other non-selected track sections.    Hold down the
CONTROL key and hit the up arrow key to rotate counter-clockwise and the 
down arrow key to rotate clockwise.    Each time the up or down arrow key is 
hit the items rotate by an amount equal to the current increment set for the 
quick rotate dialog.



Table of MTH RealTrax length combinations
The following table is provided as a guide for using the standard 
sections of MTH RealTrax in filling in gaps in your layout.    The 
entries for each length should not be viewed as necessarily the 
only possible solution, although many are.    Entries in red cannot 
be achieved with the current track components.

Length 3.5 4.25 5.0 5.5 10.0
3.5 1

4.25 1
5.0 1
5.5 1

7.00 2
7.25
7.50
7.75 1 1
8.00
8.25
8.50 1 1
8.75
9.00 1 1
9.25 1 1
9.50
9.75 1 1

10.00 1

Length 3.5 4.25 5.0 5.5 10.0
10.25
10.50 1 1
10.75
11.00 2
11.25 2 1
11.50
11.75
12.00 1 2
12.25
12.50 2 1
12.75 3
13.00
13.25 1 1 1
13.50 1
13.75
14.00 1 1 1
14.25 1 1
14.50 1 2
14.75 1 1 1



Length 3.5 4.25 5.0 5.5 10.0
15.00 1 1
15.25 1 2
15.50 1 1
15.75
16.00 1 2
16.25 1 3
16.50 3
16.75 2 1 1
17.00 2 1
17.25
17.50 2 1 1
17.75 1 1 1
18.00 2 2
18.25 1 1 1 1
18.50 1 1 1
18.75 1 1 2
19.00 1 1 1
19.25 1 1 1
19.50 1 1 2
19.75 1 1 1
20.00 2



How to order additional libraries for RR-Track
Other libraries for O-gauge as well as other gauges of track and accessories may be 
purchased by contacting R & S Enterprises at:

R & S Enterprises
POB 643
Jonestown, PA 17038-0643
(717) 865-3444

INTERNET: http://www.rrtrack.com/rrtrack
e-mail: rsbecker@rrtrack.com

The current price for individual track libraries is $12 and accessory libraries are $25; 
multiple library discounts are available.    For more information, check out the RR-Track 
website at:

http://www.rrtrack.com/rrtrack
On the RR-Track website you can download example layouts using various track systems, 
as well as a copy of RR-Viewer3D that lets you visualize your MTH RealTrax layout in three 
dimensions so that you may get a better idea of the appearance of your layout. 



Railroad Turntable
The turntable item in the Object menu creates a railroad 
turntable object and adds it to the layout.    

Turntables are 24 sided polygons with an inner and outer rim, and a center rotating 
platform.    The turntables have 24 radial lines at the edges to indicate potential connection
points;    these are spaced every 15°.    
Turntable objects may be moved, cut, and copied like track sections, but they may not be 
joined to a piece of track since they are not electrically connected to the layout.    You may 
edit the outline drawing color, style, and fill color of turntables ( see setting object 
properties ).
Procedure:
1. Select the Turntable item from the Object|buildings menu.    The cursor changes to a 

cross-hair, indicating that you are to designate the center of the circle.
2. Move the cursor to the point at which you wish to locate the circle.    The status window is

updated as you move the cursor, showing the current position in the layout.    Press the 
left mouse button and hold it down.    The cursor changes to a horizontal arrow and the 
title 'Size'.    You have now designated the center of the circle.

3. While continuing to hold the left mouse button down, drag the cursor to where you wish 
the edge of the circle.    The screen will dynamically display the circle swept out, while 
the status window will display a continuous update of the circle's radius.

4. When you are satisfied with the circle, release the left mouse button.    This establishes 
the radius of the circle which is now drawn, while the cursor changes back to the 
Windows arrow.    

 



Text Labels
You can create and place text labels in our layout using the Text 
Labels object under the Object menu.    

Text labels are like other objects and may be moved and grouped as you see fit (but not 
rotated).    Text labels may also be edited through the Object Properties dialog.    When you 
choose this object, you immediately see a dialog:

 
You enter the text you want to add to the layout in the large edit box in the upper left, 
including carriage returns if you want multiple lines.    The other controls are used to set the
properties of the text label.
Font...    pressing this button calls up the Windows Font Chooser letting you select the type 
face, size, color, and other attributes of the font used for the text label.
Default font : pressing this key sets the currently selected font as the default font for any 
subsequent text labels.    You do not have to use the default font, but if you want a lot of 
labels with a certain type face and size, this is useful.
Back color:    pressing this button calls up the Windows Color Chooser so that you can select
the background color for the text label.    This is only active if you have checked the Opaque
Background button.
Border:    draws a rectangular border around the text the same color as the text color.
Opaque Background:    sets the background opaque rather than transparent, which is the 
default.    When you check the Opaque background button, you may now also set the 
background color by pressing the Background Color button.
Justification group:
Left, centered, and right : these control the current text justification setting with left 
justified the default.
Cancel:    aborts creating a text label.
OK:    takes the current setting of the dialog, and the text in the edit box and creates a text 
label.    The dialog disappears and a box which bounds the text appears under the cursor.    
You can move this box to wherever you wish, placing it by single-clicking the left mouse 
button.    A text label object is like any other object, and may be moved around as you wish.
You may even edit the content and properties after you have created the text label by 
setting the cursor over the text label and clicking the right mouse button.    This will call up 
the Object Properties dialog which shows you the details of the text label object, and has 



an Edit button.    Pressing the Edit button will allow you to go back and change the text 
label and its associated properties.



Setting Object Properties
To set the drawing properties of general purpose objects, you use
the Set Object Properties command found on the Object menu.    

You can also invoke the Set Object Properties command by double-clicking with the left 
mouse button on the object whose properties you want to change.    Choosing this 
command displays the following dialog:

 
The property setting controls are organized into three groups: line width, line style, and 
drawing colors.    A sample view of the current drawing line is displayed between the line 
width and style radio buttons, while a sample of the current outline and fill colors are 
shown to the right of their respective buttons.
Line Width:    these radio buttons let you select a line width of one to four pixels.    RR-
Track defaults to one pixel on startup.
Line Style:    these radio buttons let you choose between solid, dashed, dotted, and dash-
dot line styles.    Note that only the solid line style is allowed for line widths greater than 
one pixel (this is an internal Windows 3.x limitation).
Color:    these two pushbuttons, one for outline or line colors and one for fill color, let you 
set the object drawing colors.    Pushing the appropriate button calls up the Windows Color 
Chooser, where you may select the color graphically.
The Set Object Properties dialog has a dual-mode action, depending on whether an object 
is currently selected (highlighted) or not.    If no objects are selected, then the dialog 
displays the current setting of the default drawing values, and any changes apply to the 
default values.    This is how you change the settings for future objects.    If one or more 
objects are selected, then the dialog displays the current settings for that object(s), and 
changes made are applied to those objects, but not to future objects.
To change an existing object's drawing properties:
1. Select the object(s) using the cursor.
2. Pull down the Object menu and choose the Set Object Properties command.    The Set 

Object properties dialog appears.    Alternatively, you can combine steps 1 and 2 by 
double-clicking with the left mouse button on the object whose properties you want to 
change.

3. Change any or all of the properties as you need, and then push the OK button.
4. RR-Track applies the changes to the selected objects, but they are left selected 

(highlighted) in case you want to carry out some other action on them.    To view all of the
new changes (like colors), deselect the objects by clicking the mouse somewhere else.

To change the default object properties for future objects:
1. Make sure no objects are selected (highlighted), and then pull down the Object menu and

select the Set Object Properties command.    The Set Object Properties dialog appears.
2. Change any or all of the properties as you need, and then push the OK button.



3. RR-Track applies the changes to the default object properties.    These new defaults will 
be used for any future objects.

The Set Object Properties dialog does not affect the manner in which track is drawn.    
When the Set Object Properties dialog is opened with a grouped object, the starting object 
properties are the current default values.    If you press OK, the current settings in the 
dialog are applied to all of the objects in the group; this effect is not reversible except by 
ungrouping the objects and resetting them individually.    The Set Object Properties dialog 
can be used to change the appearance of stock objects such as trees and buildings by first 
adding them to the layout, and then changing their properties with this command.    



Electrical Connection Line
The electrical connection is a specialized line which is designated
in the same manner as a line object.    Electrical connections are 
always depicted in a block manner, with only horizontal and 
vertical components.

Procedure:
1. Select the Electrical connection item from the Object:Special Objects menu.    The cursor 

changes to a cross-hair indicating that you are to designate the starting endpoint of the 
line.

2. Move the cursor to the point at which you wish to begin drawing the line, notice that the 
status window is updated as you move the cursor, reflecting the position in the layout.    
Press the left mouse button and hold it down.    The cursor changes to a horizontal arrow 
and the title 'Size'.

3. While continuing to hold the left mouse button down, drag the cursor to the point where 
you wish to end the line.    The screen will display a dynamic line as you move the cursor,
while the status window will display a continuous update of the length of the line.

4. When you are satisfied with the line, release the left mouse button.    The line you have 
just designated is drawn and the cursor changes back to the Windows arrow.    At this 
point the line may be selected, moved, and rotated just as for track.

 



Water Tower Building
The water tower is a specialized building which is designated in 
the same manner as a rectangular structure.

Procedure:
1. Select the Water tower item from the Object:Buildings menu.    The cursor changes to a 

cross-hair, indicating that you are to designate the center of a circle.
2. Move the cursor to the point at which you wish to locate the water tower.    The status 

window is updated as you move the cursor, showing the current position in the layout.    
Press the left mouse button and hold it down.    The cursor changes to a horizontal arrow 
and the title 'Size'.    You have now designated the center of the circle.

3. While continuing to hold the left mouse button down, drag the cursor to where you wish 
the edge of the circle.    The screen will dynamically display the circle swept out, while 
the status window will display a continuous update of the tower's radius.

4. When you are satisfied with the tower, release the left mouse button.    This establishes 
the radius of the water tower, which is now drawn, while the cursor changes back to the 
Windows arrow.    

 



Buildings and Other Structures
There are five items in the Buildings submenu of the Object 
menu which are drawn in a rectangular manner.    

These are plain buildings (filled rectangles with a horizontal roof line), hip-roof buildings, 
water towers, railroad bridges, and turntables.    These five types of structures are shown 
below:

 Plain building. 

 Hip-roof building. 

 Water tower.

 Railroad bridge/overpass. 
All four of these are designated in the same manner as rectangles.    

 Railroad turntable.    The turntable is designated in the same 
manner as a circle.    
Procedure:
1. Select the appropriate structure (Plain building, Hip-roof building, Water tower, Railroad 

bridge, turntable) item from the Object:Buildings menu.    The cursor changes to a cross-
hair indicating that you are to designate the starting corner of the bounding rectangle.

2. Move the cursor to the point at which you wish to begin drawing the building, notice that 
the status window is updated as you move the cursor, reflecting the position in the 
layout.    Press the left mouse button and hold it down.    The cursor changes to a diagonal
arrow and the title 'Size'.

3. While continuing to hold the left mouse button down, drag the cursor to the corner where
you wish to end the rectangle.    The screen will display a dynamic box showing the 
rectangle you have swept out, while the status window will display a continuous update 
of the width and height of the rectangle.

4. When you are satisfied with the building rectangle, release the left mouse button.    The 
rectangle you have just swept out is replaced by the appropriate structure and the cursor
changes back to the Windows arrow.    At this point the building may be selected, moved, 
and rotated just as for track.

 



Rock and Stone Objects
The Boulder item in the Scenery submenu under the Object 
menu creates a quasi-hexagonal, random vertices, stylized rock, 
and adds it to the layout. 

Rock objects may be moved, cut, and copied as any other object, but may not be joined to 
a piece of track since they are not an electrically active component of the layout.    They 
may be grouped with any other object in order to create more complex entities.    The rock 
item appears approximately as:

 Stylized boulder. 
Procedure:
1. Select the Boulder item from the Object|Scenery menu.    The cursor changes to a cross-

hair, indicating that you are to designate the center of the tree's circle.
2. Move the cursor to the point at which you wish to locate the boulder.    The status 
window is updated as you move the cursor, showing the current position in the layout.    
Press the left mouse button and hold it down.    The cursor changes to a horizontal arrow 
and the title 'Size'.    You have now designated the center of the circle.
3. While continuing to hold the left mouse button down, drag the cursor to where you 
wish the approximate edge of the boulder.    The screen will dynamically display the circle 
swept out, while the status window will display a continuous update of the boulder's radius.
4. When you are satisfied with the circle, release the left mouse button.    This establishes 

the radius of the boulder, which is now drawn, while the cursor changes back to the 
Windows arrow.

 



Tree Objects
The 11 tree items in the Scenery submenu under the Object 
menu create a quasi-circular geometric object shaded 
schematically like a tree, and add it to the layout.    

Tree objects may be moved, cut, and copied like track sections, but they may not be joined 
to a piece of track since they are not electrically connected to the layout.    Trees may be 
edited like polygons; they have 24 vertices each of which can be individually manipulated 
to create specialized shrubbery if desired.    The three trees appear approximately as:

 Standard deciduous tree. 

 Standard evergreen tree. 

 Random edges-'realistic' tree.    There are also    other randomized edge trees, the 
spring tree, fall tree, and winter tree.    The spring and fall trees have colors that are 
randomized around medium green and orange-yellow respectively, while the winter tree is 
drawn with 12 bare, forked branches.    There are also two-tone spring trees and fall trees, as
well as a tri-toned spring tree.    These appear as a superimposed set of randomized trees 
like that below:

 
 or a spiney, yucca style tree:

 
There are also two-tone, randomized edge evergreen style trees and single-tone, 
randomized edge evergreen style trees.    Regardless of which tree you select to create, all 
are designated in the same manner you designate a circle:
Procedure:
1. Select the appropriate tree item from the Object:Scenery menu.    The cursor changes to

a cross-hair, indicating that you are to designate the center of the tree's circle.
2. Move the cursor to the point at which you wish to locate the tree.    The status window
is updated as you move the cursor, showing the current position in the layout.    Press the 
left mouse button and hold it down.    The cursor changes to a horizontal arrow and the title
'Size'.    You have now designated the center of the circle.
3. While continuing to hold the left mouse button down, drag the cursor to where you 
wish the edge of the tree.    The screen will dynamically display the circle swept out, while 



the status window will display a continuous update of the tree's radius.
4. When you are satisfied with the circle, release the left mouse button.    This establishes 

the radius of the tree which is now drawn, while the cursor changes back to the 
Windows arrow.



Railroad Bridge Object
The railroad bridge item in the Object menu creates a 
rectangular geometric object shaded as a railroad overpass and 
adds it to the layout.    

 Like other objects, bridges may be moved, cut, copied, and rotated like track sections, but 
they may not be joined to a piece of track since they are not electrically connected to the 
layout.    
Procedure:
1. Select the Railroad Bridge item from the Object:Buildings menu.    The cursor changes to

a cross-hair indicating that you are to designate the starting corner of the bridge 
rectangle.

2. Move the cursor to the point at which you wish to begin drawing the bridge,    notice 
that the status window is updated as you move the cursor, reflecting the position in the 
layout.    Press the left mouse button and hold it down.    The cursor changes to a 
diagonal arrow and the title 'Size'.

3. While continuing to hold the left mouse button down, drag the cursor to the corner 
where you wish to end the bridge.    The screen will display a dynamic box showing the 
rectangle you have swept out, while the status window will display a continuous update of 
the width and height of the bridge.
4. When you are satisfied with the building, release the left mouse button.    The 
rectangle you have just swept out is drawn as a railroad bridge, and the cursor changes 
back to the Windows arrow.    At this point the bridge may be selected, moved, and rotated 
just as for track.



Line Object
The line item in the Object menu creates a linear geometric 
object and adds it to the layout.

 Line. 
Linear objects may be moved, cut, copied, and rotated like track sections, but they may not 
be joined to a piece of track since they are not electrically connected to the layout.    A line's 
drawing color and style may be edited ( see setting object properties ).
Procedure:
1. Select the Line item from the Object:Basic Shapes menu.    The cursor changes to a 

cross-hair indicating that you are to designate the starting endpoint of the line.
2. Move the cursor to the point at which you wish to begin drawing the line, notice that the

status window is updated as you move the cursor, reflecting the position in the layout.   
Press the left mouse button and hold it down.    The cursor changes to a horizontal arrow
and the title 'Size'.

3. While continuing to hold the left mouse button down, drag the cursor to the point 
where you wish to end the line.    The screen will display a dynamic line as you move the 
cursor, while the status window will display a continuous update of the length of the line.
4. When you are satisfied with the line, release the left mouse button.    The line you 
have just designated is drawn and the cursor changes back to the Windows arrow.    At this 
point the line may be selected, moved, and rotated just as for track.



Circle Object
The circle and filled circle items in the Object menu creates a 
circular geometric object and adds it to the layout.

    Circle. 
Circular objects may be moved, cut, and copied like track sections, but they may not be 
joined to a piece of track since they are not electrically connected to the track in the layout.
You may edit the outline drawing color and style of circles, and both the outline drawing 
color/style and the fill color for filled circles ( see setting object properties ).
Procedure:
1. Select the Circle item from the Object:Basic Shapes menu.    The cursor changes to a 

cross-hair, indicating that you are to designate the center of the circle.
2. Move the cursor to the point at which you wish to locate the circle.    The status 
window is updated as you move the cursor, showing the current position in the layout.    
Press the left mouse button and hold it down.    The cursor changes to a horizontal arrow 
and the title 'Size'.    You have now designated the center of the circle.
3. While continuing to hold the left mouse button down, drag the cursor to the point 
where you wish to place the edge of the circle.    The screen will dynamically display the 
circle swept out, while the status window will display a continuous update of the circle's 
radius.
4. When you are satisfied with the circle, release the left mouse button.    This 
establishes the radius of the newly drawn circle.    The cursor changes back to the Windows 
arrow.    



Polyline Object
Polyline objects are similar to unfilled polygon objects, but no 
attempt is made to close the endpoints of the figure.    

You set the drawing color of polyline objects using the Set Object Properties command 
found under the Object menu.    Polylines, like other objects, are created using the current 
drawing color.    The current drawing color may also be set using the Set Object Properties 
command.
Once created, polylines may be moved, rotated, and grouped just as any other general 
purpose object.
Procedure:
1. Select the polyline object command found under the Objects:Basic Shapes menu.
2. The cursor changes to a bullseye cross, indicating that you are to designate the first 

point by moving the cross to where you wish the point and clicking the leftmouse button.
3. The cursor changes to an arrow with a small hexagon and the word 'Point' indicating you 

should designate the next point.    Do this by moving the arrow to the desired spot and 
clicking the leftmouse button.    Repeat this step for as many points as you need, up to 
50.

4. When you reach the last point, double-click rather than single click the leftmouse button. 
This tells RR-Track that you have finished designating the polyline points.    As soon as 
you double-click the leftmouse button, RR-Track draws the new polyline in the current 
drawing color, and returns the cursor to the Windows arrow.

see also:
polygons 
 



Polygon Object
Polygon objects are used to represent features and structures 
that aren't easily described using the simpler geometric forms, 
such as large shrubs and water features.    Both filled and unfilled 
polygon objects are allowed.    

You set the outline and fill colors of polygons using the Set Object Properties command 
found under the Object menu.    Polygons, like other shapes, are created using the current 
drawing and filling colors.    These colors may also be set using the Set Object Properties 
dialog.
Once created, polygon objects can be moved, rotated,    and grouped just as for any other 
general purpose object.
Embankments are a special type of filled polygon that is drawn with a diagonal hatched 
pattern and not outlined.    Since they are filled polygons, embankments are designated in 
the same manner as polygons.
Ponds are also a special type of polygon object that are drawn with a dark blue border and
filled with a light blue brush.    Since they are filled polygons, ponds are designated in the 
same manner as polygons.
Procedure:
1. Select the appropriate polygon object command found under the Objects:Basic Shapes 

menu.
2. The cursor changes to a bullseye cross, indicating that you are to designate the first 

vertex by moving the cross to where you wish the vertex and clicking the leftmouse 
button.

3. The cursor changes to an arrow with a small hexagon and the word 'Point' indicating you 
should designate the next vertex.    Do this by moving the arrow to the desired spot and 
clicking the leftmouse button.    Repeat this step for as many vertices as you need.

4. When you reach the last vertex, double-click rather than single click the leftmouse 
button.    This tells RR-Track that you have finished designating the polygon vertices.    You
do not have to 'close' the polygon; RR-Track does this automatically.    As soon as you 
double-click the leftmouse button, RR-Track draws the new polygon in the current colors, 
and returns the cursor to the Windows arrow.

see also:
polyline object 



Mountain object
Mountain objects, like ponds, are specialized polygons, and are 
designated as you would a polygon.

RR-Track offers three-contour level and four-contour level mountains.    The base fill color for
a mountain is a random color near brown, but you can change the base color at any time 
by choosing the Set Object Properties command and changing the fill color.
When RR-Track draws the successive contours of a mountain, it chooses a center and then 
scales the edges of the polygon from there, choosing successively lighter versions of the 
base color as layers are added.    Ordinarily, the center is the geometric center of the 
polygon.    You can change this center point to the origin point (the edit point with square 
box around it, see editing objects for more information) by right-clicking on the mountain 
(after you create it), and checking the Use Origin box in the Object Properties dialog.    This 
is useful for creating partial mountains that sit in the corner of a layout (just make the 
origin, i.e. the first point, the corner).    
Once created, mountain objects can be moved, rotated,    and grouped just as for any other
general purpose object.
Procedure:
1. Pull down the Object menu and choose Scenery | 3-Level Mountain or Scenery | 4-Level 

Mountain as needed.
2. The cursor changes to a bullseye cross, indicating that you are to designate the first 

vertex by moving the cross to where you wish the vertex and clicking the leftmouse 
button.

3. The cursor changes to an arrow with a small hexagon and the word 'Point' indicating you 
should designate the next vertex.    Do this by moving the arrow to the desired spot and 
clicking the leftmouse button.    Repeat this step for as many vertices as you need.

4. When you reach the last vertex, double-click rather than single click the leftmouse 
button.    This tells RR-Track that you have finished designating the polygon vertices.    You
do not have to 'close' the polygon; RR-Track does this automatically.    As soon as you 
double-click the leftmouse button, RR-Track draws the new polygon in the current colors, 
and returns the cursor to the Windows arrow.

see also:
polygon object 



Rectangle Object
The rectangle , filled rectangle, and X-rectangle items in the 
Object menu create a rectangular geometric object and add it to 
the layout.

 Rectangle. 
Rectangular objects may be moved, cut, copied, and rotated like track sections, but they 
may not be joined to a piece of track since they are not electrically connected to the layout.
The outline color and style for rectangles, as well as the fill color for filled rectangles, may 
be edited (see setting object properties ).      
Procedure:
1. Select the Rectangle item from the Object menu.    The cursor changes to a cross-hair 

indicating that you are to designate the starting corner of the rectangle.
2. Move the cursor to the point at which you wish to begin drawing the rectangle, notice 

that the status window is updated as you move the cursor, reflecting the position in the 
layout.    Press the left mouse button and hold it down.    The cursor changes to a 
diagonal arrow and the title 'Size'.

3. While continuing to hold the left mouse button down, drag the cursor to the corner 
where you wish to end the rectangle.    The screen will display a dynamic box showing the 
rectangle you have swept out, while the status window will display a continuous update of 
the width and height of the rectangle.
4. When you are satisfied with the rectangle, release the left mouse button.    The 
rectangle you have just swept out is drawn and the cursor changes back to the Windows 
arrow.    At this point the rectangle may be selected, moved, and rotated just as for track.



Setting the Track Junction Error
One of the difficulties with comparing layouts designed with the 
aid of a PC and those that are actually on a layout is that the PC 
assumes perfect track joining (it always joins them with no gap 
error and no angular error) while the reality of the typical layout 
is that track joining mechanisms don't always fit exactly.      These
junction errors lead to mismatches between what is on the PC 
and what is on the layout.    

To simulate joining errors, RR-Track lets you set the average junction error at each joint by 
using the Set joining error command found under the Options menu.    When you choose 
this command RR-Track displays the Set Joining Error dialog shown at left:

    To set a non-zero (or a zero) joining error, choose one of the radio buttons on the left.    
You can set average joining errors of up to 0.2 inches or 5mm.      Then choose OK to change
to the new junction error, or Cancel if you want to forget about it.    Every track junction 
created after you set the joining error will be gapped by this amount, effectively 
lengthening the track by the joining error.    The default joining error is, of course, zero.      
You can change the joining error at any time, but the new error value will not affect track 
junctions that are already in place.



Snapping Items to the Coordinate Grid
You use Snap To Grid command, found under the Options menu, 
to toggle object placing and sizing are between arbitrary 
positions, if turned off, and positions fixed by the Set Snap Size 
command.    

When object snapping is enabled, only those positions lying on integral numbers of the 
snap size may be used for track/object placing and sizing.    Every other point on the snap 
grid is shown, if you are at sufficient magnification (RR-Track will not display snap points 
closer than 12 pixels on your screen).    Alternatively, when object snapping is disabled, any
point and size may be used, and the snap grid will not be displayed.    
The purpose of snapping track/objects is to make it easier to create objects of a given, 
predetermined size, and to place track/objects with respect to one another.    For example, 
if you wish to create a railroad bridge with a width of 5 inches and a length of 30 inches, 
this will be considerably simplified if object snapping is turned on, and you set the snap 
size to 1.0 inch.    In this manner, no dimensions with fractional inches are allowed.    If you 
are designating benchwork, you may wish to set the snap size to 6.0 inches.
When snapping track to the coordinate grid, the point chosen for snapping is the origin of 
the lead selection (the one in bold highlight).    If you wish to change the snap point for a 
collection of track, make sure the lead selection is the track section that you want to snap 
to the coordinate grid.    It is usually a good idea to make the lead selection a straight 
section of track when snapping track to the coordinate grid;    using curved sections can 
produce undesirable results if you are not careful. 

 Hint:    you can also toggle object snapping by clicking the snap size button on the 
multifunction status bar. 
see also:
setting the snap size      



Setting the Size of the Snap Grid
You set the resolution of the grid used for placing and sizing 
objects using the Set Snap Size dialog, which is invoked by 
choosing the Set Snap Size command on the Options menu.      
You may also choose the Set Snap Size command from the 
shorthand menu brought up by clicking the right mouse button 
over an empty area of the layout. 

 Here you are presented with choices ranging from 0.05 inch to 6.0 inches for the snap 
resolution, or 0.1 to 10cm if you are using metric units (see setting global options).    When 
you enable object snapping by checking the Snap Objects to Grid command found in the 
Options menu, any general purpose objects created will have their sizes and positions 
governed by the snap size.    For example, if you set the snap size to 1.0 inch, and turn on 
object snapping, you can only created a hip-roof building with a horizontal and vertical size 
in integral units of inches ( say 5.0 x 7.0).    The origin of this building, the upper left-hand 
corner, must also be in whole inches.    After you create the building, you can turn off 
snapping, or change the resolution, and move the building to a different spot under the 
new snap conditions.

 Hint:    you can also change the snap size, as well as turn object snapping on and off, by 
clicking on the uparrow symbol on the snap size button on the multifunction status bar, and
then choosing from the pop up list.
see also:
snap objects to grid     



Setting the Drawing Size
The Drawing Size command is used to set the lateral (width) and 
vertical (depth) extents of the drawing.    These extents represent
the area that you may lay track in; the area outside this (when 
visible) is painted in gray.    At any time, you may resize the 
layout you are working on by selecting this command.

When you select the Drawing Size command, the RR-Track displays the following dialog 
box:

 There are four sets of numerical windows which you use to set the drawing size, one 
window for feet and one for inches for both the width and depth settings (these are meters 
and cm, respectively, if you are using metric units, see setting global options ).    Spin 
buttons are used to set the dimensions for all four values, with the up-button increasing 
values and the down-button decreasing values.    The OK button tells RR-Track to take the 
new width and depth values and resize the layout, while the Cancel button leaves the 
layout at its current size.
You may resize the layout at any time simply by selecting the Drawing Size command.    
Use the spin buttons to set the new values and press OK.    The layout will be rescaled and 
redrawn on the screen.    Remember that the lower left hand corner is consider 0.0, 0.0 by 
RR-Track; any changes in the layout size affect the placement of the right and top margins.



Allow Joined Track Breakaways
When a track section is physically joined to neighboring track sections, it is usually not in 
your best interests to allow the joined pieces independent motion or rotation.    However, it 
is also convenient to move chunks of track away from the rest of the layout when making 
alterations.    Checking this item will lift this restriction, both for moving track and rotating 
track.    If you allow track breakaways, then you can select sections of track that are joined 
to other sections, and move them away with RR-Track automatically breaking the 
connections at the ends.    So that you don't accidentally move sections a small amount, 
RR-Track makes sure you have moved the selected track sections at least 2, 5, or 10 per 
cent of the current screen size before severing the connections (the exact amount depends
on the setting of the breakaway distance in the Global Options dialog).    If you do not move
at least this far, RR-Track will not let you move the track. The default state is to prohibit the 
independent motion of joined track.
see also:
moving track, rotating track 



Select Track on a Grade
This item controls the selection of track joined to the track 
section under the cursor.    

If this item is enabled, indicated by a check mark, then all track sections on the same 
grade or at the same elevation as the section under the cursor will be selected and 
highlighted when you make an extended selection.    The lead selection will be the track 
section under the cursor. 

 Hint:    you can also toggle the extended selecting mode from physically joined to 
elecrically joined, to joined on grades by clicking the extended selection button on the 
multifunction status bar. 
see also:
selections include joints, selections include blocks,selecting track  



Select Electrically Joined Track
This item controls the selection of track joined to the track 
section under the cursor.    

If this item is enabled, indicated by a check mark, then all track sections electrically joined 
to the section under the cursor, and the track joined to them, i.e. all electrically 
continuously joined track, will be selected and highlighted when you make an extended 
selection.    The lead selection will be the track section under the cursor.

 Hint:    you can also toggle the extended selecting mode from physically joined to 
elecrically joined, to joined on grades by clicking the extended selection button on the 
multifunction status bar.    
see also:
selections include joints, selecting track 



Select Joined Track
This item controls the selection of track joined to the track 
section under the cursor.    

If this item is enabled, indicated by a check mark, then all track sections joined to the 
section under the cursor, and the track joined to them, i.e. all continuously joined track, will
be selected and highlighted when you make an extended selection .    The lead selection 
will be the track section under the cursor.

 Hint:    you can also toggle the extended selecting mode from physically joined to 
elecricallt joined, to joined on grades by clicking the extended selection button on the 
multifunction status bar.      
see also:
selecting track 



Manual Track Joining
There are a few rare instances when automatic track joining is 
insufficient to achieve the desired track configuration.    In these 
cases, you must fall back to manual track joining, which is similar
to what you do with your hands when you join two pieces of 
sectional track (there is no analog for automatic joining).    

The simplest method relies on the join to nearest track command which may be found both
on the Action menu and the shorthand menu called up by the right mouse button.    For this
to be successful, you should disable Automatic Track Joining.    
Procedure:
1. Highlight the track section you wish to join by selecting it with the mouse.    
2. Place it close (or at least closer than any other un-joined track site) to the track section 

to which you wish it joined (see moving track).    If automatic track joining is turned on, 
don't place it within a track width or it will be joined.    

3. Select Join To Nearest from either the Action or shorthand menu.    The track will be 
joined, unless RR-Track can find no unoccupied, free, joining sites that are not already 
connected to the track section(s) you have decided to join.    In this case you will be 
informed of the error, and no joining occurs.

see also:
automatic joining 



Automatic Track Joining
RR-Track can join track either automatically, or manually. If 
automatic joining is enabled, the cursor will change to an arrow 
with the term 'autojoin' when a new track section is selected 
from the track menu.    Automatic joining occurs both when 
adding new track sections and moving existing sections around 
the layout

When joining track automatically,    RR-Track scans the track list for the closest available 
joining point (unoccupied track end) to the joining points (track ends) on the new piece.    
As the left mouse button is released, the tracks are joined.    The best way to get the joint 
configuration that you desire is to move the new track section close to the point you wish 
to join it, and RR-Track will proceed from there.    
When you are adding a new piece of track to the layout, the track ends that RR-Track will 
join can be a further distance apart than when moving existing track sections.    The 
capture distance for joining when adding new track is 18.0 inches for Standard Gauge and 
G-gauge, 12.0 inches for O- and S-gauge, 6.0 inches for HO-gauge, and 4.0 inches for N-
gauge.    When you are moving existing track sections, then you must place the ends you 
wish to join within a track width, i.e. 1.77 inches for G-gauge track like LGB, 1.25 inches for 
O-gauge track such as Lionel, and 0.625 inches for HO-gauge track like Atlas.    
If automatic track joining is enabled, and you do not wish    a new track section joined to 
the existing track layout (for instance, starting a branch line, a second level, or an 
independent loop), simply press the Escape key on the keyboard before you place the new 
track section.    The cursor will change to an arrow with the term 'move' indicating that 
automatic joining is not enabled.    As soon as the new track is placed, automatic joining will
be re-enabled.    Alternatively, you can just place the new track section beyond the capture 
radius for that track family.
see also:
manual track joining 



Confirm Track Joining
You may select whether you wish to be consulted at every track 
joining operation.    

If you have chosen to confirm all track joining, RR-Track will highlight the two track sections
it is about to join, and draw a line showing which ends will be used.    If you wish to proceed,
press the OK button; if you do not accede to the proposed joining, then press Cancel and 
the joining will be aborted.    Confirmation of joining may become intrusive at times, 
especially when you are in autojoin mode, rapidly selecting and placing track sections.    
Typically joint confirmation is turned off, and only enabled when in critical sections.
see also:
automatic track joining 



Display Fine Grid
The fine-scale grid is an additional coordinate grid which may be include within the main 
coordinate grid.    Here points or crosses, as specified in the global options dialog, are 
drawn on six inch boundaries to aid in locating and positioning track an other objects.



Proximity Track Joining
RR-Track has several different settings which affect how track 
ends are joined when you either add new track, or move existing 
track around.    Two that are very similar are automatic loop 
closing and proximity joining.

Proximity joining is just what the term implies:    track junctions are joined only because 
they are compatible, free, and close to each other.    RR-Track does not move track when it 
proximity joins them, just the track junctions are marked as joined.    The difference 
between automatic loop closing and proximity joining is that RR-Track makes no attempt to 
ascertain whether the track sections belong to the same physical loop, i.e. that you can get
from one to the other by traversing intermediate track sections.    The joining criteria are 
simply that the track junctions be compatible, free, and within 1/4 track gauge width (i.e. 
0.31 inches for O-gauge) with a maximum misalignment of 2.5°.    
Proximity joining comes into play when you swap out track sections where there is no 
contiguous loop, for example a spur track off a turnout.    If you were to remove a straight 
section and replace it with an uncoupling section, with only automatic loop closing turned 
on RR-Track will join one end leaving the other end unjoined since it cannot find a 
contiguous loop.    With proximity joining enabled, RR-Track will join both ends.
RR-Track distinguishes between these joining methods since there are times when you do 
not want proximity joining enabled, such as track substitutions in a congested area.



Automatic Loop Closing
You may close track loops either by selecting the loop and    
invoking the Close Contiguous Loop command from the Action 
menu, or by checking the Auto Close Loops option in the Global 
Options dialog.    

When you select the Auto Close Loops option in the Global Options dialog, RR-Track scans 
each new track section and all of the sections joined to it for free ends that appear eligible 
for joining.    Eligibility is determined by the distance apart and the angular mismatch.    If 
free ends are found that meet these criteria, the track sections surrounding the closure 
point are highlighted and you are asked to confirm the track joining.    If you choose YES, 
the loop ends are closed, while NO leaves them as they are.    When dropping in track such 
as turnouts or crosses, where the number of ends may be three or more, then you will be 
asked for more than one set of loop closing confirmations;    RR-Track will attempt to close 
as many loops as there are free track ends.
A similar feature to automatic loop closing is proximity joining.    Proximity joining is 
distinguished from automatic loop closing in that no attempt is made to determine if the 
track ends belong to a contiguous loop.
see also:
closing contiguous loops 



Layout Information
You can find out statistical information about a layout by pulling 
down the Control Menu for that layout and choosing Info...    

RR-Track then displays the Layout Information dialog, as shown at left.

 The Layout information dialog displays the size of the layout, the total number of track 
sections of all types, the total number of accessories of all types, and the total number of 
general purpose objects of all types.    The track sections are further broken down into 
quantities of straight track, curved track, turnouts/switches, and other track (crosses, 
uncoupling tracks, power tracks, etc.).    When you are finished studying the layout 
information, press the OK button.



Layout Options
RR-Track distinguishes between settings that are applied to all 
layouts and settings that apply only to the current or active 
layout. The settings which are configurable on a layout to layout 
basis are generally those that govern the appearance of the 
layout in the layout window in distinction to those which govern 
track laying.

  When you choose either the Options... command from the Control menu, or the Layout 
Options button on the Global Options dialog, you will see a dialog like that at left.
Coordinate overlay: 

Spacing
This control group sets the coordinate grid size.
6" grid sets the coordinate grid to 6 inch spacing.
12" grid sets the coordinate grid to 12 inch spacing.
24" grid sets the coordinate grid to a 24 inch spacing.
48" grid sets the coordinate grid to a 48 inch spacing.    Useful for large garden 
layouts.
no gridlines turns off the coordinate grid.

The 6", 12", 24", 48", and none grid size commands under the Options menu also set 
the size of the coordinate grid displayed on the layout for view purposes only.    The 
coordinate grid drawn when the layout view is printed is identical to that displayed on 
the screen; this is a change from release 2.3.    In order to specify a 6", 12", or 24" 
coordinate grid, select the appropriate item with the mouse.    A check mark will be 
displayed alongside the current grid size.    If you wish to dispense with the coordinate 
grid (which you may want from time to time), select the None item.    Note that setting 



the Units to metric will change these coordinate grid options to 10, 25, 50cm, and 1m 
respectively.
Fine symbols

This control group sets the symbol used for the fine grid, which is drawn every 6 
inches, and may be toggled on or off with the display fine grid selection.
crosses uses small crosses as symbols
points uses single points as symbols
display fine 6" grid toggles the display of the fine-scale, 6 inch grid.    The fine-scale 
grid is an additional coordinate grid which may be include with main coordinate grid.  
Here points or crosses, as specified in the dialog, are drawn on six inch boundaries to 
aid in locating and positioning track an other objects.

Units
You can set the measuring units to either English (using feet and inches) or metric 
(using meters and centimeters) with these radio buttons.    If you select metric units, 
useful for European track systems, then all distances will be displayed in meters and 
centimeters.

Display items and symbols group:
Detailed track render toggles the track rendering between simple and detailed.    Track may
be rendered, both on the screen and the printer, at two levels of detail.    When this option 
is selected track will be drawn at full detail.    This implied three-rail track drawn with three 
rails, two-rail with two rails, ground throws or control boxes drawn for turnouts, guide rails, 
etc.    All track types are drawn at their actual size between the rails.    To this end, O-gauge 
track will be 1.25" wide, G-gauge 1.77"(45mm) wide, and standard gauge 2.125"(54mm) 
wide.    At this time, ties are not drawn.    This detail, of course, requires additional time, 
slowing the display speed.    From time to time, especially on slower PC's, you may wish to 
turn off detailed rendering.    This reduces all track sections to single lines, greatly 
increasing drawing speed at the expense of detail.    Bear in mind that even accelerated 
Windows video cards, while they are fast at rendering straight lines, are slow at rendering 
curves.    The longer the curves, the slower the rendering.    This option may also be set 
using the Detailed Track Render item on the Options menu.
Underneath the Detailed track render check box are two that are labeled Track and Objects.
These control whether track and objects are rendered or not.    Checking the Track box 
renders all track sections, while checking the Objects box renders all objects.    The default 
mode is rendering of both track and objects.    Sometimes it is convenient to turn one or the
other of these off for special purposes (such as only showing track items).    If both are left 
unchecked, nothing is rendered. 
label track sections toggles whether track and accessories have abbreviated labels drawn 
centered on them.    The font used for the track labels is controlled under the Fonts menu.
block breaks toggles whether electrical block breaks are displayed.    When they are visible,
block breaks are marked by a double circle.
solid joining symbols toggles whether the joining symbols between tracks are solid, filled 
circles or outline circles.
grade symbols toggles whether track on a grade is rendered with an arrowhead which 
points toward the uphill direction of the grade.    This useful to visually mark grades.
grade heights toggles whether elevated and grade track heights are displayed.    When 
checked the heights are shown using the same font as that used for track labels.    The 
heights for track on grades is given at the junction furthest removed from the elevated 
track sections.    These will be the heights track supports at these junctions.



Miscellaneous
The miscellaneous settings are the Snap To Grid and Snap Size, and the layout background 
color.    Checking the Snap To Grid box is the same as choosing Snap To Grid from the 
Options menu.    When set, all items are moved about on an underlying grid whose spacing 
is determined by the current snap size.    The current snap size can be set by pushing the 
Snap Size button.
A layout may have an individual background color which you can set by pressing the 
Background color button.      Pressing this calls up the Windows Color Chooser which you 
use to select a background color for your layout.
Set as default:    pressing this button sets the default layout options for any new or newly 
opened layouts to what you have set in the dialog.    Use this to customize the way you 
want RR-Track    to display layouts by default.
Apply: pressing this button applies the layout options without dismissing the dialog. You 
can then make further changes and reapply them.
Ok:    pressing this button applies the layout options and dismisses the dialog, returning you
to track laying.



Automatic layout backups 
RR-Track can automatically create a backup of your layouts.    
Backups are created every N    'change events'.      

You can tell RR-Track to create automatic backups of your layout files while you work.    RR-
Track creates a backup after a fixed number of 'change events' occur.    You can set the 
number of change events between backups to 25, 100, and 500.    25 is for the truly 
paranoid, 100 is reasonably frequent, and 500 is for either trusting souls, or those that do 
their own saving of layout files. 
Change events occur whenever you add items, delete items, edit items, move items, rotate
items, change item attributes, etc.    Multiple change events can occur, for example, when 
you add track.    Adding a track section causes a change event for adding an item to the 
display list, a change event for moving it around on the layout, and a change event when 
you join it to existing track for a total of three change events.      If you were strictly adding 
and automatically joining track sections, and had the number of change events set to 25, 
then RR-Track would automatically backup up your layout after the 9th track section.
To set automatic backups:
1. Pull down the Options menu and choose Options...    RR-Track displays the Global Options 

dialog.
2. Go to the Automatic Layout Backups group and check the box save layout every.
3. Immediately below the save layout every box is a set of three radio buttons; 25, 100, and

500.    Choose one of these to set the number of change events between backups.
4. Press the OK button.    RR-Track enables automatic backups on the event schedule you 

specified.    
RR-Track will create at backup file with the same name as the layout file, but    with a file 
type of .RRB.    Like layout files, whose type is .RRT, backup files are registered with 
Windows 95 and Windows NT as belonging to RR-Track.    If RR-Track terminates 
prematurely, you most recent work will reside in the layout    backup file.    If you close the 
layout normally, RR-Track deletes the backup file.
To end automatic backups:
1. Pull down the Options menu and choose Options...    RR-Track displays the Global Options 

dialog.
2. Go to the Automatic Layout Backups group and clear the save layout every box.
3. Press the OK button.    RR-Track disables automatic backups. 

 
 Note:    RR-Track will also backup any layouts you are working on that have no file name 
(these are untitled).    A backup layout with the name untitled.rrb is created for each of 
these in the current folder.    If you are working on more than one untitled layout, then the 
backup of one will overwrite the other.    For this reason it is a good idea to manually save 
the layout you are working on so that you can give it a name and avoid this conflict.



 Global Options
Selection of the global options item invokes a dialog box, like that
below, which controls the selection and deselection of features 
related to the display and response of RR-Track.    Global options 
consist of those items whose settings are applied to all layout 
windows.      

 This is in contrast to local options (which you can get to either through the Global Options 
dialog or the Control Menu on the layout window) which affect only that layout.    You 
access the Global Options dialog by choosing the Options... command from the Options 
menu.
The controls are grouped into sections which contain related features.
Track laying options:
allow track breakaways controls whether a single, joined track section may be moved 
without moving all track joined to it.    When a track section is physically joined to 
neighboring track sections, it is usually not in your best interests to allow the joined pieces 
independent motion.    However, it is also convenient to not have to manually break track 
junctions in order to move some track out of part of the layout (usually because you want 
to make some minor rearrangement).        Checking this item will lift this restriction.    The 
default state is to prohibit the independent motion of joined track.    If you do enable this 
option, you can break track away by selecting it and moving it at least 10 per cent of the 
current screen size.    If you do this, RR-Track severs the junctions between the track ends 
and the rest of the layout automatically.    If you don't move the track 10 per cent of the 
screen size, then RR-Track will not permit the track to be moved.
auto-join track toggles the joining mode for newly added track between automatic and 
manual.    RR-Track can join track either automatically, or manually. If automatic joining is 



enabled, the cursor will change to an arrow with the term 'autojoin' when a new track 
section is selected from the Track menu.    
When joining track automatically, which occurs only when placing new track sections, RR-
Track scans the track list for the closest available joining point (unoccupied track end) to 
the joining points (track ends) on the new piece.    As the left mouse button is released, the 
tracks are joined.    The best way to get the joint configuration that you desire is to move 
the new track section close to the point you wish to join it, and RR-Track will proceed from 
there.    
If automatic track joining is enabled, and you do not wish    a new track section joined to the
existing track layout (for instance, starting a branch line, a second level, or an independent 
loop), simply press the Escape key on the keyboard before you place the new track section. 
The cursor will change to an arrow with the term 'move' indicating that automatic joining is 
not enabled.    As soon as the new track is placed, automatic joining will be re-enabled.
auto-close loops:    toggles automatic loop detection and closing.    When turned on, RR-
Track checks for loops whose free ends meeting the criteria for closing ( less than a track 
width apart and aligned within 2.5° and physically contiguous) as each new track section is 
added to the layout.    If RR-Track finds a pair of free ends that meet these criteria, they are 
highlighted and you are asked to confirm the closing of this loop.
proximity joining:    toggles    track proximity joining.    When turned on,    RR-Track checks all 
of the ends non-joined ends of a piece or pieces of track when they are moved.    If it finds 
unconnected track junctions that are in close proximity with other track junctions (the 
proximity joining criteria are 1/4 track width spacing and 2.5° misalignment) they are 
automatically joined. Proximity joining is distinct from automatic loop closing in that the 
free track ends do not have to be physically connected through a loop (for instance, they 
could be the other pieces in a siding).
confirm all track joining toggles user confirmation for all track joining on or off.    You may 
select whether you wish to be consulted at every track joining operation.    If you have 
chosen to confirm all track joining, RR-Track will highlight the two track sections it is about 
to join, and draw a line showing which ends will be used.    If you wish to proceed, press the 
OK button; if you do not accede to the proposed joining, then press Cancel and the joining 
will be aborted.    Confirmation of joining may become intrusive at times, especially when 
you are in autojoin mode,rapidly selecting and placing track sections.    Typically joint 
confirmation is turned off, and only enabled when in critical sections.
confirm all deletes toggles user confirmation for all track and objects deletions.    If left off, 
RR-Track will not ask for confirmation when you delete track or objects, unless you are 
deleting more than 25 items, in which case confirmation is always required.
Layout appearance:
The controls in the Layout Appearance group let you choose the standard background color
used by layout windows, and choose whether RR-Track uses scroll bars for panning and 
scrolling or uses the mouse cursor for panning and scrolling.

Background color:    This set of radio buttons allow you to pick the background color 
that RR-Track uses when displaying the track layout.    The choices are the system color, 
which you may set using the Windows Control Panel, white, and an off-white color.    All 
are standard system colors which are available in any Windows display mode from 4-bit, 
16 color VGA through 16.7million color, 24-bit true color.    If you find that white and off-
white are too boring, then set some psychedelic color of your own using the Windows 
Control Panel and selection the system color.    Bear in mind that it is of fundamental 
importance for the background color to allow the foreground colors, i.e. those of the 
track and objects, to be easily discernible.    This background color is the default color 
that is used if no specific background color is chosen for the layout.    You can override 
this by setting the layout background color in the Local Options dialog.
Show Scroll Bars:    There is a check box which lets you decide whether you want RR-



Track to display vertical and horizontal scroll bars on each layout window (for moving 
around your layout when at zoom settings other than 1), or to save screen space and not
show scroll bars, but use the mouse cursor to move around the layout.    If this box is 
checked (the default), then RR-Track displays the standard Windows scroll bars.    If this 
box is not checked, then RR-Track removes the scroll bars from the layout window, and 
instead uses the mouse cursor for panning and scrolling.      When the cursor nears the 
edge of the layout window (within 10 pixels), the cursor will change to an arrow than 
indicates the direction of panning.    To pan in this direction, click the left mouse button 
once.    Each click of the mouse button is equivalent to clicking the scroll bar arrow 
buttons, i.e. panning is 1/10 of the screen width in that direction.    

When you change the setting of the Show Scroll Bars check box, changes will not take 
affect until the next time you start RR-Track. 
Display type:
This set of radio buttons lets you choose whether you want the display colors associated 
with VGA color monitors, or the set of colors chosen for monochrome monitors.    The 
default setting is VGA color, which is used for desktop systems.    The monochrome setting 
is useful if you are using a laptop machine with no color display.
Move delay time
You can choose whether you want a long delay (1/2 second) or a short delay (1/6 second) 
between when you depress and hold the left mouse button down when selecting a track 
section, and when the cursor changes to the `Move" cursor, letting you move the track.    
The way you want to set this will depend on how adept you are at single-clicking, double-
clicking, and in general using the mouse cursor.
Breakaway distance:
You can set the size of the jitter for track breakaways by choosing either 2 per cent, 5 per 
cent, or 10 per cent of the screen width (previous versions of RR-Track were fixed at 10 per 
cent).    The breakaway jitter distance dictates how far a piece of track that is joined to 
other pieces of track before RR-Track decides you really want to disconnect it.
Automatic layout backup:
If you want RR-Track to automatically create a backup file of your open layouts, check this 
box.    You can then choose the number of change events between backups.    See 
automatic backup for more information.      
Layer options:
You have to option to set how RR-Track treats the former working layer when you change 
working layers.    If you check the reset to active button, the old working layer will be set as 
an active layer; conversely, if you check the reset to inactive button, RR-Track sets the 
former working layer to inactive.    See working with layers for more information on layer 
attributes.
Set Track Colors:
This command button calls up the Set Track Colors dialog, the same as if you had pulled 
down the Options menu and chosen Set Track Colors.    See Setting track colors for more 
information.
Set Joining Error:
This command button calls up the Joining Error dialog which allows you to set a gap 
between track junctions to simulate junction expansions that you create when joining the 
real track on your layout.    For more information see Setting joining error.
Layout options:
This command button calls up the Layout Options dialog which lets you configure those 



settings which are variable on a layout to layout basis.    See setting layout options for more
information.
Other settings in RR-Track, principally those which control the appearance of the layout 
windows and the appearance of the track can be configured on a layout to layout basis by 
using the local options dialog discussed in the ensuing topic.



Setting the Track Color
In order to change, or set, the drawing and fill colors for a given 
track library, you select the Set Track Color command found 
under the Options menu, or the Set Track Color button on the 
Global Options dialog.    

When you do so, you are shown a dialog like:

 This list box shows you all of the available track libraries.    Selecting one of these by 
clicking on it with the left mouse will display the highlighted library's current pen and fill 
colors.    To change the pen color, push the Pen Color button.    In a similar fashion push the 
Fill Color button the change the fill color.    Both buttons call up the standard Windows Color 
Chooser dialog.    If you want the change the color, select one of the standard colors and 
press OK, otherwise press Cancel.    
Double-clicking on one of the libraries in the list box immediately invokes the Windows 
Color Chooser for the pen color, followed by the Color Chooser for the fill color.    
To change the default track library colors, set the colors up in the fashion you wish using 
the above instructions, and then press the Set As Default button.    This writes your current 
settings to the track library's initialization file so that the next time you start RR-Track, 
these colors will be used.    It is important to note that track library colors are not saved 
with the layout files, but are instead a global property of the application.    You should 
further note that instrinsic track library colors may be overridden by colors that you set for 
the layer that contains the track.

 



 Micro Engineering Company
Micro Engineering makes a high quality line of G-gauge (45mm) two-rail track called G-
TRAKTM, compatible both with LGBâ (Code 332) and scale (Code 250).    They may be 
reached at:
Micro Engineering Company
1120 Eagle Road
Fenton, MO 63026



 Lionel (LTI) / Rydin Industries
Lionel®    produced a small line of standard gauge (54mm) three-rail track consisting of 
straight sections, two varieties of curved sections, a 90° and 45°cross, and a set of 
turnouts.
Rydin Industries produces a line of tubular, three-rail, standard gauge (54mm) trackage 
which supplements the trackage originally available from Lionel® back in the '20s and '30s
during standard gauge's heyday.    Curved track is available from St-42 to St-144, as well as
two types of turnouts, both more gradual than the stock Lionel® turnouts.    All items are 
pin compatible with Lionel sectional track, and may be mated with GarGraves three-rail 
standard gauge flexible track by using the appropriate coupling pins.



 Curtis HiRail Products, Inc./GarGraves Trackage Corp.
GarGraves Trackage, Curtis Hi-Rail Products, and Ross Custom Switches produce an 
extensive line of realistic, three-rail O-gauge (32mm) track for use with hi-rail, tinplate and 
scale, toy trains.    GarGraves specializes in flexible, three foot track sections in various 
gauges including American Flyer two-rail S, Lionel three-rail O (32mm), two-rail G (45mm), 
and three-rail standard (54mm). They also manufacture a pair of realistic turnouts and two 
types of uncoupling tracks.    All consist of steel rails with wooden ties.    Curtis Hi-Rail 
Products and Ross Custom Switches sell an extensive line of GarGraves-compatible 
trackage constructed with GarGraves steel rails and wooden ties, and specializes in 
turnouts, crosses, and pre-formed curves.    Turnouts are available from O31 to O72, curved 
turnouts, 'Y' turnouts, slip switches, and prototypical turnouts compatible with hi-rail rolling 
stock and equipment, as well as curves from O31 to O96.    
GarGraves Trackage may be reached at:

GarGraves Trackage Corp.
RD 1, Box 255A
North Rose, NY 14516

Curtis Hi-Rail Products may be reached at:
Curtis Hi-Rail Products, Inc.
POB 385
North Stonington, CT 06359

Ross Custom Switches
Ross Custom Switches
POB 110
North Stonington, CT 06359

See also:
Lionel(LTI) 



Detailed Track Render
Track may be rendered, both on the screen and the printer, at 
two levels of detail.    When this option is selected, indicated by a 
check mark, track will be drawn at full detail.    

This implied three-rail track drawn with three rails, two-rail with two rails, ground throws or 
control boxes drawn for turnouts, etc.    All track types are drawn at their actual size 
between the rails.    To this end, O-gauge track will be 1.25" wide, G-gauge 45mm wide, and
standard gauge 54mm wide.    At this time, ties are not drawn.    This detail, of course, 
requires additional time, slowing the display speed.    From time to time, especially on 
slower PC's, you may wish to turn off detailed rendering.    This reduces all track sections to 
single lines, greatly increasing drawing speed at the expense of detail.    Bear in mind that 
even accelerated Windows video cards, while they are fast at rendering straight lines, are 
slow at rendering curves.    The longer the curves, the slower the rendering.
Procedure:
1. Select the Options menu from the menu bar.
2. Highlight the Detailed Track Render item and click the left mouse button.
3. The rendering state changes, with a check mark indicating that details are to be 

rendered.    RR-Track immediately redraws the layout.
 



 Lionel® (LTI)
Lionel® / LTI is one of the oldest makers of toy trains.    Through the years, they have made 
and still make, an extensive line of rolling stock and motive power for three-rail O (32mm), 
O27, and standard (54mm) gauge, as well as a smaller line of two-rail G-gauge items.    
Lionel's tubular hi-rail track has graced many a Xmas tree in this century.    Lionel style 
tubular track consists of various straight pieces, several varieties of curves, turnouts, 90° 
and 45° crosses, as well as miscellaneous items such as bumpers and uncoupling tracks.    
Lionel O and O27 may be mated with Curtis Hi-Rail and GarGraves three-rail track by using 
the appropriate coupling pins.
See also:
GarGraves Trackage, Curtis Hi-Rail Products 



 LGB
LGB is one of the oldest makers of G-gauge (45mm) two-rail track, rolling stock, and motive
power.    Their track, consisting of brass rails and plastic ties, is both durable and pleasing to
the eye.    The track line is extensive and includes a large number of straight sections, 
curves of three radii, several varieties of turnouts, as well as assorted crosses, reversing 
sections, and bumpers.    



Make Hidden Track
Many complicated, and some not-so-complicated, layouts have 
track sections that are normally hidden from view.    These 
include track going through tunnels, under structures, under-
table marshaling and storage yards, etc.    Most of the time you 
do not want to see this track, but there are times when you must 
make it visible for design/construction purposes.    Individual 
track sections cannot be hidden in RR-Track, but layers can be 
hidden as well as grayed and other attributes (see    working with 
layers for more info).    

The way to create hidden track is to create a hidden track layer, and then move the track 
sections that are normally hidden into that layer.      Then you have the option to show the 
track normally, show it grayed out, or hide the track as needed.
Procedure:
1. Pull down the Options menu and choose Layers...    The Drawing Layers Setup dialog 

appears, showing all the layers in the layout and their current visibility.
2. Press the Add button to create the new hidden track layer.    Choose a name such as 

`Hidden track' (or something else significant to you) for the name and press OK.
3. Set the visibility of the new hidden track layer to `hidden' or `grayed' as you desire by 

choosing the appropriate radio button and then pressing Change.
4. Press OK when you have finished setting the attributes of the hidden track layer.
5. Go to your layout, and select the track sections you want to move to the hidden track 

layer.
6. Pull down the Action menu and choose Move To Layer...    The Move Selected Items To 

dialog appears, showing the available destination layers.    The layer the track is currently
has <oc>    prepended.

7. Choose the hidden track layer from the list and then press OK.    RR-Track immediately 
moves the track sections to the hidden layer and updates their screen appearance.

See also:
working with layers 



Using the Multifunction Status Bar
RR-Track has a multifunction status bar which appears at the 
bottom of the main window. The status window maintains a 
display showing the current values and state of RR-Track's most 
important settings, as well as short cuts to changing the most 
popular of these.

 To the left is a small pane that shows the current cursor position in the active layout 
window.    Next to that is a smaller pane that shows the current Zoom factor (in the 
example the zoom is 1).    Next the Zoom pane is a set of three buttons that both show, and
let you change, the current extended selection mode, the auto-join mode, and the auto-
loop close mode respectively.    You can cycle through the extended selection modes (from 
joints to electrical to grades and back to joints) by repeatedly clicking the selection mode 
button.    You can toggle auto-join between ON and OFF by clicking the auto-join button, and
you can toggle auto-loopclose between ON and OFF by clicking the auto-close button.    
Clicking these buttons is identical to choosing the respective commands from the Options 
menu.
The next button is the Snap-Size / Mode button.    It displays the current snap size, or OFF if 
snap-to-grid is toggled OFF for the active layout.    By clicking on the button, you can toggle
the snap-to-grid setting for the active layout between ON and OFF.    By clicking over the 
little up arrow symbol, you will pop up a list of the available snap settings with the current 
one highlighted.    You can choose a new snap setting from this list by clicking on it with the 
left mouse button (choosing a snap size will also turn snap-to-grid ON if it was OFF).    If you
don't want to choose a new snap setting, click somewhere outside of this list.
The next button is both informational and active, and shows the current working layer (for 
more information about drawing layers and their attributes, see working with layers ).    You 
can switch working layers by clicking on the up-arrow region.    This pops up a list of the 
current layers with the working layer highlighted.    You can choose a new working layer by 
selecting one from this list, or retain the current working layer by clicking elsewhere.    You 
can also access the Layer Setup dialog by double-clicking on the layer button.    This is a 
shortcut for pulling down the Options menu and choosing Layers. 
At the right end of the multifunction status bar is the Last Item List button.    This button 
displays the last item (track or accessory, not object) added to any of the layout windows 
(this last item list covers all of the layout windows).    You can get another of whatever you 
added last by clicking this button (this is the same as using the Last Track command under 
the track menu, or double-clicking over blank space).    You may also click on the small 
uparrow symbol to pop up a list of the 10 most recently added distinct items.    You can 
then choose one of these items.    
You may toggle between showing and hiding the status bar by selecting the Show Status 
item on the View menu.    A check mark indicates that the multifunction status bar is 
visible.



Working With Layers
Layers are a feature of RR-Track which allow you to create very 
complex layouts without necessarily having to be aware of the 
complexity at all times.    A layer is simply a grouping of track and
objects which have some common feature (such as they are all 
on the ground level, or they are all on the upper level, or they are
all on the inner loop, etc.)    

A layer has assignable attributes which govern its visibility, selectability, and color.    For 
example, a train with two levels of track can, at the very least, have two layers --- the layer
that has the lower level of track and that which has the upper level.    In this manner you 
can hide the upper level while you work on the lower level, and vice versa.    
Every layout you create automatically sets up one layer for itself which it names 
<default>.    This <default> layer can neither be renamed or removed in order to 
safeguard you against accidentally creating a layout file with no layers.    This is the 
equivalent of previous releases of RR-Track which used only one drawing layer.    When you 
create a new layout, the <default> layer is set as the working layer, i.e. the layer in which 
items are added.    Layers that you subsequently add can have any name you like, up to 48 
characters in length.    You should choose names that have significance for you.
To add a layer, modify a layer, or remove a layer from a layout, pull down the Options menu
and choose Layers...    You will see a dialog like that at left:

 The list box on the left shows the existing layers in the layout.    RR-Track prepends a 
modifier to the layer name to indicate, at a glance, its attributes (<W> working, -a- active, 
-i- inactive, -g- grayed, -h- hidden).    There are two groups of controls that are used to set 
or change layer attributes. The set of radio buttons are used to both set and indicate the 
visibility and selection attributes of the layer that is highlighted in the list box.    The 
command buttons in the Layer Colors group are used to set and clear the default layer 
drawing colors. The command buttons on the right compose the set of actions that can be 
taken on the layer attributes.
Layer Attributes:    a layer can have one of five attributes (listed in decreasing order of 
activity): working, active, inactive, grayed, and hidden.    The working layer is the layer that
items are added to when you add track, accessories, or objects to your layout; there can be
only one working layer.    You can select items in the working layer, move them, join them, 
unjoin them, rotate them, and delete them.    Obviously, the working layer is visible.    An 
active layer is the same as a working layer, except that items are not added to an active 



layer, only to the working layer.    As for the working layer, items in an active layer can be 
selected, moved, joined, unjoined, rotated, and deleted.    Any number of layers can be 
active layers; active layers are visible.    An inactive layer is visible, just as for the working 
and active layers, but items in inactive layers cannot be selected (the are invisible to the 
mouse), and hence cannot be manipulated (until you change the layer attributes).    
Inactive layers are similar to Windows wallpaper; you can seem them but you can't touch 
them.    A good use for inactive layers is for benchwork while you are working on the track.   
Grayed layers are like inactive layers but items in grayed layers are drawn using a pale 
gray pen; objects and accessories are only drawn in rough outline form.    Grayed layers are
useful when you need to see underlying items for the purpose of registration with other 
items, but you don't want to be plagued with all of the details.    Hidden layers are just that;
they are not visible at all.    Hidden layers are useful when you don't want the details of 
upper level track to bother you while you are working on the lower level.    The table below   
summarizes the properties of the different layer attributes.

Attribute Visible Selectable Additions
working Yes Yes Yes

active Yes Yes No

inactive Yes No No

grayed sort of No No

hidden No No No

Layer colors:    layers can have a default drawing and fill color which will override the 
intrinsic color for a track library (but not for the intrinsic colors used for accessories and 
objects).    In this manner you can change the default color of track by assigning the track 
to another layer, and then setting the default layer colors to that which you want for the 
track.    For instance, if you have two loops of track, one of which is the outer mainline and 
the other the inner mainline used for connection to yards, sidings, etc., you could place the
track in the outer loop in a layer (called Outer Mainline) and the inner loop in a layer (called
Inner Mainline).    If you assign the Inner Mainline layer a drawing color different from that 
normally used by the track library (set using the Set Track Color command found under the 
Options menu, see setting the track color) then the two loops of track are drawn with 
different colors.

 If you are adding a new layer, removing an existing layer, or modifying the attributes of an
existing layer, you will use the controls in the Layer Attributes section of the Layer Setup 
dialog.    The Change button is only enabled when one of the attributes radio buttons is 
clicked.
To add a layer:
To add a layer to a layout you use the Layers... command found under the Options menu. 
The Drawing Layers Setup dialog will be displayed, at which point you choose the Add 
button to create a new layer.
Procedure:
1. From the menu bar, select Options and then Layers...    from the drop-down menu. RR-



Track displays the Drawing Layers Setup dialog.
2. Press the Add button.    RR-Track shows the New Layer Name dialog.    Enter the name you

want for the new layer and press OK.    If you decide not to add a layer, press Cancel.    If 
you pressed OK, RR-Track creates a new layer with the name you chose, sets its attribute 
to inactive and adds it to the list.

You can then change the new layer's attributes to whatever you want.    When you are 
finished with the set up of the layout's layers, press the OK button on the Drawing Layers 
Setup dialog.
To remove a layer:
As for adding a new layer, you remove an existing layer using the Layers... command.
Procedure:
1. From the menu bar, select Options and then Layers... from the drop-down menu.    RR-

Track displays the Drawing Layers Setup dialog.
2. Using the mouse, choose the layer you want to remove by single-clicking it with the left 

mouse button.    
3. Press the Remove button.    If there are no items in the layer, RR-Track immediately 

removes it.    If there are items in the chosen layer, you will be advised of this and 
informed that the layer cannot be removed until those items are either deleted or moved
to another layer.

To rename a layer:
Renaming a layer is similar to both adding a layer and removing it.    As for adding and 
removing, you start with the Layers... command.
Procedure:
1. From the menu bar, select Options and then Layers... from the drop-down menu.    RR-

Track displays the Drawing Layers Setup dialog.
2. Using the mouse, choose the layer you want to rename by single-clicking it with the left 

mouse button.
3. Press the Rename button. RR-Track shows the New Layer Name dialog.    Enter the name 

you want for the new layer and press OK.    If you don't want to change the name, press 
either OK without typing in a new name, or press Cancel.    

When you are finished with the set up of the layout's layers, press the OK button on the 
Drawing Layers Setup dialog.
To change a layer's attributes:
As for the layer creation, deletion, and renaming, modifying a layer's attributes starts with 
the Layers... command.
Procedure:
1. From the menu bar, select Options and then Layers... from the drop-down menu.    RR-

Track displays the Drawing Layers Setup dialog.
2. Using the mouse, choose the layer you want to modify by single-clicking it with the left 

mouse button.    As you change the chosen layer, the Layer Attributes radio buttons 
change to reflect the current attributes of the chosen layer.

3. Go to the Layer Attributes radio buttons and select the attribute you want from the 
choice of working, active, inactive, grayed, and hidden.

4. Press the Change button.    RR-Track changes the layer attributes, and, if necessary, 
reduces the status of the former working layer to active.



Whenever a layer's attributes are changed to working, the previous working layer is 
switched toactive, meaning that you can still choose and manipulate items in that layer, 
but newly added items will go into the new working layer.    A quick way to change the 
working layer is to combine steps 2, 3, and 4 above by double-clicking rather than single-
clicking on the layer you want to make theworking layer.
To change a layers default colors:

 As mentioned in the introduction, you can also set the default drawing colors for a layer.    
If a layer has defined drawing colors, it will use them in lieu of the standard track library 
colors when rendering track.    When you modify a layers drawing colors, you use the 
command buttons in the Layer Colors group.
As usual, you start with the Layer Setup dialog.
Procedure:
1. From the menu bar, select Options and then Layers... from the drop-down menu.    RR-

Track displays the Drawing Layers Setup dialog.
2. Using the mouse, choose the layer you want to rename by single-clicking it with the left 

mouse button.
3. Press the Draw button to change the outline drawing color (this is the color used for the 

rails and outlines of switch machines, etc.), or press the Fill button to change the fill color
(this is the color used to fill in switch machines and joining symbols).    RR-Track displays 
the Windows Color Chooser. 

4. Select the color you want and then press OK.    If you don't want to change the color, 
press Cancel.    If you press OK, RR-Track takes the new color and makes it either the 
outline drawing color or the fill color as denoted above.    The layout is not redrawn until 
you press the OK button on the Layer Setup dialog.

If you want to reset the layer colors to the defaults (that is, draw the track with the 
standard track library colors), choose the layer using the above procedure, but press the 
Reset button rather than the Draw or Fill buttons.



 Elevating track
RR-Track allows you to change the elevation (height) of a section 
or sections of track while performing the calculations for the 
grades on either side automatically.      RR-Track distinguishes 
track that is not at zero height (flat on the table or ground) as 
one of two types;    elevated track or grade track.    Elevated track
are those sections, which are contiguous, that are all at the same
height.    Grade track are those sections, on one or more sides of 
an elevated track, that have both non-zero height and a non-zero
slope (i.e. the track sections one either side are at different 
elevations).    Grade track is denoted by a small arrow symbol at 
the center which points in the direction of increasing elevation.    

There are four commands, all located under the Grades menu, which change the elevation 
of track:    Change elevation, Remove elevation, Set Track Height, Create Grade, and Zero 
Track Height.    Another command, Reconcile grade recalculates the track junction heights 
of an existing grade.    In order to use most of the commands on the grade menu, except for
the Change elevation    and Zero Track Height commands, you must have the extended 
selecting mode set to Selections Include Grades.
In order to change the elevation of some track, you first select it with the mouse and then 
choose the Change elevation command found under the Grades menu.    When you do this, 
you will see the dialog shown below:

 Description: to the left is a preview window which shows a rough drawing of the track 
layout zoomed out so that the entire layout is visible.    Existing elevated track is shown in 
dark red; existing grades are shown in magenta.    The track you have chosen to elevate is 
shown in red. As you change elevations, any new grades are shown in orange if they are 
above table level, or blue if they are below table level.
Immediately below the preview window are a set of radio buttons in the Grade group that 
are used to both indicate and set the required grade.    These grades are expressed in per 
cent.    Per cent grade is an engineering term which merely indicates the ratio of the rise of 
the track to the run along the table (for example, a five per cent grade means that the 



track rises 5 inches for every 100 inches along the table).    You have fixed grade choices 
ranging from 1.0 to 10 per cent.    Keep in mind that a five per cent grade is steep;    most 
real railroads try to hold this to 1.0 or 1.5 per cent and hi-rail layouts to 2.5 per cent --- 
Lionel® trestle sets use grades between 7.5 and 10 per cent.    
To the right of the preview window is a fader control similar to that on a stereo amplifier.    
Immediately below the fader control is a panel readout which shows the change in 
elevation for the selected track.    The up/down spin buttons next to the panel readout work,
in conjunction with the fader, to let you vary the change in elevation.    The set of radio 
buttons to the right of the fader, in the Height Inc. group, are used to set the incremental 
height changes used both by the fader control and the up/down spin buttons.
The Change Track Elevation dialog is designed to let you graphically change the elevation 
of the selected track, highlighted in red, while RR-Track dynamically calculates the number 
and height of the grade track sections on either side which are required to accommodate 
this height change.    You can change the grade by selecting one of the    radio buttons in 
the Grade group and instantly have RR-Track update the preview window, showing the track
sections that will be picked up to accommodate this grade.    You can leave the grade fixed, 
and vary the height using either the fader or the spin buttons.    Similar to the interaction 
between the fader and the distance increments in the Duplicate Parallel dialog, as you 
change the height increment with the radio buttons in the Height Increment group, the 
range on the fader updates (to get a larger fader range, increase the increment).    The spin 
buttons are not bound by the fader range, and can change the height to any value in 
increments set by the radio buttons in the Height Increment group.    Note:    height 
changes made using the Change Elevation dialog are relative heights; that is they are 
relative to the current height of the track.    Height changes made using the Set Track 
Height command are absolute heights measured from the layout benchwork.
When RR-Track changes the elevation of track sections, by using the Change Elevation 
command, the Remove Elevation command, the Set Track Height command, or the Zero 
Track Heights command, the track display list is sorted to force rendering the track with the
lowest elevation first,    and that with the highest rendered last.    This automatically makes 
higher track sections appear to pass over lower ones, although you will still be required to 
set overpass characteristics for the grade track.    RR-Track automatically sets the elevated 
portion to overpass status.
To change existing track elevation
To change the elevation of track, use the following method:
Procedure:
1. Select the track section(s) you wish to elevate.
2. Pull down the Grade menu and choose Change     Elevation  .    The Change Track Elevation 

dialog appears, as shown above.
3. Using the fader and/or the spin buttons, move the selected track to the required 

elevation.    As you change the elevation of the track, RR-Track will show the grade track 
sections on the ends of the elevated track that are required to accommodate the grade 
set in the Grade group.

4. Manipulate a combination of the grade buttons, fader, and spin buttons until you reach 
both an elevation you want, and the grade that you can live with.

5. When you are satisfied with your grade design, press the OK button.    RR-Track 
immediately applies the grade changes to the layout track, updating the layout display.    
If you decide you do not like your choice of grades, press Cancel to return to the layout 
with the track elevation unchanged.    

To remove an existing track elevation

In order to remove an existing track elevation, carry out the following steps:



Procedure:
1. Pull down the Options menu and change the extended selecting mode to Selections 

Include Grades, if it is not already set so.
2. Select the elevated track (not grade track) which you wish to return to zero height.
3. Pull down the Grades menu and choose Remove Elevation.    If this command is grayed 

out, return to step one and make sure the extended selecting mode is set to include 
grades.

4. RR-Track immediately zeros the elevation of the elevated track and all grade track 
contiguous with it, reordering the display list as necessary to reflect the new heights.

Getting    details on grade and elevated track

After you have set some elevations and grades in a layout, getting some detailed 
information on the elevated track sections, and especially the grade sections, is quite 
useful.    You can access this information with the Information command under the Grades 
menu.    Doing so is straightforward: select the elevation or grade you want to examine by 
double-clicking on it with the extended selecting mode set to Selections Include Grades.    
The pull down the Grades menu and choose the Information command.    When you do so 
you will see one of two dialogs depending on whether you have selected elevated track or 
grade track:

 or  
For elevated track, you will see the total length, the number of track sections in the 
elevation, and the elevation height.    For grade track you will see the total length, the 
number of track sections, the height change (from low to high end), and the exact per cent 
grade.    Press OK to dismiss the dialog and return to your track layout.    Note that the grade 
shown in the Grade Information dialog may be somewhat less that that you requested when 
you used the Change Elevation dialog to set the elevation and grade originally.    This is 
because RR-Track creates grades by picking up integral pieces of track, and does not bend a 
track section in the middle somewhere.    RR-Track chooses the number of track sections 
necessary to create the chosen grade, but not a grade steeper than the chosen grade.

Reconciling grades

When several elevations are introduced into a track layout, it is quite common to end up 
with a non-smooth grade between adjacent track elevations (a non-smooth grade is a 
contiguous set of grade track with an unequal per cent grade, i.e. some track descends and



then changes to ascending as you traverse the grade).    You can see this if you have RR-
Track display the track junction elevations on grade ( seeGlobal Options).    You can have 
RR-Track smooth out the grade and recalculate the track junction heights by using the 
Reconcile grade command.    In order to reconcile a grade, carry out the following steps:
Procedure:
1. Pull down the Options menu and change the extended selecting mode to Selections 

Include Grades, if you have not already done so.
2. Select the grade track you want to reconcile by double-clicking on it with the left mouse 

button.
3. Pull down the Grades menu and choose Reconcile grade.    RR-Track immediately 

recalculates the track junction heights in the grade and shows you the Grade Information
dialog.

4. Press the OK button on the dialog when you are finished viewing the grade information.    
You are returned to the layout with the newly smoothed grade.

Manual Grade editing
While automatic grade calculation during creation of elevated track is simple, there are 
many situations in which you would like to gain some further measure of control over the 
grades and elevations in your layout.    The following topics cover common grade editing 
procedures that use the Set Track Height, Create Grade, and Reconcile grade commands.
Adding to and subtracting from grades:    You can use the Reconcile grade command, 
in conjunction with some of the other commands, to both add to and subtract from an 
existing grade.    Since RR-Track creates symmetric grades (i.e. the grade track on both 
sides of elevated track has the same slope), this is a way to create asymmetric grades.      
To add to an existing grade:
1. With the extended selection mode set to Selections Include Grades, select the grade you 

want to add to by double clicking on one of its track sections.    The grade will then 
highlight.

2. Select the track section(s) you want to add to the grade by adding them to the selected 
track (hold down the SHIFT key while clicking on them with the left mouse).    Any track 
you add to the grade must be contiguous with the grade (RR-Track will check for these 
and advise you if you err).

3. Pull down the Grades menu and choose Reconcile grade.    You will see a dialog which 
shows the composition of the new grade, as well as its slope.    Click the Ok button.    RR-
Track immediately updates the grade, adding the new track sections.

To subtract from an existing grade:

1. Choose the track sections you want to remove from the grade by clicking on them with 

the left mouse button. 
2. Pull down the Grades menu and choose Zero Track Height.    RR-Track immediately sets 

their height to zero, and recalculates any connecting grades to reflect changes 
precipitated by setting the selected track to zero height.

Setting the absolute track height:    You can use the Set Track Height command to set 
the absolute height of one or more track sections, accessories, or objects.    This command 
is useful for creating asymmetrical grades, or setting up intermediate elevated areas on 
existing grades ( for more complex grade systems).    When you choose the Set Track 
Height command, you will see a dialog box like that below:



 The readout control shows the height of the selected items (this will be the actual height 
of a single item, or the average height of any multiple selections).    The up/down spin 
buttons are used to change the height in the readout control.    The increment used by the 
spin buttons is determined by the radio buttons just below the readout control.    Use the 
up/down spinner to set the new height, and press Ok to have RR-Track set the new height, 
or Cancel if you decided not to change the height.    
To set the absolute track height:
(1) Select the track sections, accessories, or objects whose height you want to set.
(2) Pull down the Grades menu and choose Set Track Height.    The Set track height dialog 

appears.
(3) Use the up/down spin buttons to set the new height, and then press OK. RR-Track sets 

the selected items to the set height, and automatically recalculates any attached grades.
 

Manually setting grades:    You can use the Create Grade command to manually place a 
grade in your layout.    This command is generally used in conjunction with the Set Track 
Height command, which is used to manually set the absolute track height.    Track sections 
selected for a new grade must not include objects or accessories or existing grades 
sections.    
To create a grade:
(1) Select the track sections you want to include in the grade.    They must not include 

existing grade sections, accessories, or objects.
(2) Pull down the Grades menu and choose Create Grade.    RR-Track analyzes the selected 

track for continuity and other restrictions, and then displays a dialog showing the 
calculated per cent grade, number of track sections, and height change.

(3) Press the Ok button.    RR-Track immediately creates the grade.

 Notes and limitations:    RR-Track measures heights and elevations from the layout base 
which is either the top of your benchwork or the floor for layouts on the floor.    This position
is considered zero height;    track that descends some below your benchwork level is a 
negative elevation as far as RR-Track is concerned.    RR-Track can is restricted to changing 
the track elevation of selected track with 16 or fewer ends, and is also limited to a 
maximum of 200 track sections in each grade on those ends.    These limits will meet 
almost all grade situations.    RR-Track is further limited to calculating simple grades; that is 
if RR-Track encounters a non-simple track section on a grade (such as a turnout or any 
other track section with more than two ends) it will continue the grade calculation using 
only the straight-through path (for a turnout this is the thru track) and will ignore any other
ends.    For these cases you will need to break up the grade into a combination of elevations
(using the turnout as one of the elevations) with connecting grades.



Showing Overpass Tracks
RR-Track normally draws track as a see-through item;    only the 
rails and end lines are rendered, as well as track joining accents, 
track and grade labels, and switch machines.    However, when 
one track section is passing over another, it is visually useful to 
show the overpass track blanking the track underneath. In order 
to do so, you can set the overpass attribute for any track section 
on the layout.    You may also remove the overpass attribute at 
any time.    

When you set the overpass attribute, RR-Track immediately moves the track sections with 
the overpass attribute to the top of the display;    removing the overpass attribute has no 
effect on the position of a track section in the display list.
To change the overpass attribute

You can change the overpass attribute in one of two ways, either by using the toggle 
overpass command found on the shorthand menu summoned from a right mouse click, or 
using the track property inspector summoned by a right mouse click when over the desired
overpass track section.
Procedure when using the toggle overpass command:
1. Select the track section(s) whose overpass attribute you want to change.
2. Position the cursor over empty screen space and click the right mouse button to bring up

the shorthand menu.
3. Choose the toggle overpass command.    RR-Track toggles the overpass attribute of all 

selected track sections;    those that are not overpasses are set as overpasses, and those 
that are overpasses are cleared.    You are returned to the layout with the selected track 
still highlighted.

Procedure when using the track property inspector:
1. Position the cursor over the track whose overpass attribute you wish to change.    The 

track section does not have to be selected.
2. While over the track section, click the right mouse button to bring up the Track Properties

dialog.    
3. Find the overpass check box and check it if you want the track to be an overpass, or 

clear it if you don't.
4. Press the OK button to apply your changes, or the Cancel button if you have decided to 

not make any changes.    You are returned to the layout.
For more information on using the overpass track, see the tutorial on overpass track 
sections.



Using the Mouse or Other Pointing Device
Since it is a Windows application, RR-Track makes extensive use 
of the mouse or other pointing device for designating actions.    
Most of the work of designation is done using the left mouse 
button, but the right mouse button is used for two functions and 
item property inspection, and both buttons function can be 
modified by the use of the SHIFT or ALT keys.    The use of the 
mouse has been changed in release 2.3 to bring it more into line 
with Microsoft's guide lines for Windows 95.

Left mouse functions:    the left mouse button is used to select track or objects for further
action such as movement, rotation, joining, aligning, grouping.    To designate, you position 
the cursor over the item you want to choose, and then click the left mouse button (see 
selecting track or objects).    If you follow the same script, but double-click rather than 
single click,    you designate an extended selection.    Whether the extended selection 
includes all physically connected track, all electrically connected track, or all track on the 
same elevation or grade    is determined by which extended mode you have currently set 
using the Options menu.    Double-clicking over an extended selection collapses the 
selection back to only the item under the cursor.    Double-clicking over nothing (no track, 
accessory, or object beneath the cursor) will act as choosing the Last Track item on the 
Track menu, and put a piece of track identical to the last chosen under the cursor for 
placement.    Double-clicking over nothing while holding down the CONTROL-key will act to 
choose the last object selected from the Object menu (this is a handy way to draw a lot of 
trees or buildings quickly without going back to the Object menu).    If you position the 
cursor over a non-highlighted object and depress and hold down the leftmouse button, RR-
Track will, after a pause of 1/4 to 1/2 second, assume you want to move that item, highlight
it and change to the move cursor, allowing you to drag the object to a new position ( see 
selecting track or objects ).    This may also be done when double-clicking a track section to
create an extended selection, you just don't let up on the mouse button after the second 
click.    
To sweep out a rectangular area for selecting objects, to move selected items, or to 
designate the size of all general purpose objects you use a depress - drag - release 
sequence with the left mouse button.    Here you position the cursor over the previously 
selected item, depress and hold the left mouse button, move the cursor while holding down
the left mouse button to move or designate a region or size, and then release the button 
when you are satisfied with your designation (see moving track for another description of 
this). 
To choose or unchoose track or objects in addition to those already selected (highlighted), 
position the cursor over the item, and click the left mouse button while holding down the 
SHIFT key (see selecting track for more information).
To cause the view to automatically scroll when you move the cursor, hold down the SHIFT 
key without depressing any of the mouse buttons.    When the cursor gets near the edge, 
the view of your layout will automatically scroll in the appropriate direction.
Right mouse functions:    the right mouse button is used to measure distances on the 
layout using the ruler function, to pop up a short menu (shorthand menu) of the most 
commonly used commands, to tear off menus from the menu bar for later use, and as a 
property inspector for both track and objects.
To bring up the shorthand menu, position the cursor over nothing and click the right mouse
button.
To use the ruler function, depress the SHIFT key, position the cursor over the starting point,



depress and hold both the SHIFT and right mouse buttons, drag the cursor to the ending 
point, and release both the SHIFT and right mouse buttons.    To make the ruler function 
snap the endpoints to the nearest track junctions, depress the ALT key rather than the 
SHIFT key.    For more information see measuring distances.
To find out the gory details about a track or object item, position the cursor over that item 
and click the right mouse button.    This action calls up a dialog box showing you more than 
you probably want to know about that item.
The right mouse button is also used to tear menus off, and leave them on the screen for 
further use and reference (see tearing off menus).    
Mistakes and pitfalls:    probably the biggest source of problems with the mouse 
functions comes when you use the Mouse Control Panel Object to reconfigure your pointing
device.    If you are having the wrong action occur when you click a mouse button, such as 
a menu appearing when you press the left mouse button, check to see whether you have 
remapped the right and left mouse buttons.    To be sure, use the Mouse Control Panel 
Object to reset the mouse buttons in the standard fashion.    RR-Track looks for specific 
mouse messages from Windows; if you remap the buttons mass confusion can easily result.
Another set of difficulties arises from either too long or too short double-click times, or too 
much cursor acceleration, both of which may be set from the Mouse Control Panel Object.    
If you are having trouble single- and double-clicking, check the Mouse settings in the 
Control Panel.

 Note: If you are using a laptop with a touchpad, some of these maneuvers can be difficult,
especially single-clicking and holding the left mouse button down to drag.    We have found 
it more effective to resort to either two fingers or both hands, and manually depress the 
touchpad button corresponding to the left mouse with one digit while dragging with the 
other digit.    Or, if desk or table bound, just attach a conventional mouse to your laptop.
 
        



Track Consistency Errors
Older versions of RR-Track, those with release designations 
before 2.1e (you can find out your current release by choosing 
the About item from the Help menu), had an internal consistency 
problem with track rotations where a cumulative series of track 
rotations built up roundoff errors that eventually led to 
inconsistencies in the track orientations.    

When this problem became severe enough (around 200 or so contiguous track sections), it 
manifest itself by drawing the track rails in a different location from the track ends.    This 
problem has been corrected starting with version 2.1f.    In version 2.3 RR-Track checks 
track consistency when it opens a layout file.    If any inconsistencies are found, you will see
a dialog like this:

 You are given two choices for handling this error.    If you choose to repair the damage by 
pressing the Fix button, RR-Track will do its best to determine the proper track orientation 
and effect this change.    If you decide not to fix up the errors (because you don't see any 
problem in the layout's appearance), press the Ignore button.
In many cases, automatic fixup results in track sections that are skewed at a small angle 
from their proper orientation (1 or 2 degrees).    The only sure fix for this condition is to 
select and delete the offending track from the layout, and replace it with fresh track 
sections.    If you are having trouble, give us a call and arrange to send the layout so we can
take a crack at fixing it.      In most cases this is not a difficult task.
Starting with v2.4, RR-Track uses extended precision arithmetic for all track position and 
orientations which should eliminate any consistency errors.
      



Printing the Track List
The list of track and accessories in the layout, which is contained 
in the track list window, may be printed by using one of the Copy
commands in the track list window's menu bar.    There are two 
commands found under the Copy submenu; Contents to 
Clipboard and Contents to WRITE.    

If you select Contents to Clipboard, the track list text is copied to the Windows Clipboard, 
where you may subsequently paste it into your favorite word processor using that 
application's paste command.    You then print the track list by formatting the text as you 
like, and then printing it.
By selecting Contents to WRITE, the track list text is copied into the Windows Clipboard as 
before, but additionally, RR-Track launches Windows Write and then pastes the track list 
into Write.    The Write main window appears on top of RR-Track; you can then format the 
text as you desire and print it to your printer.
If you are using Windows 95, RR-Track will instead find and launch WordPad, the general 
purpose word processor included with this release of Microsoft Windows.



Editing Objects
RR-Track allows you to edit any general purpose object that you 
create, and to rescale any set of grouped objects.    This editing 
capability means that you do not have to draw an object exactly 
correctly the first time; you can go back at any time and resize or
rescale it.    Resizing refers to moving an individual corner or edit 
point, resulting in an over all shape change.    Rescaling refers to 
changing the overall size of an object at equal scale in all 
directions.    RR-Track does not support anisotropic rescaling of 
grouped objects.

All editing in RR-Track is done with the mouse. You use the mouse to `grab' an edit point on
the object your are editing, and then drag it to where you want it, letting go when you 
reach the desired size or position.    This is similar to the way that you move an object 
around the screen, except here you move just one part of an object.    
Ordinarily, RR-Track does not display the edit points on an object.    When you select the 
object, RR-Track not only highlights it but displays the object's edit points, as for the 
rectangle at right (when selecting multiple objects, RR-Track shows the edit points of the 
lead selection if the lead selection is an editable object).    RR-Track draws an object's edit 
points as small, filled circles.    

 Here there are four edit points, one on each corner.    One of the edit points, that at the 
upper left, has a box drawn around it.    The box signifies that this edit point is the origin of 
the object, but you may move this edit point as you would any of the other three.    

 At left is a six-sided filled polygon.    Each vertex is    an edit point, with the left-most vertex
also the origin of the polygon.        

 At left is a group consisting of three rectangles.    The edit points for the group are the 
corners of the group bounding box; note that the origin is not at any of the edit points.    
When resizing or rescaling an object, the current snap settings are in affect, but they are 
applied in the coordinate system that is intrinsic to the object.    For rectangle objects (and 
buildings which are derived from rectangles) and grouped objects, the intrinsic coordinate 
system is along the width and height of the bounding box, even if you subsequently rotate 
the object.    For all other objects, the intrinsic coordinate system is the same as the overall 
coordinate system for the layout.    In order to resize or rescale an object, the following 
routine is recommended:
Procedure:
1. Select the object you wish to edit.    RR-Track highlights the object and displays the edit 

points.
2. Place the cursor over the edit point that you want to move (it must be over the point in 

order to grab it) and depress and hold down the left mouse button.    RR-Track changes 



the cursor to an arrow with the word `Edit' below it to indicated that you are about to 
resize or rescale the object (if you miss the edit point, the cursor will change to an arrow 
with the word `Move' below it indicating you are about to move the entire object).    At 
the same time RR-Track shows a small readout window in the upper right corner of the 
layout window.    This readout window shows the relevant current and changing size 
settings of the object. 

3. While continuing to hold down the left mouse button, drag the edit point to the position 
you want.    While you move the edit point, RR-Track continuously updates the readout 
window, telling you the size and position, and the per cent change in size or position.

4. When you reach the desired size or position, release the left mouse button.    RR-Track 
immediately updates the objects new size, and dismisses the readout window.

You can repeat the above procedure as many times as you like; there is no limit to the 
number of times you can edit an object.    Grouped objects can only be rescaled 
isotropically; this is enforced by RR-Track.    

 Note: Polygon objects (this includes trees ,turntables, boulders, and ponds) allow each of 
their individual vertices to be edited; this can upset the overall symmetry of these objects 
if carried to an extreme.    This release of RR-Track does not support rescaling of polygons, 
just editing of individual vertices.    Further, you may not insert additional vertices into a 
polygon after creation.



Grouping and Ungroupling General Objects
In order to build up more complex drawing objects out of the 
basic shapes of lines, rectangles, and circles that exist under the 
Object menu, you may group them so that they are treated as a 
single object by RR-Track.    

When grouped, they may be selected and moved, rotated, copied, and deleted as a single 
entity.    This makes creating complex diagrams of structures and accessories on your 
layout a more simple task.    Even more complicated objects can be created by building 
them up from groups of simpler groups, for instance a combination watering, coaling, and 
sanding station put together from separate watering, coaling, and sanding facilities.
Procedure:
1. Select the objects you wish to group using the pointing device.
2. Pull down the Action menu and select Group Objects.    The selected objects are 
redrawn with a dashed rectangle around them indicating they are grouped.    This dashed 
line only appears when the grouped objects are selected and highlighted.
You cannot form a group from a single object, and track sections are not allowed in a group 
and will be ignored if they are included in the selected objects.    When selected, a grouped 
object is drawn with an enclosing dashed rectangle which denotes the region RR-Track 
assigns to the object.    Like any other object, you can edit grouped objects by rescaling 
them.    See editing objects  for more information.
In order to ungroup a grouped object, simply select it and choose Ungroup Object from the 
Action menu.    The first grouped object found in the list of selected objects will be 
ungrouped and redrawn without its telltale dashed grouping rectangle.
see also:
selecting objects 
 



Tearing Off a Menu
A handy feature of RR-Track is the ability to tear off any of the 
menus and leave them up on the screen for quick reference.    
This is especially useful when used with the submenus 
associated with the Track menu.    

These usually, but not always, consist of straight, curved, turnouts, and special sections of 
track, and vary from track family to track family.    If you have the screen space, you can 
conveniently leave up the submenus for straight, curved, and turnout sections on the 
screen for quick selection.    To tear off a menu:
Procedure:
1. Pull down the menu you wish to tear off using the cursor and left mouse button as you 

normally would.
2. Instead of selecting a command or item, move the cursor over the newly appearing 

submenu and click the right mouse button.
3. A new window appears, with a small thumbtack in the upper left corner, the menu name 

in the usually window name area, and the menu items in the main drawing area of the 
window.    You may position this window anywhere on the screen by putting the cursor in 
the title bar, depressing the left mouse button, and dragging --- just as for any window.

Tearoff menus look like:

 You select an item from the tearoff menu by clicking it with the 
left mouse button just as for other menus.    To dismiss a torn off menu, click the left mouse 
button with the cursor in the thumbtack area in the upper left-hand corner.    If a torn off 
menu has submenus associated with it (like the main Track menu would), these may be torn 
off from the parent menu in exactly the same manner as above. 
When you change track families, by selecting a new track system from the Options menu, all
torn off menus associated with the previous track family are destroyed.    If you then return 
to the old track family, you must again tearoff menus since RR-Track maintains no record of 
previously torn off menus.

 Note:    tear off menus are disabled under Windows NT since the tearoff menu feature 
interferes with normal menu operation.    Under Windows 95, you may have to select menu 



items twice in order to get you choice.



Copying Track Between Layouts
To quickly clone new layouts, you may wish to copy track from 
one layout to another.    This is easy to do using the Copy and 
Paste commands to the RR-Track clipboard.    A limitation is that 
RR-Track can only handle approximately 400 items at a time in its
clipboard.

In order to copy between layouts, you must have both the source layout and the 
destination layout open.
Procedure:
1. Make the source layout the active layout if it is not already so.    This is done by clicking 

with the mouse anywhere on the layout window to bring it to the top, or by pulling down 
the Windows menu and choosing the layout from the list appended to the bottom of the 
menu.

2. Select the items you want to copy.
3. Choose Copy from either the Edit menu or the shorthand (right mouse) menu.
4. Make the destination layout the active layout by either using the Windows menu as 

described above, or by clicking on it with the mouse.
5 Pull down the    Edit menu and choose Paste, or pop up the shorthand menu and choose 

Paste.    RR-Track pastes the items into the destination layout, where they remain 
selected.

 Note:    RR-Track pastes the items into the working layer, whatever that is.    If the working 
layer has different default drawing and filling colors, then the track will be rendered with 
the new colors, not the color attributes from the source layout.

 Note:    if you want to quickly reproduce an entire layout, choose the Clone Layout 
command from the File menu.
see also:
selecting track, opening a layout file 



Track and Object Information
You can access the details on a given items properties by 
positioning the cursor over it and clicking the right mouse button.
When you do so over track, you will see the Track Properties 
dialog like that below:

 Position group:    this tells you the location of the origin for the track and its current 
orientation (angle) in degrees measured counter-clockwise from the horizontal axis.
Properties group: this shows you the length, and arc angle and radius for a curved track 
section; and the total length and radius for a turnout transition track.
Details button:    pressing the Details button will show you the connection properties of all
of the track junctions in a dialog such as that at below:

 Junctions group:    this shows you the joining and block break status for each of the track 
junctions.    Straight and curved tracks have two junctions, turnouts three, crosses four, etc. 
For turnout transition curves and easement curves, pressing the Transition... or Easement...
buttons will show further information about these specialized track sections.
The overpass, locked, and in some track libraries swap switch machine check boxes show 
the current overpass status, locking status, and whether the switch machine has been 
swapped for this track section.    You may change these track properties by checking or 
unchecking all of these controls.    If you set the overpass status of the track section, RR-
Track will redraw it and bring it to the top of the display list immediately after you press the
OK button.    Pressing the Cancel button will cancel any changes you have made to the 
locking, overpass, and switch machine status.    For more information on changing overpass
attributes see overpass track.



 The cost readout tells you the cost of this item, as set in the .INI file for that track library.    
You may change the cost, on-the-fly, by pressing the Change button.    When you do so you 
will see a dialog like the one at right:
Simply type in a new cost (dollars and decimal cents) and press the OK button. To dismiss 
the dialog without changing the price, press Cancel.    Price changes take effect 
immediately.
When you click the right mouse button while over a drawing object, you will see a dialog 
like that below:

 Position group:    this shows the position and orientation of the drawing object in the 
current units system.    As for track, angular positions are measured around 
counterclockwise from the horizontal.    
Properties group:    this shows the relevant dimensions for the object (length for lines, 
radius for circles, etc.).
Colors group: this shows the drawing (outline) and fill colors, if applicable, for the object.
For text label objects, there is an Edit button which you can use to bring up the Text Label 
dialog and edit the text label.
Pressing the OK button dismisses the dialog and returns you to RR-Track.
 



Joining Track
After placing new track, joining and unjoining track are probably 
the most common operations performed when creating a track 
layout.    A number of commands and settings in RR-Track interact
when track junctions are either created or broken.    Among these
commands are Confirm joints, Select Joined Track, Auto-join New 
Track, and Join To Nearest.      Other setting that affect track joinng
are proximity joining  andautomatic loop closing.

Joining: 
The first and most common way of joining track is to have enabled the Auto-join item under
the Object or shorthand menus.      When automatic joining is set, any new track sections 
brought into the layout (from the Track menu) will display the Autojoin cursor, and 
automatically join themselves to the nearest unoccupied track control point when released. 
To override this, press the Escape key before releasing the track, or release the track 
beyond the capture radius for that gauge of track ( 6" for HO, 12" for O-gauge, 18" for G-
gauge).    The cursor will change to the Move cursor; auto-joining will be temporarily 
suspended, but re-enabled for the next new track section.
The second way to join track is by selecting a track section(s), moving it close to the track 
section you wish to join, and then selecting Join To Nearest from either the Action or 
shorthand menus. 
The third way to join track, and probably the most convenient, requires enabling automatic 
track joining.    You then select the track sections you want to join, move them close to the 
track you wish to join them to (within a track width) and then release them.    RR-Track will 
automatically join the closest free ends.
If you have enabled proximity joining (this is the default), RR-Track will automatically mark 
as joined (but not move) unjoined compatible track ends that lie within 1/4 track width of 
each other and are misaligned by no more than 2.5°. 
Unjoining 
Unjoining track is as easy as joining track.    As for joining, you have several methods which 
may be employed for breaking track apart.
The easiest is to place the cursor over the track section you want to unjoin, depress and 
hold the left mouse button until the cursor changes to the Move cursor, then drag the track
at least 10 per cent of the screen width.    RR-Track will automatically break all track 
junctions for you at that moment, leaving you free to place the track section wherever you 
wish, as well as join it to another track section as described above.    
The second way is to select the track section you wish to unjoin, then pull down the Action 
menu and choose the Unjoin command.    All track junctions are severed by this command, 
but the track is left in place.
The third way is select the track section whose junctions you wish to break, pull down the 
Action menu and choose Break Joint.    The cursor changes to the Break cursor.    Place the 
cursor close to the junction you want to break and click the left mouse button.    RR-Track 
will break the track junction closest to the cursor that is in the highlighted track section.    
The latter two methods are primarily used for situations where you wish to break a track 
connection, but do not want to move the track section yet. 
see also:
automatic track joining, manual track joining,      





Measuring Distances on the Layout
Often it is useful and even crucial to know the distances between
objects and track sections on the layout in order to correctly 
space switchyards, unloading docks, or find out what length of 
track you need to fill a gap.    Distances are simply measured 
using the ruler function in RR-Track.

To measure distances on the layout, carry out the following series of steps with the mouse: 
Procedure:
1. With the cursor showing the Windows arrow (i.e. you aren't in the middle of some other 

operation such as drawing an object), place the tip of the arrow where you wish to 
anchor one end of the distance line.

2. While holding down the SHIFT-key, depress and hold the right mouse button.    The cursor
will change to a ruler with a small star which denotes the aiming point.

3. Still holding the SHIFT and right mouse buttons, move the aiming point to where you 
wish to end the measurement.    RR-Track draws a line showing the distance that will be 
measured.

4. Release the SHIFT-key and right mouse button. A dialog like that below will tell you what 
the total distance is, the angle, and the horizontal and vertical components of this 
distance, and, if the endpoints are track junctions, show button commands for custom 
track automation using the track wizards in the relevant track library.    The cursor returns
to the Windows arrow.

 To measure between track joints:    Many times it is more useful to accurately measure 
the distance between track joints (for cutting a section to fill in, or to measure adjacent 
yard track separation).    You can use the ruler function to snap to the nearest track joint by 
depressing the ALT-key rather than the SHIFT-key while using the ruler.    Remember that 
RR-Track will snap the measuring point to the nearest track joint, which can be the same as
the starting joint if you are sloppy in using the ruler.    In this case the distance measured 
will be zero.    The snapping of the ruler endpoints to track joints is unaffected by the 
current state of the Snap to grid option.

 When you measure distances between track ends by holding down the ALT key while 
measuring, RR-Track will display command buttons that provide access to the track 
wizards, if any, that are present in the track library of the track sections.



Changing Track and Accessory Prices
RR-Track calculates the cost of your layout by reading the price 
information in the .INI file associated with a given track library.    
The various track libraries and their associated initialization files 
are:

Lionel® O and O27 O-gauge OO27.INI
Curtis HiRail O-gauge CHRGG.INI
Ross Custom Switches O ROSSCS.INI
GarGraves® Trackage O GARGRV.INI
Lionel Super-O O-gauge SUPERO.INI
LGB G-gauge LGB.INI
MicroEngineering G-gauge MEC.INI
Aristocraft G-gauge ARISTO.INI
American Flyer S-gauge AMF.INI
Lionel/Rydin standard gauge STDG.INI
Atlas® HO gauge ATLASHO.INI
Kato® HO gauge KATO.INI
Märklin HO gauge MRKLINM.INI, MRKLINK.INI
Pilz/RailTech code 100 HO PILZ100.INI, PILZ83.INI
Pilz/RailTech code 83 HO PILZ83.INI
Pilz/RailTech code 80 TT PILZTT.INI
Atlas® N-gauge ATLASN.INI
Kato® UniTrack N-gauge KATON.INI
Märklin Z-gauge MARKLINZ.INI

for accessory libraries:
Lionel® pre-war accesories ACPREWAR.INI
Lionel® post-war accessories ACPSTWAR.INI
Lionel® modern accessories ACMODERN.INI
Gilbert post-war accessories ACCGLBRT.INI
Pola® G-gauge accessories POLAG.INI

Each of these initialization files my be edited using the Note Pad editor included with 
Windows (NOTEPAD.EXE, usually found in your Accessories group).    If you choose to edit 
these files with a word processor such as Microsoft Word, WordPerfect, AMI Pro, or 
whatever, be very careful and save the edited file as ASCII text only.    If you save it in the 
word processors native file format, RR-Track won't be able to read it, and all of the track 
prices will default to zero.
The track library initialization files are divided into four sections: [straight track], [curved 
track], [turnouts], and [special track].    For each type of track supported by the respective 
library there will be a line with an entry like



s10=
with a decimal number reflecting the price in dollars (RR-Track doesn't convert between 
currencies, but you could put in the price in pounds sterling, deutche marks, lire, or 
whatever and ignore the $ symbol).    Simply change the price to reflect the price you can 
purchase this track section for.    The track types are the abbreviated names that are used 
when the track sections are labeled on the screen or when printing (such as LGB:s1000 for 
an LGB #1000 straight section) without the prepended track family name.    When you are 
finished with editing the track prices, save the file and then restart RR-Track.    RR-Track only
reads the price information on startup.

 You can also edit the track and prices by using the Track Property Inspector, summoned 
when you right click the mouse over a track or accessory piece.    By pressing the Change 
button located in the lower right corner, you will access a Track Cost dialog which will allow 
you to immediately review and change the track price ( see Track Information for more 
details).    At present this is not implemented for accessories; these can be changed by 
directly editing the appropriate .INI file as described above. 



Selecting Track and Objects
Before you can do anything useful with track sections you have 
already placed in the layout, they must first be selected. Track 
items must be selected before they may be moved, copied, cut, 
deleted, rotated, joined, aligned, closed, and relaxed.    

Track selection is an action performed entirely with the mouse cursor, but is modified by 
the enabling/disabling of the Selections include joints item, the Selections Include Blocks 
item, and the Selections Include Grades  item on both the Options and shorthand menus.     
These properties are called extended selections.    Extended selections occur when you 
double-click the left mouse button instead of single clicking.    The current extended 
selection mode is denoted by a check mark in front of it on the menu.    When the extended
selection mode is set to Selections Include Joints, then all of the track physically joined to 
the track under the cursor will be highlighted when you make an extended selection.    
When the extended selection mode is set to Selections Include Blocks, then all of the track 
sections electrically connected to the section under the cursor are highlighted.    This mode 
is very useful for checking the arrangement of electrical blocks on your layout.    When the 
extended selection mode is set to Selections Include Grades, all of the track that is either 
on the same grade or at the same elevation as the track under the cursor is highlighted.    
This will let you quickly choose elevated track, and is necessary for some of the commands
found under the Grades menu.
Among track in the selected track list, the first track section is called the lead selection.    
This section is highlighted with larger control points than the secondary selections.    The 
graphic below illustrates this:

 Note that the leftmost section has the large, filled squares denoting its control points.    
Circles denote points that are joined, while hollow squares are unused control points.    The 
lead selection is the track section about which rotations occur, moves are referenced to, 
and which determines who is moved to whom when aligning or joining track and there is 
more than one possibility for movement.    The lead selection is drawn with bold lines, while
the other track sections are drawn using a single width pen.
Selecting items
Selection may be carried out in two distinct ways.    The first allows you the select all of the 
track and general purpose objects in a rectangular region that you sweep out with the 
cursor, while the second allows you to designate each item in turn.
Multiple selections:    multiple selections are designated by sweeping out a selection 
rectangle on the screen with the mouse.    
Procedure:
1. With the Windows arrow cursor showing (i.e. you aren't in the middle of some other 
procedure), position the cursor in an area where there are no objects or track sections, and 
you wish to start the select rectangle.    
2. Depress and hold the leftmouse button.    The cursor changes to a diagonal arrow with
the word 'Select'.    
3. While continuing to hold down the left mouse button, sweep out the rectangle 
containing the objects you wish to select.    It will be drawn as you move the cursor.
4. When you are satisfied with the region you have drawn, release the left mouse 



button.    All track and other objects wholly within this region will be placed into the select 
list and highlighted.    The cursor returns to the Windows arrow.
Using this method, the lead selection will be the first track section found in the track list 
that is in the region.    Note that using the selection box does not select track that is not in 
the box, regardless of the setting of the extended selection mode.    You can further fine 
tune the selections by individually selecting/deselecting items using the SHIFT-left mouse 
combination as described below.
Individual selections: the second method consists of manually moving the cursor over 
each item you wish to include in the select list.    While slower than the first method at 
adding track to the list, it allows you to be more precise.
Procedure:
1. With the Windows arrow cursor showing (i.e. you aren't in the middle of some other 
procedure), position the cursor over the track section or object you wish to select and 
single-click the left mouse button.    The object is highlighted in red.
2. To add objects or track sections to the select list, position the cursor in turn over the 
next objects and, while holding down the SHIFT-key, single-click the left mouse button.    
The new object is highlighted.    If this item was already selected (highlighted) it will be 
deselected instead.
3. Repeat step two until you have chosen all of the track or objects you wish to select.

 Hint: You may both select and move at item in one operation by placing the cursor over 
that item, then depress and hold down the left mouse button for 1/4 to 1/2 second.    RR-
Track will assume you want to move the object(s) under the cursor, highlight them and 
then change to the 'move' cursor.    In this manner you do not need two separate mouse 
clicks to initiate moving an object.
You can select all of the track and objects in a layout by pulling down the Edit  menu and 
choosing Select all.    This is the equivalent of dragging a selection box around everything.
Making extended selections
To make an extended selection, you double-click the left mouse button when over the first 
track section you want to select.    Depending on which extended selection mode is 
currently set, RR-Track will choose the track section under the cursor and all of the others 
joined to it, modified by the extended selection mode.    If more than one track section is 
currently highlighted, and the left mouse button is double-clicked, RR-Track collapses the 
selected track to only that track section under the cursor, regardless of whether the 
multiple selections occurred because of a previous double-click or not.    In other words, to 
return multiple selections to only the track under the cursor, you can double-click when 
over this section rather than manually deselecting track items using the SHIFT-left mouse 
combination.    Identical to single-clicking the left mouse to make a selection, double-
clicking and holding down the left mouse button after the second click will cause RR-Track 
to change to the 'Move' cursor after 1/4 to 1/2 second.    In this manner, a single double-
click allows you to select a chunk of track and then move it to a new location.      
Changing the lead selection
In order to change the lead selection of track that has already been selected, position the 
cursor over the track section you wish to become the lead selection and single-click the left
mouse button.    
Deselecting objects
To deselect items, position the cursor over the already selected object and, while holding 



down the SHIFT-key, single-click the left mouse button.    The object will be removed from 
the select list.    To deselect all of the items, simply move the cursor to an empty area of the
layout and click the left mouse button.
see also:
selecting joined track, selecting electrically joined track 



Track Relaxation Tips
Relaxing track to get good closure and minimize mismatch is a 
subject that could be discussed for many pages.    Suffice it to say
that the quickest and best minimizations occur with a 
combination of RR-Track computation and input by you, the user.  
Here are a few tips to help you out:

(1) Don't expect to make up 3 inches of error with only three sections of track.    
There is a limit to how much 'slop' each section of track can absorb and you will have to be 
the judge of what that limit is.    If you don't mind a lot derailments, and having track come 
apart under the pounding of the trains, then perhaps you will be comfortable with 0.2" per 
track section (this is close to the physical limit given the size of the connecting pins).    If 
you like smooth operation, then you will want to get the track ends as close as possible to 
the 'ideal' condition (zero mismatch) as you can before you started relaxing the track.    
(2) Choose track sections on both sides of the closure point.    If you have a joint 
mismatch of 1.0inches, and select six track sections on the right side for relaxing while 
only one on the left, then most of the error will have to be made up by moving the six 
sections leftward.    This will both take longer and be less accurate.    If possible, put an 
equal number of track sections on each side of the closure point.
(3) Don't choose too many track sections.    Each track section represents three 
'degrees of freedom' to the relaxation engine.    If you choose 25 track sections for 
relaxation, then the relaxation engine will have 3 x 25 = 75 different ways to manipulate 
the track sections.    It is a fundamental theorem of numerical computation that the more 
freedom you give a system of objects, the less sensitive the system will be to achieving the
correct solution.    Of course, you have to consider the comments of (1) also; you can't 
choose too few track sections either.    I have successfully used up to 18 track sections, but 
a better working limit would be 8 or 10.
(4) Start out allowing large maximum track displacements ( in the Relaxation 
Constraints group), and then steadily rein the process in.    Usually the first few iterations 
can be run with everything 'wide open' (i.e. 0.5" displacement, allow both rotations and 
translations, etc.).    Then begin to close the maximum displacement down, first to 0.25" 
and then 0.1".    Usually, by the time the maximum track error is less than 0.5" you can set 
the maximum displacement at 0.1".    At this stage you can take iterations five at a time 
using the x5 button.
(5) Pay attention to the error report.    If the residual track mismatch energies are low 
(at zero error you would have zero energy) but one of the tracks has an angular error of 6°,
you are likely to have derailments at that junction.    You may have to back up and start 
over, repositioning some of the track sections as necessary.    It might, in fact, be a better 
idea to custom cut a stock piece of track to eliminate some of the error.    After all, even 
when using Lionel tubular track, permanent layouts make a lot of use of cut track sections.
The more relaxation of track mismatches you do, the more adept you will become at this 
process which is as much an art as it is a science.      
 
 



Getting Object Information
You get information about any track section, accessory, or 
general purpose object by putting the cursor over the item and 
clicking the right mouse button.

When you right click over a general purpose object, you will get a dialog like that below:

 The caption describes the type of object (in this a case a mountain which is a specialized 
polygon).    There are several control groups which relay further information about the 
object.
Location:    RR-Track shows the horizontal and vertical positions of the origin of the object, 
as well as the position angle.
Properties:    these are the physical size, in this case the length (horizontal span) and the 
width (vertical span).    For circle objects, the radius is given.    For line objects, the length is 
given.
Colors:    these two readouts show the draw color (the color of the pen used when outlining
something), and the fill color (if applicable).    The numerical information is the color value 
in RGB terms.    The background color for both readouts is the color whose numerical value 
is shown in the readout.    In this case the draw color is black (RGB = 0, 0, 0) and the fill 
color is a brown ( RGB = 196, 165, 060).
Layer:    RR-Track shows the layer this object is in.
Use origin:    this check box is only shown for Mountain objects.    When checked, RR-Track 
uses the object origin for centering the higher level contours; if clear RR-Track calculates 
the center of the base and uses this for centering the higher contours.
see also:
Object menu
    



Moving Track and Objects
Moving track sections and objects if very easy with RR-Track.    
Movement is done entirely through the mouse cursor in a what-
you-see-is-what-you-get manner.    

The procedure is simple and straightforward.
Procedure:
1. Select the track or objects you wish to move.
2. Place the cursor over, or in, one of the track sections or objects you wish to move (for a 

general purpose object this will have to be on one of the drawn lines).    Depress and hold
the leftmouse button.    The cursor will change to a diagonal arrow with the legend 
'Move'.

3. While holding the leftmouse button down, move the cursor to where you want to place 
the track or objects.    The track will move with you, with control points indicated, so that 
you may see exactly where the track will be placed.

4. When you reach the destination, release the leftmouse button.    The old track/object 
positions will be erased and the new ones drawn.    The track sections remain selected if 
automatic track joining is not enabled; you must manually deselect them otherwise.    If 
automatic joining is enabled and you have moved an end within a track diameter of the 
joining point, RR-Track will automatically join the track sections are deselect the track.

Alternative:    you may combine steps one and two by placing the cursor over the track or 
object you wish to move, depress and hold down the leftmouse button.    After 1/4 to 1/2 
second, RR-Track will assume you wish to move the designated item, highlight it/them, and 
then change to the move cursor.    You may then proceed at step three above.
You may also move items in an incremental manner (in steps of the snap size), by selecting
the items you wish to move and then choosing the Move command from the Action menu.   
Using the Move command may be easier for fine positioning of items, or for those 
uncomfortable with using the mouse to move things.
Keyboard shortcuts:
You can also move items in an incremental manner by using the up, down, left, and right 
arrow keys in combination with the SHIFT key.    See RR-Track shortcuts for more 
information. 
see also:
selecting track    ,moving incrementally 



Changing the Working Track Library
Track is organized into 'libraries' in RR-Track.    The families 
currently supported are Z, N, TT, HO, S, O-27, O, G, and standard 
gauge.    

RR-Track allows joining of O and O-27 track (this includes Lionel O-27, Lionel O, Curtis 
HiRail, Ross Custom Switches, MTH RealTrax through the 40-1011 adapter section,    and 
GarGraves at present), G (this included LGB, Aristocraft, TDV, Märklin MAXI, and Micro 
Engineering, HO (Atlas, RailTech, and Shinohara are compatible), and standard gauge 
(Lionel and Rydin Industries).    Any and all track families may be mixed in one layout (for 
example the XMAS93.RRT file which has both O-27 and standard gauge loops), but physical
joining is only allowed between track of the same gauge.
Changing families is simple.    Pull down the Library menu and select the track library you 
wish.    RR-Track places a checkmark next to that family, and changes the Track menu to 
reflect the components of that family.

 



Hidden layer
A hidden layer is not visible at all; items may not be selected in a hidden layer.



Grayed layer
A grayed layer is like an inactive layer except that all items are drawn grayed out, making 
them somewhat visible.    Items may not be selected, and they will not respond to a right 
mouse click.



Inactive layer
An inactive layer is a layer that is fully visible, but items cannot be selected or 
manipulated.    Since the items are visible, a right mouse click over them shows their 
properties.    Any number of layers can be inactive.



Active layer
An active layer is a layer in which you may select, move, rotate, and delete items.    You 
may not add items to an active layer (the only layer to which items may be added is the 
Working Layer).    Any number of layers can be active at one time.



Working layer
The working layer is the layer to which new items are added.    Only one layer can be the 
working layer at any given time.



Layer
A layer in a layout contains a collection of objects, track, and accessories that are grouped 
by their visibility as opposed to some other parameter.



Active layout
The active layout is the layout window that has the input focus, and should be the layout 
window that is on top of all of the others.



Credits box
The credits box is a small box printed below your layout view that contains the file name, 
date and time, the layout size, and the number of track sections in the layout.



General object
A general object is a shape such as a line, rectangle, or circle.    Track sections and 
accessories are not general objects.    General objects may be grouped to form a more 
complex object.



Zoom factor
This is the amount by which a view has been magnified compared to the original, full view 
of the layout set when the width and height were set.    The minimum zoom is 1, showing 
the full layout, while the maximum is 64.



Drawing depth
The drawing depth is the vertical distance, in feet and inches, of the area you are allowed 
to lay track and place objects.



Drawing width
The drawing width is the horizontal distance, in feet and inches, of the area you are allowed
to lay track and place objects.



Spin button
Spin buttons are small push buttons containing an up or down arrow.    These allow you to 
increment or decrement a number simply by pressing the appropriate button.



Shorthand menu
This menu is called up by clicking the right mouse button when not engaged in another 
activity which requires the use of the mouse, such as dragging track to new positions, or 
sizing objects.    It contains an abbreviated list of the most commonly used commands.



Individual moves
These are independent changes in either position or angle of a track section joined to 
another track section.



Lead selection
This is the first item in the selected track list, indicated by bolder control points symbols 
and drawn with a thicker line.    The lead selection in the select list may be changed by 
clicking the left mouse key will holding the cursor over the track section you wish to move 
the origin to.



Select list
The select list is a list of all track sections and objects that are selected (highlighted) in the 
current layout.    The lead selection is indicated by bolder control point symbols.



Selection box
The selection box is the rectangle swept out by the cursor when selecting track.



Capture radius
The capture radius is the distance one track end of a given family can be from another and 
still have them find each other for automatic joining.    These distances are HO: 6.0 inches; 
S- and O-gauge: 12.0 inches; G-gauge: 18.0 inches; standard gauge: 24.0 inches.



Extended selections
Extended selections are track sections that are either physically, or electrically joined to the
track section under the cursor, or on the same grade or elevation.



Selected track
Selected track is any and all track sections or other objects that are highlighted in red on 
the current view of the current layout.



Application clipboard
The RR-Track clipboard is a private scratchpad area maintained by RR-Track for storing track
and other related objects, and is separate from the Windows system clipboard.



Portrait orientation
This is the orientation of the printer page where the short dimension runs horizontally, and 
the long dimension vertically.



Landscape orientation
This is the orientation of the printer page.    The long dimension runs horizontally, and the 
short dimension vertically.



Current layout
The current layout is the track layout file shown on the screen by RR-Track.    This file 
absorbs all of the additions, subtractions, and changes made by your actions.



Listbox
A list box is a window that contains a list of text strings.    When used with the Windows 
open and save dialogs, the text strings are file names in the current folder.



Track control points
Track control points are the 'active' ends of the track sections, those which may be used to 
join to other track sections.    Simple straight and curved sections have two control points 
(each end), simple turnouts three control points (the thru track (2) and the turnout (1)), 
crosses have four, three-way turnouts four, etc.    



Track list
The track list is a list of all of the track sections, types, and quantities that are in the 
current layout.    Accessory items are also listed.



MTH RealTrax O-gauge track

MTH RealTrax is a new concept in sectional track for 3-rail O-gauge trains.    Individual track 
sections consist of three solid rails with a blackened center rail and integrated molded ties 
and ballast, both of heavy gauge ABS plastic.    The outside rails are electrically isolated; a 
snap in lockon for connecting a power source and a track activation device (TAD) (for 
activating accessories and signals)    may be attached to any section of track. 
RealTrax is available directly from MTH Electric Trains, Inc., or from many resellers.



Undo Last Track 
The undo last track command on the shorthand menu allows you to remove the last track 
section you added to the layout from the track list.    This is a convenient way to 'undo' a 
track section that was either improperly joined or otherwise objectionable from the layout.   
You must be sure, however, that it is indeed the last track section that you wish to remove.
see also:
last track 



Last Track
The last track item, common to all track menus, allows you to 
select another piece of track that is identical to the previously 
selected piece.    

Unlike the copy/paste sequence, this command adds a single section of the previous type 
of track to a neutral location on the layout.    Simply place the Windows pointer on a neutral
site on the layout window and double click the left mouse button.    This function is a 
shortcut that eliminates scrolling through the track menu and selecting the previous track 
section from the list of all track sections.



      Drawing Benchwork
Many layouts are not strictly rectangular in shape, but are L-, C-, 
or U-shaped, or some more complex arrangement.    It is a good 
idea to draw in the boundaries of your benchwork in order to act 
as a guide for laying the track.    RR-Track will not stop you from 
laying track outside of the bench work boundaries, but at least 
you will be able to see where the edge of the layout is supposed 
to be.

    We will start with a 20' x 12' layout which is composed of 4' x 8' sections;    you could use 
any sizes but these will illustrate the basic idea.    Start by creating a 4' x 8' unfilled 
rectangle.    First, to make things easy, pull down the Options menu, select the Snap Size 
command, and choose a snap size of 6 inches.    This will restrict the rectangle's size and 
position to 6 inch boundaries, making it easy to both create and place it.    Next, let us 
create a benchwork layer.    Pull down the Options menu again and choose Layers...., and 
then add a layer called `benchwork'.    Before you close the layers dialog, make the 
benchwork layer the working layer by double-clicking on it.    Then pull down the Objects 
menu and select Basic Shapes|Rectangle and create a 4' x 8' rectangle, as seen below:

    
    
    I have set the rectangle color to blue, and the line size to 2 pixels to make it easier to 
see;    you can do this or not as you like.    Next, duplicate the first rectangle by either 
drawing another (repeating the process previously described), or by selecting the rectangle
and choosing the Edit|Duplicate command.    Then rotate this rectangle by 90°, and place it 
so that the two rectangles look like that below:



    
 
    Now, duplicate the 4 x 8 rectangle three more times, and create an additional 4 x 4 
rectangle and place as shown.        Note that we have a perimeter layout, 4 feet deep 
everywhere with a total length of 32' and three corner sections.    

    
    
    In order to get more usable space for inside curves, I have added small 45° sections to 
the three inside corners.    Next, create a new layer, just like you did before, but call it 
`walkway', and make it the working layer.    Then, keeping the snap size set at 6 inches, 
draw a filled polygon (by pulling down the Objects menu and selecting Basic shapes | Filled 
polygon ) that covers the space not covered by the 4 x 8 tables.    When you are done, you 
should have something about like that shown below where I have colored in the walkway 
light gray.    



    
 To make the walkway become a non-selectable background, pull down the Options menu 
and choose Layers...    When you see the Layer Setup dialog, double-click on the 
`benchwork' layer to make it the working layer, and then set the `walkway' layer to 

inactive as shown at right:
    Now we are going to go into one of the 4 x 8 rectangles and drawn in the actual bench 
structure.    Zoom in on one of them and set the Snap Size to 0.5 inches.    Then draw a 
vertical, filled rectangle that is 48 inches tall and 1.5 inches wide (this is the dimension of a
standard milled 2x4 stud).    Duplicate this four more times (either by using the Duplicate 
command or by using Copy and then Pasting four times).      You should end up with

 something that looks like that at left.    I have colored the 2x4 structure brown, but you can



color it anything you like.    Next, create a pair of horizontal 96 x 1.5 inch studs and place 
them at the top and bottom of the 4x8 rectangle.    Finally, draw in four 1.5 x 3.5 inch 
nominal 2x4 legs and you should have something like that below. 

    
 Here I have placed the legs in the corners and then grouped the entire assembly into one 
unit (you group objects by selecting them and then pulling down the Action menu and 
choosing Group objects).    Grouping it is required if we are to replicate it and place it in the 
other positions.    Now,select the completed bench section and replicate it four more times, 
replacing the other 4 x 8 bench sections you already made.    You can paste in a fifth 4 x 8, 
then ungroup it, edit it, and regroup it to make the single 4 x 4 section at the lower right.    
When you are done, you should have something like that at left

    
    As a final step, you can pop up the Layer Setup dialog (either by going back to the 
Options menu or double-clicking on the layer pane in the multifunction status bar ) and 



change the `benchwork' layer to hidden so that it is out of the way and you can begin to 
lay track in a new layer that you may want to call `track'.    That is left as an excercise for 
the student.    If you are using `L' girders rather than 2x4s, then just draw in the top 
dimensions of the girders rather than the 2x4's that I used.    You can draw the benchwork 
to any level of detail that you want, and nothing stops you from also including a benchwork
wiring layer, or any number of wiring layers up to the layer limit of 64 total layers.    

    
 

    



      Setting Up Concentric Curves
Many times, when building a layout with a multiple track main 
line, you need to set up concentric curves.    This is easy to do 
using the Align To| Designated Object command under the Action
menu in RR-Track.    

    Below we show a standard situation, an O42 outer curve (MTH RealTrax) composed of 3 
40-1042 sections of curved track, with an O31 inner curve (two sections of 40-1002 track) 
that we want to make concentric.    

    
    To make the O31 curve concentric with the O42 curve we must align both the top and left
sides of the two arcs, and this must be done in two stages since we have to align the O31 
arc with two different pieces of track.    First highlight (select) the O31 curve (both track 
sections).    Then, choose the Align To| Designated Object command from the Action menu.   
When the dialog appears check the Left boxes on both the Source and Destination groups.   
Press the Align button; the cursor changes to the 'Align' cursor.    Move the cursor to the 
leftmost O42 curve and single-click the mouse (a beep means you missed and you have to 
start over).    RR-Track immediately moves the O31 arc so that it's left edge is in alignment 
with the left edge of the O42 curve, as shown below:

    
    Keeping the Align dialog up, uncheck both Left boxes and check both of the Top boxes.    
Again press the Align button, but this time place the cursor on the uppermost O42 curve 
and single-click the left mouse button.    RR-Track immediately moves the upper edge of the
O31 curve into alignment with the upper edge of the O42 curve.    Since both the upper 
edge and left edges are aligned, the two arcs are now concentric.    Dismiss the Align dialog
and your layout should like like that below.    If you use the ruler function, snapping to track 
ends (see measuring distance), you can verify that both ends of the arc are separated on 
track centers by 5.87 inches.



    
    It is easy to see that this method could be extend to aligning any set of curved arcs, as 
long as they subtend 90°.    For shorter curved arcs you will have to use some other method
for insuring concentricity, or expand them up to 90° and then delete track sections as 
needed after they are concentric. 

    



      Using Overpass Track Sections
RR-Track    allows the overpass attribute to be applied to all track 
sections:    straight, curved, turnouts, special track.    The 
overpass attribute is an editable item, that is, you can change 
track sections between overpass and non-overpass after they are
added to your layout;    you do not have to make this decision up 
front.

    We start with a simple overpass situation using MTH RealTrax as shown below:

    
 This consists of six 10 inch straight sections (40-1001) that are to pass under an upper 
level track which starts below the straight sections, bends left through 45° using an O31 
curve, continues straight for 30 inches using three 10 inch straight sections, and then turns
right through 45° using an O31 curve, resuming a course parallel to that which it started 
on.    
    We wish to make the center straight section of the elevated track an overpass. There are 
two ways to do this:    right click on the center section to summon the Track Property 
Inspector, or select the center section (by left clicking on it with the mouse) and then 
choosing the Toggle Overpass command from the shorthand menu (which we pop up by 
right clicking over nothing).    Using the Track Property Inspector, check the box labelled 
Overpass, and then press OK.    RR-Track adds the overpass attribute to the straight section,
brings it to the front, and then redraws the affected track sections, as shown below:

    
 To use the Toggle Overpass command on the shorthand menu, select the track section, 
pop up the shorthand menu, and choose Toggle Overpass.    This command toggles the 
overpass attribute of all of the selected track, changing those that are not overpasses to 



overpasses, and those that are overpasses to normal track.    For MTH RealTrax, overpass 
dashed lines are not drawn as for other types of track because of the presence of the 
integrated ballast.    Overpass designation is important, however, if you wish to view your 
MTH RealTrax layout using RR-Viewer3D, available from the RR-Track website.    RR-
Viewer3D uses the presence/absence of the overpass attribute to decide wether or not the 
create a solid berm under elevated and grade track.    If you want the elevated track to 
appear as a bridge, like we do here, then you need to apply the overpass attribute so that 
RR-Viewer3D will not create a berm below it.    



      Getting started with RR-Track, part 2
MTH RealTrax Edition

In the second part of the tutorial we will add and subtract grades 
and elevated track to and from our layout.    We will then take a 
look at using the layers feature of RR-Track and draw/edit some 
simple objects.

    Adding a grade
    Start the grade by going over to the far left side of the layout and selecting (you 
remember how to do this) both of the straight track sections, the two 40-1001 straight 
sections.    Then pull down the Grades menu and choose Change elevation .    The Change 
Track Elevation dialog appears as shown at left.

    
 The grade preview window on the left shows the track you have highlighted in red (this is 
the track whose elevation we are going to change), the rest of the layout in black, and the 
edges of the layout in dashed blue lines.    Below the preview window is a set of radio 
buttons that you use to set the required grade.    The fader control on the right of the 
preview window, as well as the up/down spin buttons below the fader and adjacent to a 
panel readout that shows the change are used to set the elevation of the selected track 
sections. 



    
 Leaving the grade set at 5.0 per cent for the moment, and the height increment set at 
0.25 inch, either grasp the fader slider and move it up so that a height of 2.00 inches is 
shown in the panel readout, or click the up spin button eight times to achieve the same 
result.    The preview window should now look like that at left: 
    Notice that RR-Track has calculated you must pick up four track sections height on each 
side of the elevated track (two O31 curves and two 10in straights) in order to satisfy grade 
requirements of 5.0 per cent and an elevation of 2.0 inches.    

    
 To see the effect of changing the grade without changing the elevation, go down to the set
of radio buttons below the preview window and select 3.0 per cent as the grade.    RR-Track 
immediately recalculates the grade track and shows you that, in order to meet an elevation
of 2.0 inches with a grade of 3.5 per cent, you will have to pick up track sections all the 
way to the turnouts as shown at left: 
    Of course, the problem now is that 2.0 inches is not enough clearance for an O-gauge 
train (here you need at least 4.5 inches, 5.0 inches is better, and 6 is even better(Lionel 
trestle sets raise the track to 4.75in)).    It is clear, in order to raise the track up high 
enough to clear another train, we will need to either increase the grade, or build a bigger 
layout (this kind of issue commonly arises when you start introducing elevations to an 
existing layout).    You can play around both with different elevations and different grade 
values to see how they trade off in terms of track sections that will have to be picked up in 
order to accommodate the grade. 



    
 Go down to the set of grade radio buttons and choose 7.5 per cent for the grade (this is 
approximately the grade imposed by a Lionel trestle set.    At the same time, by using 
either the fader or the spin buttons, change the track elevation to 5.0 inches.    RR-Track 
recalculates the grades, and shows you a preview like that at left.    You can see that with a 
combination of 5.0 inches of elevation and a grade of 7.5 per cent, we can accommodate 
the grade without having to pick up the turnouts as well.      To enter this grade into the 
layout, press the OK button.    RR-Track now applies the elevation and grade heights to the 
affected track in the layout, and redraws these items.    Your layout should now look like 
that shown at left.

    
 The triangular arrow symbols on the grades show that this a grade track section; the arrow
points in the direction of increasing height (uphill if you wish).    The tags showing 
dimensions denote the heights of the track junction on a given section that is furthest 
removed from the elevated track, i.e. the downhill end.    This is the height you would have 
to make your structural supports in order to build this layout design (If you don't see either 
the grade symbols or the junction heights, pull down the Options menu and select Options 
and then Layout Options (or pull down the Control Menu at the upper left of the layout 
window and choose Options).    When you see the Layout Options dialog, look to the lower 
right and make sure that the grade symbols and grade heights boxes are checked).



    Pull down the Options menu and select Selections Include Grades.    Then, move the 
cursor over one of the elevated track sections (one of the straight track sections to the left 
which we originally selected and moved up) and double-click the left mouse button.    All 
three sections should be highlighted as they are all in one elevation.    Now move the cursor
over one of the grade track sections (any one with an arrowhead grade symbol, it doesn't 
matter which one) and double-click the left mouse button.    All of the grade track sections 
should highlight.    Now, pull down the Grades menu and choose Information.    You will see 

a dialog like that at right. 
 It shows a grade length of 72.45 inches comprised of 7 track sections.    There is a total 
height change of 5.0 inches and this works out to a grade of 6.9 per cent, a little less that 
the 7.5 per cent we set when we created the grade.    This is because RR-Track picks up 
track sections wholly;    grades always start at a track junction and end at a track junction 
and they don't start in the middle of track. In this manner you won't have to bend any track
to create the grade, and you will always get a final grade that is equal to or less that the 
set grade. 
    Go back to the elevated straight track and double-click it with the left mouse button.    
Again,all three elevated sections highlight.    Now we will remove the grade we just put in.    
Pull down the Grades menu and choose Remove elevation.    RR-Track immediately finds all 
of the grade track connected to the elevated track, resets the height to zero, and removes 
all grade symbols.    You will see a layout that is identical to that you started with for we just
took out all of the elevated and grade track that we had put in.      For more information on 
using the Change Elevation dialog, and other commands found in the Grades menu, see 
elevating track .
    Using multiple layers
     Another feature of RR-Track is the ability to design your layout without having to always 
see every detail.    This is done by introducing the concept of layers to the track layout.    
Despite the name, layers having nothing to do with the height of track, accessories, or 
objects.    A layer is a convenient name for items that are associated in some other fashion 
(for example you could have a benchwork layer for all of the support structures, or a 
mainline track layer, or an upper level track layer).    In order to add, remove, or modify 
layers, you have to go through the Layer Setup dialog.    Pull down the Options menu and 
choose Layers.



    
 Every layout you create has at least one layer in it which RR-Track sets up for you.    This is 
the <default layer>, as shown at left.    You can't remove or rename this layer.    At the 
moment, all of the track that we have added to the layout in this tutorial is in the 
<default> layer.    This layer is also the working layer, as signified by the prepended <W>.   
The working layer is the layer in which new items are placed (see working with layers    for 
more information about layers).

    
 Let's add a new layer.    Press the Add button, and when the Layer Name dialog appears, 
type in "upper level track".    Then press OK. The list of drawing layers should change to 
reflect this additional layer, as shown at right.    The working layer is still the default layer at
this time.    Double-click on the `upper level track' layer in order to quickly change this layer
to the working layer, and leave the <default layer> as active (which means you can do 
anything you want to it but add items).    The layer list changes to:

 Now that you have added a new layer for some upper level track, press the OK button on 
the Layer Setup dialog so that we can get back to laying some track.
    Build a loop of O-gauge track, using the techniques we just went through, that looks 
something like that at left



    
 Next, we want to raise this entire loop of track up to 5 inches or so (the exact amount 
doesn't matter for this tutorial, but to be consistent we will set the height at 5 inches).    Do 
this by: 
    (1) double-clicking on the new loop to select all of the track.
    (2) Pull down the Grades menu and choose Set Track Height.    
    (3) In the Set Track Height dialog, use the spin buttons to set a height of 5 inches, and 
then press OK.    This raises the track sections up and makes them all overpasses.    Now the
layout should appear as below.

    
 Note that the elevated track sections are drawn as passing over those that are not 
elevated.    Now, let's return to the Drawing Layer Setup dialog and change the properties 
of the `upper level track' layer.    Pull down the Options menu and select Layers to get the 
Drawing Layer Setup dialog.    
    The `upper level track' layer should be highlighted since it is the working layer 
(remember we set this before we started creating the second loop).    Go to the Layer 
Attributes radio buttons and check Grayed.    As soon as you have done this, press the 
Change button (changing the layer attribute to grayed doesn't take effect until you press 
the Change button).    Notice that RR-Track automatically makes the <default layer> the 
working layer when you do this.    Then press OK to go back to track laying. RR-Track 
redraws the upper level track so that your layout now looks like



    
 Try going back to the Drawing Layers Setup dialog and changing the `upper level track' 
layer attributes to Hidden or Inactive and see what happens.    If you want to change the 
color of the track in the `upper level layer', press the Draw and Fill buttons to get the 
Windows Color Chooser.
    Creating and editing objects
    You can use RR-Track's set of general purpose drawing objects to draw in all of the 
scenery and structures that you want.    The only limit on detail is your own time and 
patience.    To show what can be done, we will draw a simple building.

    
 Make sure the working drawing layer is the <default layer> (you can check this by looking 
at the status bar at the bottom of the RR-Track main window --- the current working layer is 
shown in blue).    If the working layer isn't the <default layer>, make it so by bringing up 
the Drawing Layers Setup dialog.    Now, pull down the Objects menu, then the Buildings 
menu, and choose Hip-roof building.    Sweep out a building that is about 8 x 6 inches (the 
exact size doesn't matter) somewhere on the left side of the layout. Next, place the cursor 
on the building you just created and click the left mouse button to select it, just as you 
have for track.    The building should look something like that at right. Notice that each 
corner has a small red circle, and the corner at the upper left has an additional box around 
the circle.    The red circles are the object's edit points, while the edit point with the box is 
the object's origin.    Whenever an object is the first item selected, RR-Track displays its edit
points so that you can resize or rescale it.
    Place the cursor arrow point over the edit point on the lower right of the building and 
depress and hold the left mouse button until the cursor changes to an arrow with the word 
`Edit' below it (if you aren't exactly over the red circle, you will either get the `Move' cursor
to show that RR-Track thinks you want to move the building around the layout, or if you 
miss completely, the building will be deselected and you will have to start over).    Slowly 
drag the edit point to the right.    RR-Track displays a small window in the upper right corner



of the layout window that shows the new size, and the per cent change in scale in both the 
horizontal and vertical directions.    When you reach the new size that you want, release the
left mouse button.    RR-Track redraws the building at the new size.    There is no limit to the 
number of times you can edit an object.
    While this tutorial does not cover every feature, it does introduce you to the methods of 
laying track implemented in RR-Track.    You can see that it is easy to both build a new 
layout, and modify existing layouts using RR-Track.    Feel free to examine both the 
demonstration layout files that came with RR-Track, and/or the example layouts found in 
the EXAMPLES subdirectory.    You can use these to play with, to get ideas from, or to use as
starting points for your own layout.    There is also an MTH RealTrax examples layout 
diskettes which you can order from R & S Enterprises for $19.    This diskette contains 40+ 
example layouts in a wide range of sizes and complexity using MTH RealTrax and MTH 
RailKing accessories.    See the RR-Track website at

 www.rrtrack.com/rrtrack
 for more details on these example layouts.
      
    

    



      Getting Started with RR-Track
and MTH RealTrax

In order to get started building your own layout, the following 
tutorial will guide you through building an oval of track, and then 
editing it to include a turnout and spur.    Following this, we will 
expand the layout vertically.    Finally, we will add and then 
remove an elevated track / grade combination from the layout.

    Start RR-Track by (1) double-clicking its icon in the Program Manager (or whatever 
Windows shell you use), or (2) by double-clicking RRTRACK.EXE in a File Manager or 
Explorer directory listing, or (3) by using the Run... command in either the File or Program 
Manager.    If you are using Windows 95 or Windows NT, you can also double-click on a track
layout file (those with type .RRT) and RR-Track will automatically start.
    A number of windows are created when RR-Track starts:    the main window, track list 
window, select list window, and the status bar.    Not all of these are initially visible;    initial 
visibility is determined by the settings in the RRTRACK.INI file, which are themselves set 
from the RR-Track main menu, and are remembered between sessions.    RR-Track has two 
distinct sets of options, those that affect every layout you open (things like joining defaults,
confirmations, default background colors) and things that affect a single layout (snap 
settings, extended selection mode settings, track labels, etc.).    More information on the 
settings in the initialization file can be found in the chapter on miscellaneous material.    In 
this manual, some of the dialogs and windows you will see are shown as they appear under
Windows 3.1 while others are shown as they appear under Windows 95/98/NT4; this is so 
that you are familiar with the appearance of RR-Track under both Window's shells. 
    At startup, RR-Track displays a picture of a toy train layout, and a menu bar with File on 
the left and Help on the right.    The File menu has three items, New..., Open..., and Exit.    
Select New... to start a new track layout, Open... to open an existing layout file (such as 
one of the example files included on the distribution diskette).    The function of Exit is 
obvious.    The Help menu has items for Contents, Search For Help On..., Getting Started, 
and About RR-Track.    Selecting Contents will open up the RR-Track hypertext help file and 
show the table of contents, Search will open up the help file and display the help search 
dialog, while   Getting Started   opens up the track laying tutorial.
    Track laying tutorial
    If you are reading this, you must have RR-Track running, and are probably staring at a 
roughly drawn image of an old steam locomotive or a train layout.    The menu bar at the 
top of the main window, in this case, will have two entries:    File and Help.    Pull down the 
File menu and select New.    This action pops up the Drawing Size dialog.    Using the spin 
buttons, set the width of the layout at 10 feet and the depth at 7 feet.    When this is done, 
press the OK button with the mouse cursor.    To give yourself the maximum screen space to
work in, press the maximize button on the new layout window.    At this point the main 
window will change to look something like:



    
 
    We will first build an oval out of MTH RealTrax O-gauge three-rail track, but you could just
as well build the oval    any of the    track libraries available for RR-Track.    Pull down the 
Library menu and select MTH RealTrax.    A check mark will be placed next to this item, 
indicating that MTH RealTrax is the current track library.    Pull down the Options menu and 
verify that Detailed Track Render is checked.    If not, select it so that it is checked. While 
you have the Options menu down, verify that Selections Include Joints is checked.    If it is 
not, select it so that it is checked.    Then, pull down the Options menu and select Options....
The dialog shows the state of all of the options that apply to all layouts. Check and make 
sure the Auto-close Loops option, found in the upper left corner, is checked, as well as 
Allow Track Breakaways , Auto-join track , and Proximity joining.    Pull down the Control 
menu and choose Options    to bring up a dialog showing the options you previously 
manipulated. Verify that Detailed Track Render, Label Track, Grade Symbols, and Block 
breaks are set.    At this point you are ready to begin laying track.
    Next, pull down the Track menu and select RealTrax straights | 40-1001 10in from the list 
of straight track sections available.    The cursor will change to a diagonal arrow with either 
the word 'Autojoin' below it.    Without depressing the left mouse key, move the track to 
somewhere in the lower left region of the layout, then depress and release the left-mouse 
key (this depressing and releasing of the left-mouse button is termed 'releasing the track'). 
A straight track will now be drawn at this point with label '1001', while the cursor returns to
the Windows arrow.    Repeat this process, except use the Last Track command from the 
Track menu to get another piece of 10 inch straight track.    Bring this near (within 12 
inches) of the previous track section, depress and then release the left mouse key.    The 
new piece of track immediately attaches itself to the first piece, forming a combination of 
two straight pieces.    Again, repeat this process, but this time get the track section by first 
clicking the right mouse button, with the cursor over nothing, to bring up the shorthand 
menu, and then use the cursor and click the left mouse button to select Last Track.    Bring 
the new piece near the first combination, then depress and release the left mouse button, 
adding the third track section to the first two.    Next, move the mouse cursor to a point on 
the screen where it is not over a track section, and double-click the left mouse button.    You



will see another straight section of O-gauge track appear under the cursor.    Move this to 
one end of the other three track sections and let it go so that it automatically joins to them.
Finally, go down to the status bar, put the cursor on the button labeled `MTH 40-1001 10 
inch straight' and press the button.    You will see yet another section of O-gauge track 
appear under the cursor.    Move this to the end of the four track sections and join it to 
them.    At this point the screen should look something like this:

    
 You have assembled five pieces of track using all five ways of calling up a new piece of 
track (Track Menu | RealTrax Straights | 40-1001 10in Track Menu | Last Track, Shorthand 
Menu | Last Track, left mouse double click, and multifunction status bar last track list.).    
Now we tackle building the first curve.    We will build a semicircular (180°) curve out of four
sections of MTH O-31 track.    Pull down the Track Menu and select RealTrax curves | 40-
1002 O31 45° left,     bring the left side of the curve down near the right end of the straight 
combination and release it, automatically joining it to the other three sections of track.    
Double-click the left mouse button with the cursor in a blank area, giving you another 40-
1002 O31 curve, bring the new curve's left side near the right end of the previous curve, 
and release, joining the curve to the previous five track sections. Repeat this process two 
more times, giving you four O-31 curves in all, joined to form a semicircle.    The layout 
should now look something like this:

    
 If the layout does not look similar to that in the figure, look back through the previous 
section and see what you left out.    If the last track section was joined in an errant manner 
(which is any manner that is not the way you wanted) you can select the Undo last track 
item on the shorthand menu and remove the last piece of track (pop this up by clicking the
right mouse button when the cursor is over nothing).
    Pull down the View menu and select Show Track List.    The track list window should say 
you have five MTH RealTrax 10 inch straights and five MTH RealTrax O31 curves, nine 
pieces in all.    For your information, both left- and right-hand curves are identical;    they are
both included to make it a bit easier for you when you are placing new pieces of track.    
Left- and right-hand turnouts are not identical, needless to say.    If you do not have five 
straight sections and four curves, please add/delete track sections as necessary.    When 
finished, you can dismiss the Track List Window (by double-clicking on the control menu in 
the upper left hand corner).
    Now pull down the View menu and select Show Selects List.    This window should have 
nothing listed because no track items are selected.    Move the cursor over one of the 
straight sections and single-click it (if the select list window is in the way, move/resize it so 
that you can see your track).    The select list window should now show one MTH RealTrax 
10 inch straight.    Move the cursor over another of the straight sections and double-click 
the left mouse button.    All nine of the track sections should highlight at this point, with the
Select List Window showing five straight and four curved sections.



    
    Keeping the cursor over the straight track section, double-click the left mouse button.    
The highlighted track returns to the one straight section, which is reflected in the Select 
List Window.    You can close the Select List Window now, and deselect the highlighted track
by single-clicking the left mouse button in a blank area of the layout.    An important item to
note is that you moved between choosing a single track section and choosing all of the 
connected track sections simple by single-clicking or double-clicking    the left mouse 
button.    Many times you are interested in carrying out some action on individual track 
sections, while at other times you want to grab the entire, contiguous set (for moving or 
rotating as an example).    The ability to move back and forth between these capabilities is 
controlled by whether you single-click or double-click on a track section when selecting it.    
Single-clicking selects only the item under the cursor, while double-clicking selects that 
track section and all of the others that are joined to it in some manner, either physically, 
electrically, or in elevation (this is determined by the Selections Include Joints / Selections 
Include Blocks / Selections Include Grades items on the Options menu).    This is called 
extended selecting.    The current extended selection mode may be found by either (1) 
pulling down the Options menu and checking for a checkmark next to one of these items, 
or (2) by watching the multifunction status bar .    It is a good idea to get in the practice of 
glancing at the status bar from time to time to check on the state of these features since 
they control what happens when you double-click the left mouse button.
    We are going to complete the oval by using five more straight sections and four more 
curves, as you would expect.    This can be done in several ways.    The most straightforward
would be to repeat the process just carried out by serially selecting four more 40-1001 10 
inch straights and four more 40-1002 O-31 curves.    A faster way, the one we will use, is to:
    (1) copy the existing track, 
    (2) paste it back into the layout, 
    (3) rotate it 180°, 
    (4) join it to the first cane-shaped set of track, and then 
    (5) close the track loop.
    We can merge the first two operations, if desired, by Duplicating all of the track in the 
layout.
    We start by selecting the track.    Place the cursor over one of the nine contiguous track 
sections and double-click the left mouse button.    All nine track sections should now be 
highlighted in red (if they are not, pop up the shorthand menu by clicking the right mouse 
button away from the track sections and select Selections Include Joints so that it is 
checked.    All nine sections should highlight at this time.).    Pull down the Edit menu and 
select Copy (or popup the shorthand menu and select Copy).    The track sections have now
been copied into the RR-Track clipboard.      Next, we paste the copied track back into the 
layout, duplicating it.    Pull down the Edit menu and select Paste (or popup the shorthand 
menu and select Paste).      The duplicated cane-shaped track should now be somewhere in 
the upper left corner of the layout, and highlighted in red.    The layout should look 
something like:



    
 At this point, we could pull down the Action menu and selection Rotate.., which will let us 
carry out a manual track rotation on the newly pasted track, but there is a simpler and 
faster method.    We will make use of the automatic track joining capabilities of RR-Track.    
Place the mouse cursor over the last section of straight track (the end section) and depress
and hold the left mouse button.    After something like 1/2 second, the cursor changes to 
'Move'.    While holding the left mouse button down, drag the free end of the straight 
section to within one track width (1.25") of the free end on the last curve section of the 
non-highlighted track ( see moving track ).    When you have them close enough, release 
the left mouse button.    

    
 RR-Track will automatically rotate and join the highlighted sections to the existing sections. 
It will also find the other free end, notice that it is close enough to close the loop, and ask if
you want to do so (the sections RR-Track wants to close are highlighted in cyan). Choose 
Yes (there should be 0.00" of track error).    You now have an oval of 18 track sections which
look something like that above. 
    Adding a turnout and spur track
    Having mastered creating a simple loop, let us now move onto adding a turnout and spur
siding.    Move the cursor over the right O-31 curve track on the bottom of the oval, and 
select it by clicking the left mouse button once (see selecting track) and holding down the 
left mouse button.    After a short pause, the track section will highlight and the cursor 
change to 'Move'.    Continuing to hold the left mouse button down, drag this curve away 
from the rest about 1/10th of the screen width, and then release the left mouse button.    
RR-Track will break the connections and let you move the curve to its new position.    This 
single section of track should be highlighted as shown below:



    
 The single O-31 curve should be off alone, leaving a gap in the oval. Zoom in on the gap 
by pulling down the View menu and selecting Zoom in 2x, centering the zoom rectangle on 
the gap, and clicking the left mouse button. 
    Next, pull down the Track menu and select RealTrax turnouts | 40-1005 O31 45° left, 
place it near the gap so that the turnout curved section is closest to the oval's track ends 
(we don't want to join the turnout thru track to the oval; the idea is to have the spur track 
on the turnout replace the curved track we just removed) and release it.    RR-Track joins the
turnout to the oval.    Since adding the turnout will also close the loop, RR-Track will do this 
either by proximity joining or automatic loop closing since both options should have been 
set by you at the start.    If RR-Track does not close the loop, you will have to perform this 
task manually.    Do this by selecting the entire loop of track (double-click on one of the 
track sections), pull down the Action menu and select Close Contiguous Loop.    After asking
you for confirmation, the loop is closed.
    An important item to note is that you removed the curved section from the existing oval 
by using a continuous click-hold mouse button-drag-release motion.    You could have easily
reinserted the curved section you removed by reversing this process:    selecting and 
dragging the curved section back to the gap in the oval, and releasing it when the ends 
were within 1.25" of gap sections.    Get used to doing this, it makes if very easy to 
rearrange track layouts, something useful when you are trying out new configurations, or 
trying to find the best arrangement of curved and straight track that will cover part of your 
layout.
    Now we add the spur.    From the Track menu select RealTrax curves | 40-1002 O31 left 
and place it near the turnout spur, joining the two.    Next, select another 40-1002 O31 
curve and add this to the previous curve.    Repeat again, making three curves in all.    Now 
select and drag the old O31 curve we removed from the layout, or add another O31 curve 
from the Track menu, and place this on the end of the spur to create a 180° arc, bending 
back into the oval.    

    
 At this point your track should look like that at left.    Now we add the last O31 turnout, the 



righthand one at the top of the oval.    Put the cursor over the O31 curve on the upper right 
of the oval, where the turnout will be going (this should be obvious).    Single-click the left 
mouse button to highlight this curve, and then delete it using either the DELETE key or 
pulling down the Edit menu and selecting Delete.    This will leave you with three dangling 
track ends perfectly positioned for an O-31 right-hand turnout.    Pull down the Track menu 
and select RealTrax turnouts | 40-1004 O31 45° right      and place this such that it joins to all 
three dangling ends (RR-Track should go through two automatic loop closing cycles to close
both the main oval and the bypass.    Your layout should now look like:

    
 
    Expanding the loop
    Now, move the cursor so that it is above and to the left of the loop, then, while holding 
down the left mouse button, drag out a selection box that includes track in the upper half 
of the loop.    When you have completed the selection box, release the left mouse button.    
All of the track in the upper half of the loop should be highlighted.    If it is not, carry out the
selection process again until you have all of the track in the upper half highlighted (for 
more detailed instructions on using selection boxes to select track see selecting track and 
objects).    
    When you have the upper track highlighted, place the cursor on one of the sections, and 
depress and hold the left mouse button.    Then, while holding the button down, drag the 
highlighted track upwards far enough so that when you release the mouse button, the 
layout will be split into two halves like that at left:

    



 Now, pull down the Track menu and select RealTrax straights | 40-1001 10in, and join this 
track section to the far left vertical on the lower loop half;    select another 40-1001 10in 
and join this track section to the first new straight section.    Now repeat this process with 
the center vertical section.    Finally, place the cursor on one of the track sections in the 
upper loop half, double-click the left mouse and hold the button down.    When the entire 
half-loop highlights, and the cursor changes to 'Move', drag the half loop down close 
enough so that RR-Track can join up the left and middle verticals.    Your layout should now 
look like that below and to the left to the left.   

If we leave the O31 curves on the passing siding, we can fill in the gap using two 40-1001 
10 inch straight sections just as we used on the other two verticals.    Instead we are going 
to use O42 curves on the passing siding just to introduce a slight complexity to this layout 
and to show you how to use RR-Track's ruler measurment capabilities.

    Start by selecting the 40-1002 O31 curves that we put on this siding and deleting them.   
Now, pull down the Track menu and select RealTrax curves | 40-1042 O42 30° Left , and 
add his to the lower turnout spur.    Repeat this five times, placing three curves n the lower 
spur and three on the upper spur (since O42 curves are 12 sections to a circle, it will take 
three curves for each 90° arc rather than the two curves needed when you use O31 track). 
Your layout should now look like that below and to the left.



      
Now we have to find out how long the gap is, and decide what track needs to be inserted to
fill it.    Move the cursor near one of the gapped ends, depress and hold the ALT-key while 
depressing and holding the right mouse button.    The cursor will change to a ruler, with an 
endpoint snapping to the nearest track junction, which should be ne of the track junctions 
on either side of the gap.    While holding down both the ALT and right mouse buttons, move
the cursor near the other side of the gap, and release the ALT and right mouse buttons.      
RR-Track displays a dialog in the upper right of your layout window showing the vertical, 
horizontal, and total distances between the two track junctions. in this case 8.26 inches.    
We can come close to this distance (close enough) by combining a RealTrax 40-1018 3.5in 
straight with a RealTraxk 40-1016 5.0in straigtht (their combined length is 8.5in but we can
spread the other track sections a bit and squeeze them in).   

Choose both of these from the track menu and drop them
into the gap so that they automatically join to both sides.    Your layout should now look like 
that below at this point (for information on what combinations of RealTrax are required to 
make up a given distance see MTH RealTrax length conversions). 



    
 You have now constructed a simple oval loop of track, added a passing siding, and then 
expanded the oval vertically using the track joining/unjoining features of RR-Track.    The next
thing to do is add a simple grade to the left side of this layout.    Doing so will familiarize you 
with the various commands and tools for dealing with grades, all of which are found under 
the Grades menu.
    To procede with the second part of this tutorial, click on getting started part 2.

    



Fit In Window
The Fit In Window command is designed to maximize the 
utilization of the a given layout window's screen space without 
changing the zoom setting. 

 When you choose Fit in Window, RR-Track compares the layout dimensions to the window 
dimensions, and selects a display scale that maximizes the use of the window space.    The 
window is not resized.
When you are at a zoom factor of 1, and choose to maximize the window, RR-Track 
automatically executes a Fit in window to make the best use of the expanded display 
space.    The Zoom factor is not affected by this.



Zoom Out 4X
Zoom Out 4X is the reverse of the zoom in 4x command, 
reducing the magnification by 4x rather than increasing the 
magnification.    

 When you select the Zoom Our 4X command, the center of the current view becomes the 
center of the new view, while the horizontal and vertical extents are quadrupled, bringing 
more of the layout into view.    The status window updates to display the new current zoom 
factor.    Like the zoom in commands,    the current view becomes the last view, replacing 
the last view on the RR-Track view stack.
see also:
zoom in 4X



Redraw
The Redraw command forces an immediate redraw of the screen.

 From time to time, as you move track sections around, join and unjoin them, add and 
subtract them, small parts of the background coordinate grid, and the track sections 
themselves, will become partially erased.    For these reasons forcing a redraw can be 
useful.    RR-Track redraws track that it feels needs updating, but does not keep a detailed 
account of the state of all screen objects for performance reasons.      You can choose this 
command at any time. 



Show Select List
This menu item toggles between showing and hiding the select 
list window.    

The select list window shows the type and quantity of all track sections highlighted in the 
select list.    It also displays the length of this track, and approximately how many average 
length cars of the appropriate gauge/scale will fit in that length.    This is useful for checking
the length of spurs, passing tracks, and sidings.    
see also:
select list window 



Show Track List
This menu item toggles between showing and hiding the track 
list window.    

The track list window displays the type and quantity of all of the track sections, and 
accessories in the layout.    At the end of the track list, RR-Track displays a basic summary 
of the number of general purpose objects in the layout.
see also:
track list window 



Show Status
The menu item toggles between showing and hiding the 
multifunction status bar . 

The multfunction status bar, among other things, displays the current cursor position in 
layout coordinates, the zoom factor, and state of features such as track joint selection and 
automatic joining, and the sizes of general purpose objects such as rectangles, circles, and 
lines, as they are being constructed.    This command is the only way to show or hide the 
status bar.
see also:
multifunction status bar 



Zoom Out 2X
This command is the reverse of the zoom in 2x command, 
reducing the magnification by 2x rather than increasing the 
magnification.

 When you select Zoom Out 2X, the center of the current view becomes the center of the 
new view, while the horizontal and vertical extents are doubled, bringing more of the 
layout into view.    The status window    updates to display the new current zoom factor.    
Like the zoom in commands,    the current view becomes the last view, replacing the last 
view on the RR-Track view stack.
This command is available both on the View menu and the shorthand menu.
see also:
zoom in 2x    



Zoom In 4X
This command is similar in action to the zoom in 2x command, 
but instead zooms in by 4x.    By doing so, the current view 
becomes the last view, replacing the last view on the RR-Track 
view stack.    

Procedure:
1. Select Zoom in 4x from the View menu.    The cursor changes to a square with four 

inward point arrows, and a zoom box representing a 4x magnification surrounds the 
cursor.

2. Move the cursor around the layout until you are satisfied with the location of the zoom 
box.

3. Press the left mouse button.    The portion of the track layout inside the zoom box is 
magnified until it fills the screen, representing a zoom in of 4x.    The zoom factor in the 
status window is updated to reflect the new magnification.    The cursor is returned to the
standard Windows arrow.

see also:
zoom out 4x 



Zoom In 2X
This command allows you to zoom in by a factor of 2 on the track
layout.    By doing so, the current view becomes the last view, 
replacing the last view on the RR-Track view stack.

This command is available on both the View and the shorthand menu.    
Procedure:
1. Select Zoom in 2x from the View menu.    The cursor changes to a square with four 

inward point arrows, and a zoom box representing a 2x magnification surrounds the 
cursor.

2. Move the cursor around the layout until you are satisfied with the location of the zoom 
box.

3. Press the left mouse button.    The portion of the track layout inside the zoom box is 
magnified until it fills the screen, representing a zoom in of 2x.    The zoom factor in the 
status window is updated to reflect the new magnification.    The cursor is returned to the
standard Windows arrow.

see also:
zoom out 2x 



Last View
The Last View command switches the view on the screen to the 
previous viewing position with the previous zoom factor.

RR-Track maintains    a view stack with a depth of two, the current view and the last view.    
This command causes the current view of the track layout to return to the previous view, at
that view's position and zoom factor.    The current view then becomes the new last view.    
Repeatedly selecting Last View is an easy way to toggle between two views.
see also:
zoom in 2x, zoom out 2x , zoom in 4X, zoom out 4X



Home View
The Home View command restores the screen view to the home 
position.    

The home position has the upper left-hand corner of the screen as the upper left-hand 
corner of the track layout drawing ( in CAD terms, coordinates x = 0.0, and y = drawing 
height).    The layout zooms out (to a zoom of 1) to show the entire layout.    You may return 
to the previous view by selecting Last View 
see also:
zoom in 2x, zoom out 2x , zoom in 4X, zoom out 4X
 



Track List Windows
The Track List window displays a columnar listing of all of the 
track and accessory items in the layout, including their unit and 
total costs if they are known.

 
 The track list window displays a list of all the track sections in the current layout, sorted by
track families, and their costs.    For each entry, the number of sections of that type are 
shown as well as the unit and the total cost of those track sections, as well as a summary 
at the end of each track family.    A subtotal price is displayed at the end of each family's 
section, as well as a total cost at the end of the list.

The track list window has its own menu, which has commands for copying the track list to 
other applications and changing the font used in the track list.
Commands:
Copy|contents to clipboard:    this copies the track list to the Windows clipboard where 
other applications, such as word processors, can retrieve it by using their paste commands.
Copy|contents to WRITE  :   this copies the track list to the Windows clipboard, then launches 
Windows Write and pastes the track list in the clipboard into Write.    You may then use 
Write to reformat the text, change the font, etc., and then print the track list.    If you are 
using Windows 95, RR-Track will instread launch the WordPad editor rather than Write.
Action | Hilite    this highlights all of the track sections of the selected type.    You must click 
on one of the track entries to enable this command.    This is useful for seeing where you 
have stuck all of those cut sections of track.
Font:    this command lets you set the font the track list window uses for display of the track
list.    Invocation of this command will bring up the Windows ChooseFont dialog, where fonts
may be selected, sized, and previewed.
Help:    brings up this topic.
Track Item Window: the track item window displays secondary information about any of 
the items listed in the Track List Window.
More information about the individual track sections can be obtained by double-clicking 
any given item with the mouse.    This action will pop up a secondary window, the track 
item window, which itemizes the individual track sections of the selected type.    



 This secondary window details the horizontal and vertical positions of the track origin, the 
rotation angle of the track section, and the length.    If applicable, such as for curved track, 
the angular arc subtended by the track section as well as its radius are displayed.    Like the
track list window, the track item window has several commands to aid you in layout design.
Commands:
Copy|contents to clipboard:    this copies the track item list to the Windows clipboard where 
other applications, such as word processors, can retrieve it by using their paste commands.
Copy|contents to WRITE: this copies the track item list to the Windows clipboard, then 
launches Windows Write and pastes the track list in the clipboard into Write.    You may then
use Write to reformat the text, change the font, etc., and then print the track list.
Action|Hilite track:    this causes all of the track sections of the listed type to be highlighted 
on the layout.    When the track sections are highlighted you can easily distinguish areas 
where you have accidentally doubled up cut track sections, for example, or accidentally 
mixed curve radii in an undesired manner.    This is exactly the same function performed in 
the parent Track Item window.
 



Select List Window
The select list window displays a list of all track sections that 
are currently in the select list and highlighted in red.    

 The total length of the track, in 
inches, of the track is shown at the end of list, as well as the approximate number of cars of 
the appropriate gauge will fit on this length of track.    This is useful for checking the length 
of spurs, sidings, and passing tracks.
 






